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Введение

Настоящий практикум разработан для общего потока географического факуль-

тета МГУ имени М.В.Ломоносова и ориентирован на студентов различной специ-

ализации (физическая география, экология и природопользование; социально-

экономическая география; гидрометеорология; картография и геоинформати-

ка). Практикум состоит из 18 заданий и представляет собой комплекс учебных

упражнений для освоения базовых технологий геоинформатики и методов про-

странственного анализа. Состав выполняемых упражнений определяется препо-

давателем. Упражнения выполняются в ГИС-пакете ArcGIS for Desktop 10.3+.

Практикум доступен в трех форматах: HTML, EPUB и PDF. Скачать практи-

кум в форматах PDF и EPUB можно через главное меню:

Для практической работы рекомендуется использовать HTML-версию,

поскольку она поддерживается в актуальном состоянии1. Формат EPUB

удобен своей компактностью и адаптивностью под экран устройства, и мо-

жет быть использован для работы с электронной книгой или планшетом в

оффлайн-режиме. Во всех версиях практикума реализована навигация по

разделам.

Актуальная версия практикума, которую вы сейчас просматриваете,

1файлы PDF и EPUB тоже актуализируются, но их придется каждый раз качать заново, чтобы
убедиться в том, что вы используете последнюю версию практикума
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сформирована 2019-10-01 и доступна по ссылке https://tsamsonov.github.io/

arcgis-course/.

Перед выполнением практикума необходимо внимательно ознако-

миться с регламентом и тщательно придерживаться его при выполнении

заданий.

Регламент

В целях обеспечения порядка на рабочих компьютерах и успешного завершения

курса следует придерживаться следующих правил.

• Ваша личная рабочая директория должна иметь адрес:

D:\GIS\<ваша кафедра>\<фамилия>

Например, студент 207 группы Петров хранит результаты своей работы в

каталоге D:\GIS\207_CAR\Петров.

Каталоги кафедр уже созданы. Если вас двое, пишите в названии катало-

га обе фамилии: «Петров-Иванов». По желанию вы можете называть свой

каталог латиницей (Petroff).

• Исходные данные, а также шаблоны отчетов для выполнения всех

заданий лежат в каталоге:

\\gserver\DATA\GIS\

Внутри папки есть 18 каталогов с упражнениями: Ex01, Ex02, … Ex18. Со-

став и порядок выполняемых упражнений определяется вашим препода-

вателем (их должно быть не менее пяти).

Вы также можете скачать архив с исходными данными

и файлом отчета, используя ссылку в начале каждого

упражнения. Внутри архива находится точно такой же ката-

лог с упражнением, что и в локальной сети. Его необходимо

разархивировать и положить в свою папку на диске D (см.

следующий шаг).

• Каждое задание вы начинаете с того, что копируете соответствую-
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щую папку в свою директорию на локальном диске D.

Не меняйте ничего в каталоге исходных данных на серве-

ре. Помните, что кроме вас над теми же заданиями будут рабо-

тать студенты других групп. Если вы отредактируете или удали-

те содержимое исходного каталога упражнения, у ваших коллег

возникнут проблемы при выполнении задания.

• Отчетный файл вы кладете в сетевую папку:

\\gserver\REPORTS\GIS\<кафедра>\

Найдите внутри нее каталог с нужным номером упражнения, и положите

в него отчетный файл. Формат имени файла должен быть следующим:

Ex<номер задания>_<номер группы>_<фамилия>.doc

Например, студент 207 группы Петров в конце 2-го и 7-го зада-

ния должен на основе шаблона отчета создать файлы с именами

Ex02_207_Петров.doc и Ex07_207_Петров.doc.

• Документ карты с расширением mxd, который вы создаете в каждом

задании, должен называться аналогично файлу отчета:

Ex02_207_Петров.mxd

• Если вы не знаете, как выполнить то или иное действие, вы може-

те получить соответствующую справку в разделе Описание функций

настоящего практикума.

Принятые обозначения

Текст пособия отформатирован в соответствии со следующими соглашениями:

• Жирным шрифтом в тексте отмечены элементы пользовательского ин-

терфейса и программные инструменты.

• Курсивом в тексте отмечены элементы данных и значения параметров.

• Ссылками выделены операции, справку к которым вы можете найти в при-

ложеении Описание функций, документации ArcGIS и прочих ресурсах.

Снимок экрана№1В этом месте вы нажимаете Alt+PrintScreen и вставляете
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изображение из буфера обмена в отчетный файл

Серый текст с чертой слева — это различные определения, пояс-

нения к предыдущему тексту, а также вопросы на понимание.

О практикуме

Практикум разработан в 2011-2014 гг. на кафедре картографии и геоинформа-

тики географического факультета МГУ Т.Е.Самсоновым и с тех пор ежегодно

обновляется. В 2016 году совместно с И.К.Лурье опубликовано учебное пособие

“Основы геоинформатики” , содержащее вместе с упражнениями также вводную

теоретическую часть по каждой теме. В 2018 г. практикум был преобразован в

интерактивный формат и выложен в открытый доступ в сеть Интернет.

Структура настоящего практикума несколько отличается от пособия 2016 г.,

однако состав упражнений остался прежним. В частности, упражнения по адрес-

ным (18) и табличным (8) данным перенесены в настоящей редакции в раздел

II. Базовые технологии, поскольку в них рассматривается два варианта привяз-

ки данных: по адресу и идентификатору. По этой же причине анализ плотности

распределения (14) перенесен в более подходящий раздел V. Пространственное

моделирование. Вводный раздел получил название I. Знакомство с ГИС, в нем

обучающиеся делают первые шаги в работе с пространственными данными на

примере картографической визуализации.

Автор выражает благодарность рецензентам к.г.н. М.Ю.Грищенко и к.г.н.

П.Е.Каргашину за полезные замечания по структуре и содержанию практикума.

Библиографическая ссылка:

Самсонов Т.Е. Основы геоинформатики: практикум. М.: Географический факультет МГУ, 2019. DOI: 10.5281/zenodo.1167857
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Часть I

Знакомство с ГИС
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Глава 1

Создание карты четвертичных

отложений

Скачать данные и файл отчета

1.1 Введение

Цель задания — знакомство с моделями пространственных объектов и базой

пространственных данных. Визуализация данных на карте. Оформление леген-

ды и компоновки карты.

Параметр Значение

Теоретическая подготовка Модели пространственных данных, модели пространственных объектов, базы пространственных объектов, картографические проекции

Практическая подготовка Не требуется

Исходные данные База данных ГИС “Сатино”.

Результат Карта четвертичных отложений Сатинского учебного полигона масштаба 1:30 000

Ключевые слова Модели пространственных данных, модели пространственных объектов, базы пространственных данных, классы пространственных объектов, визуализация пространственных данных, геоинформационное картографирование
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1.2. Изучение данных в приложении … Глава 1. Создание карты …

1.1.1 Контрольный лист

• Добавить на карту слои базы пространственных данных и оформить их

• Настроить подписи объектов

• Создать компоновку карты, легенду и координатную сетку

• Экспортировать результат в графический файл

1.1.2 Аннотация

Задание посвящено знакомству с созданием тематических карт на основе баз

пространственных данных. Вы познакомитесь с представлением площадных,

линейных, точечных объектов в базе пространственных данных. Научитесь со-

здавать карты на их основе, оформлять легенду, сетку координат и зарамочные

элементы карты.

1.2 Изучение данных в приложении ArcMap

В начало упражнения �

1. Скопируйте папку Ex01 с сервера в каталог под своей фамилией.

2. Откройте приложение ArcMap

ArcMap — это основное приложение ArcGIS, предназначенное

для редактирования и анализа данных, создания новых объек-

тов и оформления карт.

3. Откройте окно Catalog, нажав кнопку на панели инструментов.

Catalog (Каталог) — это файловый менеджер для управления

пространственными данными. Его задачи в чем-то аналогичны

Проводнику в Windows или Finder в Mac OS X: создание, копи-

рование, удаление и т.д., но видит она только файлы тех фор-

матов, которые можно использовать в ГИС.

4. Раскройте папку D:/GIS в дереве каталогов и найдите в ней директорию

Ex01 в вашем каталоге, содержащую исходные данные для выполнения
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Глава 1. Создание карты … 1.2. Изучение данных в приложении …

Рис. 1.1: Приложение ArcMap

23
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первого задания. Если директории D:/GIS нет в списке, подключитесь к

ней c помощью кнопки .

5. Внутри директории Ex01 раскройте содержимое объекта под названием

Satino.gdb — это база пространственных данных, созданная в форма-

те File Geodatabase (файловая база геоданных).

База геоданных — это структурированное хранилище, внутри ко-

торого можно создавать слои данных, группировать их и связывать

различными отношениями. В базе геоданных Satino.gdb есть две

группы: General (общегеографические данные) и Thematic

(тематические данные).

Внутри базы геоданных есть данные трех типов:

• — слои векторных данных (классы пространственных объек-

тов),

• — слои растровых данных;

• — обычные таблицы;

Класс пространственных объектов (feature class) — это набор

пространственных объектов одного типа геометрии (точки, линии,

полигоны или объемные тела). Для класса могут быть определены

атрибуты, а его представлением является таблица, содержащая как

обычные столбцы (текстовые, числовые и т.д.) так и специальное

поле Shape, в котором хранится информация о геометрии. Каждая

строчка в таблице — это описание одного объекта.

Представьте, что вы работаете с двумя слоями: один содержит точки наблю-

дений скорости течения реки Протвы, другой — представление самой реки на

меженный уровень в виде площадного объекта. Съемка точек производилась с

помощью GPS-приемника, координаты измерены в виде геодезических широт и

долгот на эллипсоиде WGS-1984. Береговая линия реки получена с топографиче-

ского плана и сохранена в проекции UTM, координаты точек границы представ-

лены семизначными числами в метрах.
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Как совместить эти два слоя, чтобы составить карту фактического материа-

ла?Очевидно, надо преобразовать координаты одного слоя в систему координат

другого слоя: либо в метры в проекции UTM, либо в градусы на эллипсоиде WGS-

1984.

1. Дважды щелкните на слое WaterPolygon в группе General и перейдите на

вкладку XY Coordinate System.

2. Найдите строку Projection.

В какой проекции хранятся координаты?

Как вы помните, проекции обладают разными искажениями. В частности,

проекция Меркатора вытягивает все приполярные объекты вдоль мери-

дианов, следовательно, величины плоских прямоугольных координат за-

висят о того, какая проекция используется.

3. Найдите строку Linear Unit.

В каких единицах измерения записаны координаты в проек-

ции слоя WaterPolygon? Это могут быть градусы, метры, футы

(в США) и т.д.

4. Откройте свойства слоя HydroMeasures, лежащего к корне базы геоданных.

Этот слой хранится в Географической системе координат (ГСК)— широтах и

долготах, отнесенных к эллипсоиду WGS-1984. Т.е. у него нет проекции.

5. Закройте свойства слоя HydroMeasures.

6. Перенесите в таблицу содержания слой WaterPolygon из группы General.

Обратите внимание на то, что слой добавился под названием Гидрогра-

фия (полигоны). У него был русскоязычный псевдоним (alias). Его можно

задать в свойствах слоя в Каталоге.

Объекты базы геоданных, такие как слои, наборы данных, ат-

рибутивные поля, обычно называют латинскими буквами, од-

нако вы можете дать им русскоязычные псевдонимы, которые

будут отображаться вместо названий в ArcMap.

7. Добавьте в таблицу содержания слой HydroMeasures. Обратите внимание

на то, что слои совместились, несмотря на то, что у них различные систе-
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мы координат!

8. Откройте панель инструментов Tools (инструменты), щелкнув правой

кнопкой мыши вверху окна и выбрав ее из списка.

9. Попробуйте инструменты навигации с панелиTools: увеличить/уменьшить

и переместить . Обратите внимание на то, как будет ме-

няться масштаб вверху окна.

Для быстрого доступа к инструментам увеличить, уменьшить

и переместить используйте клавиши Z, X и C соответственно.

10. Выберите инструмент Identify и щелкните мышью на любом объек-

те, либо растяните прямоугольник вокруг объектов.

Какую информацию позволяет узнать инструмент идентифика-

ции?

11. Откройте атрибутивную таблицу слоя Гидрография (полигоны), щелкнув на

нем правой кнопкой мыши и выбрав команду Open Attribute Table.

12. Найдите поля Shape и ObjectID.

Звездочка (*) рядом с названием поля означает, что для него

внутри базы геоданных построен индекс — невидимая вспомо-

гательная таблица, позволяющая быстро находить объекты по

их атрибутам или местоположению. Соответственно, различа-

ют атрибутивный и пространственный индекс.

В поле ObjectID хранится уникальный идентификатор каждого

объекта. Он нужен системе для того, чтобы каждый объект мож-

но было гарантированно найти по некому однозначному крите-

рию.

В поле Shape (вспомните, что слой полигональный) хранится

список координат вершин полигона. Геометрия объектов

редактируется специальными инструментами, поэтому содер-

жимое поля Shape скрыто от пользователя.

13. Закройте атрибутивную таблицу.
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1.3 Способы изображения

В начало упражнения �

Карта — язык географии, и квалифицированный географ должен уметь

пользоваться современным диалектом этого языка. В основе языка карт, как вы

помните, лежат символы и способы изображения.

1. Удалите из таблицы содержания слой HydroMeasures и добавьте слой

QDeposit (четвертичные отложения). Перетащите его вниз списка и

дважды щелкните на нем.

2. Перейдите на вкладку Symbology. Здесь вы встретите многие знакомые

вам способы изображения.

Просмотрите список в левой части диалога и попробуйте на-

звать способы изображения, основываясь на вспомогательных

иллюстрациях.

Четвертичные отложения показываются качественным фоном. В ArcGIS

этот способ изображения называется Categories (категории).

3. Выберите пункт Categories в списке слева, и в нем же выберите режим

Unique values (уникальные значения).

Вверху вы должны увидеть два списка: поле, из которого необходимо

взять уникальные значения, и цветовая шкала.

4. Выберите поле Отложения в списке Value Field, и нажмите внизу диало-

га кнопкуAdd All Values. Программа просканирует всем строчкитаблицы,

найдет уникальные значения, которые там есть, и подставит их в список.

В крайнем правом поле отображается количество объектов каждого уни-

кального значения:

Обратите внимание на то, что типам объектов были автоматически при-

своены символы из той цветовой шкалы, которая выбрана справа вверху.

5. Снимите галочку All other values, расположенную вверху списка.

6. Разверните список цветовых шкал Color Ramp и выберите любую другую

на свой вкус. Цвета объектов в легенде автоматически поменяются.

Вы помните, однако, что есть официальные и неофициальные договорен-
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1.3. Способы изображения Глава 1. Создание карты …

Рис. 1.2: Диалог настройки способа изображения
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ности относительно цветов, используемых на геологических, геоморфоло-

гических, почвенных, геоботанических картах. Вы можете задать каждому

типу индивидуально тот цвет, который требуется. Более того, вы можете

сохранить набор цветов как шкалу.

7. Щелкните дважды на любом символе в легенде. Перед вами появится диа-

лог настройки символа, в котором вы можете поэкспериментировать.

8. Закройте диалог настройки символа и нажмитеОК в диалоге свойств слоя.

Теперь слойЧетвертичные отложенияпоказан методом качественного фона

с использованием тех цветов, которые были назначены каждому типу.

1.4 Подписи

В начало упражнения �

В предыдущем разделе вы изучили возможные способы изображения и по-

казали типы рельефа методом качественного фона. Однако карты без подписей

встречаются крайне редко. Если в слое есть поле с теми значениями, которые

надо вынести в качестве подписей, это делается автоматически.

1. Убедитесь, что включен механизм расстановки подписейMaplex. Для это-

го откройте панель инструментов Labeling и поставьте соответствующую

галочку:

2. Откройте снова свойства слоя Четвертичные отложения и перейдите на

вкладку Labels.

3. Отметьте галочкой опцию Label features in this layer. Эта опция включает

подписи для слоя.

4. В поле Label Field выберите значение Индекс Подписи будут браться из

этого поля. Рядом расположены элементы настройки шрифта, с которыми

вы можете поэкспериментировать:

5. Нажмите кнопку Placement Properties. Появившийся диалог позволяет

вам настроить, как именно будут размещены подписи относительно са-

мих объектов. Это очень мощный инструмент, который управляет множе-
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1.4. Подписи Глава 1. Создание карты …

Рис. 1.3: Включение механизма расстановки подписей Maplex

ством нюансов расстановки подписей.

6. В диалоге Placement Properties нажмите кнопку Position и изучите воз-

можные варианты. Попробуйте применить разные варианты. В конце вер-

ните способ по умолчанию — горизонтально внутри.

7. Закройте все диалоговые окна, последовательно нажимая кнопку OK в

каждом из них.

8. Нажмите кнопку на панели Tools, чтобы вся карта уместилась в окне

просмотра. Окно приложения примет вид, примерно соответствующий то-

му, что показано на рисунке ниже:

Обратите внимание, что на вашей карте все объекты подписаны одинаково.

Если требуется, чтобы подписи объектов были разными в зависимости от типа

объекта, на вкладке Labels свойств слоя необходимо сменить режим Label all the

features the same way на режим Define classes… и произвести настройку.

Снимок экрана №1. Окно карты с подписями объектов
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Рис. 1.4: Диалог настройки подписей для объектов
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Рис. 1.5: Карта четвертичных отложений с индексами в произвольной цветовой
шкале
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Рис. 1.6: Панель инструментов Layout

1.5 Компоновка карты

В начало упражнения �

Если карту необходимо подготовить к печати, снабдить заголовком, масшта-

бом, легендой и градусной сеткой, используется режим компоновки.

1. Выберите пункт менюView > Layout View. Приложение перейдет в режим

компоновки.

2. Откройте панель инструментов Layout. С ее помощью вы можете осу-

ществлять навигацию в режиме компоновки:

3. Откройте меню Insert и изучите его содержание.

Какие элементы компоновки можно создать, используя меню

Insert?

4. Вставьте название карты (Insert > Title). В появившемся диалоге введите

текст «Карта четвертичных отложений». Сдвиньте название в угол листа.

5. Вставьте легенду (Insert > Legend). Добавьте туда только слой четвертич-

ных отложений. Разберитесь самостоятельно с мастером создания леген-

ды.

Настройка легенды разнесена на несколько диалоговых окон.

Изучите назначение каждого из них.

Сетка прямоугольных координат строго привязана к местоположению са-

мой карты, поэтому она является ее свойством. Для того, чтобы вставить

ее, выполните следующие шаги:

6. Дважды щелкните на заголовке фрейма данных Layers и перейдите на

вкладку Grid.

7. Нажмите кнопку New Grid.
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Перед вами окажется диалог с тремя типами возможных сеток.

Чем они отличаются?

8. Выберите режим Measured Grid, который создает сетку в плоских прямо-

угольных координатах. Изучите модерждание каждого последующего диа-

лога, параметры оставьте по умолчанию

9. Нажмите ОК в свойствах фрейма данных. Теперь поверх вашей карты

должна отображаться сетка прямоугольных координат.

10. Разместите на карте линейный масштаб в метрах.

Снимок экрана №2. Компоновка карты с легендой и масштабом

Сохраните карту через команду меню File > Save as в свою директорию под

названием Ex01.mxd.

1.6 Редактирование атрибутов

В начало упражнения �

Атрибуты играют важную роль в геоинформационных системах. На их осно-

ве происходит визуализация данных, также они участвуют в большинстве опе-

раций пространственного анализа. Необходимо овладеть техникой их создания,

редактирования и использования.

Редактирование атрибутов может понадобиться при заполнении полей для

новых объектов, исправлении ошибок и заполнении пустых значений.

1. Переключитесь обратно в режим View > Data View.

2. Добавьте на карту слой WaterLine (линейные объекты гидрографии).

3. Исправьте его символ на голубую линию толщиной 1.5 пиксела, чтобы он

лучше читался на карте.

4. Включите подписи по полюRiverNameна вкладкеLabels, задайте им синий

цвет, криволинейное размещение и нажмите OK в диалоге свойств слоя.

Появились ли подписи ручьев?

По всей видимости, с полем RiverName что-то не в порядке. Давайте про-

инспектируем атрибутивную таблицу.

34



Глава 1. Создание карты … 1.6. Редактирование атрибутов

Рис. 1.7: Панель редактирования Editor

5. Зажмите клавишу Ctrl и дважды кликните на названии слоя Гидрография

(линии). Откроется его атрибутивная таблица.

Таблицу также можно открыть через контекстное меню слоя,

выбрав пункт Open Attribute Table. Свойства слоя также до-

ступны из пунктаProperties в контекстном меню. Однако вари-

ант с двойным нажатием более быстрый и, скорее всего, более

удобный.

Похоже, что создатель слоя забыл внести в него названия водотоков. Сле-

дует исправить этот недочет.

6. Пристыкуйте таблицу в нижнюю часть окна, чтобы она не загораживала

карту.

7. Выделите в таблице содержания слой Гидрография (линии) и в его кон-

текстном меню выберите пункт Edit Features > Start Editing. Включится

режим редактирования, который позволяет вручную править атрибуты и

геометрию объектов. Должна появиться панель редактора:

8. Чтобы не выделять лишних объектов, в контекстном меню слоя Гидрогра-

фия (линии) выберите пункт Selection >Make this the only selectable layer

9. Возьмите с панели редактора инструмент выбора (отмечен на рисунке) и

выделите с его помощью ручей Язвицы (на севере полигона). Он автомати-

чески подсветится в таблице. Введите название в ячейку поля RiverName:

10. Найдите на карте Чолоховский ручей (на юге полигона), выделите его и в

контекстном меню выберите пункт Attributes. Перед вами откроется ок-

но редактора атрибутов — это еще один способ редактирования таблицы,

ориентированный на индивидуальную работу с каждым объектом:
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1.6. Редактирование атрибутов Глава 1. Создание карты …

Рис. 1.8: Редактирование таблицы атрибутов слоя
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Глава 1. Создание карты … 1.6. Редактирование атрибутов

Рис. 1.9: Редактор атрибутов
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1.7. Создание и вычисление … Глава 1. Создание карты …

11. Найдите поле RiverName и введите название ручья.

12. Завершите редактирование, выбрав на панели редактора пункт меню

Editor > Stop Editing. В появившемся диалоге нажмите Да.

Снимок экрана №3. Окно карты с подписями ручьев

Сохраните документ карты еще раз. Сохраните ваш отчетный файл и поло-

жите его в сетевую папку преподавателя.

1.7 Создание и вычисление атрибутов (дополни-

тельно)

В начало упражнения �

Поля можно не только заполнять вручную, их можно вычислять и копиро-

вать значения из других полей. Но для начала необходимо научиться их созда-

вать.

Предположим, что бригада топографов произвела съемку границы леса в це-

лях ее сравнения с данными 10-летней давности. Чтобы построить карту гра-

ницы леса и совместить ее с другими данными, необходимо знать координа-

ты опорных геодезических пунктов, которые участвовали в планово-высотном

обосновании. Эти пункты есть в базе геоданных Satino.gdb.

1. Добавьте на карту слой GeoPoints (геодезические пункты).

2. Смените через свойства слоя значок на белый треугольник с точкой посе-

редине (он есть в библиотеке).

3. Откройте атрибутивную таблицу слоя.

Есть ли координаты точек в таблице слоя Геодезические пунк-

ты? В каком поле они должны храниться?

Координаты объектов точечного слоя можно вывести в числовое поле. Для

этого создадим два поля X и Y.

4. Выберите в окне таблицы пункт меню Table Options — Add Field….

5. В диалоге введите X (латиницей) в название поля Name.
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Глава 1. Создание карты … 1.8. Контрольные вопросы

6. Теперь необходимо задать тип поля. Раскройте ниспадающий список

Type.

Какой тип должно иметь поле для хранения координат геодези-

ческих пунктов и почему?

7. Установите тип поля Float. Остальные параметры оставьте по умолчанию.

Нажмите OK.

8. Повторите операцию, создав поле Y.

9. Нажмите правой кнопкой на заголовке поля X и выберите в контекстном

меню Calculate Geometry….

10. В появившемся диалоге из ниспадающего списка выберите величину

X Coordinate of Point и единицы измерения Meters.

Обратите внимание, что инструмент Calculate Geometry позволяет вам

вычислять координаты не только в проекции данных (data source), но и в

проекции карты (data frame).

11. Нажмите OK.

12. Повторите вычисление координаты для поля Y

Какого порядка величины получились в полях X и Y? Вспомни-

те, куда направлена ось X в проеции UTM/Гаусса-Крюгера. Нет

ли здесь противоречия?

В ArcGIS используется стандартная система плоских прямо-

угольных координат, в которой ось X направлена на восток,

а ось Y — на север. То же самое касается и проекций Гаусса-

Крюгера и UTM

1.8 Контрольные вопросы

В начало упражнения �

1. Какие типы геометрии допустимы для слоев в базе геоданных?

2. Что хранят системные поля Shape и ObjectID?

3. Если у слоя нет проекции, то в какой системе координат он хранится и в
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1.8. Контрольные вопросы Глава 1. Создание карты …

каких единицах измерения выражены координаты?

4. Как добавить слой базы данных на карту в ArcMap? Опишите последова-

тельность действий.

5. Как получить доступ к настройкам отображения слоя? Опишите последо-

вательность действий.

6. Чем отличается вид компоновки от вида данных?

7. Какая команда меню позволяет создать легенду?

8. Если открыта таблица слоя, что нужно включить, чтобы отредактировать

значение в ячейке?
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Глава 2

Создание общегеографической

карты

Скачать данные и файл отчета

2.1 Введение

Цель задания — знакомство с моделями пространственных объектов и базой

пространственных данных. Визуализация данных на карте. Оформление леген-

ды и компоновки карты.

Параметр Значение

Теоретическая подготовка Модели пространственных данных, модели пространственных объектов, базы пространственных объектов, картографические проекции

Практическая подготовка Не требуется

Исходные данные Картографическая база данных на территорию Швейцарии

Результат Общегеографическая карта Швейцарии в масштабе 1:1 750 000.

Ключевые слова Модели пространственных данных, модели пространственных объектов, базы пространственных данных, классы пространственных объектов, визуализация пространственных данных
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2.2. Начало работы Глава 2. Создание …

2.1.1 Контрольный лист

• Добавить на карту слои базы пространственных данных и оформить их

• Настроить подписи объектов

• Создать компоновку карты и легенду

• Экспортировать результат в графический файл

2.1.2 Аннотация

Задание посвящено знакомству с созданием тематических карт на основе баз

пространственных данных. Вы познакомитесь с представлением площадных,

линейных, точечных объектов в базе пространственных данных. Научитесь со-

здавать карты на их основе, оформлять легенду, сетку координат и зарамочные

элементы карты.

2.2 Начало работы

В начало упражнения �

1. Запустите приложение ArcMap и откройте окно Сatalog

2. Подключитесь к рабочему каталогу Ex02 в окне Сatalog.

В каталоге Ex02находится база геоданныхMapData.gdb, содержащая исход-

ные данные для выполнения задания. Внутри базы геоданных могут быть

объекты следующих типов:

• — слои векторных данных (классы пространственных объ-

ектов),

• — слои растровых данных;

• — обычные таблицы;

3. Раскройте базу данных MapData.gdb и изучите ее содержимое:

Векторные слои базы данных MapData.gdb:
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Глава 2. Создание … 2.2. Начало работы

Рис. 2.1: База данных MapData.gdb
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2.3. Оформление рельефа Глава 2. Создание …

Слой Содержание

Airports Аэропорты

Borders Границы

Cities Города

Countries Страны

Frame Рамка (фрейм)

Heights Высотные отметки

Lakes Озера

Railroads Железные дороги

Rivers Реки

Roads Дороги

Snow Ледники и снежники

UrbanAreas Урбанизированные территории

Растровые слои базы данных MapData.gdb:

Слой Содержание

Elevation Высоты рельефа

Hillshade Отмывка рельефа

2.3 Оформление рельефа

В начало упражнения �

1. Добавьте на карту слой Elevation из базы данных MapData.gdb.

2. В настройках оформления растрового слоя установите способ градиент-

ной окраски со следующими параметрами:

Параметр Значение

Шкала Surface
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Глава 2. Создание … 2.3. Оформление рельефа

Рис. 2.2: Гиспсометрическая окраска рельефа

Параметр Значение

Растяжка гистограммы Минимум-Максимум (Minimum-maximum)

3. Установите передискретизацию слоя в режим кубической cвертки (Cubic

Convolution). Результат:

4. Наложите отмывку поверх гипсометрической окраски. Для этого добавьте

на карту слой отмывки Hillshade и установите для него следующие пара-

метры:

Параметр Значение

Прозрачность 50%

45



2.4. Оформление векторных слоев Глава 2. Создание …

Параметр Значение

Режим передискретизации Кубическая свертка

Остальные параметры оставьте по умолчанию.

Результат:

Снимок экрана №1. Картографическое изображение рельефа

Сохраните документ карты в каталог Ex02 под названием Ex02_Фамилия.

2.4 Оформление векторных слоев

В начало упражнения �

Добавьте на карту и оформите векторные слои, содержащиеся в базе данных

MapData.gdb, все кроме слоя Countries. Для каждого слоя выберите единый сим-

вол. В качестве образца оформления используйте рисунок ниже.

Учтите, что:

• Слой Snow располагается между отмывкой и цветовой окраской рельефа.

Это позволяет показать заснеженные территории, но при этом сохранить

светотеневую пластику.

• При выборе значка для аэропорта следует воспользоваться поиском по

символам, набрав ключевое слово «airport»

Результат:

Снимок экрана №2. Оформление векторных слоев

2.5 Создание подписей

В начало упражнения �

1. Установите масштаб карты равным 1:1 750 000.

2. Включите Maplex для размещения подписей и переведите его в режим

Best
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Глава 2. Создание … 2.5. Создание подписей

Рис. 2.3: Гиспосметрическая окраска и отмывка

3. Сделайте подписи для слоев Cities, Heights, Rivers, Lakes со следующими па-

раметрами:

Cities:

Параметр Значение

Шрифт Calibri

Размер 10

Цвет Черный

Начертание Обычный

Размещение По умолчанию

Образец -

Heights:

Параметр Значение

Шрифт Calibri

Размер 7

Цвет Серый 80%

Начертание Курсивный

Размещение По умолчанию

Образец -

Rivers:

Параметр Значение

Шрифт Calibri

Размер 10

Цвет Синий Dark Navy

Начертание Курсивный
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2.6. Классификация населенных … Глава 2. Создание …

Параметр Значение

Размещение Regular Placement > Offset Curved

Образец -

Lakes:

Параметр Значение

Шрифт Calibri

Размер 8

Цвет Синий Dark Navy

Начертание Курсивный

Размещение Regular Placement > Curved

Образец -

Результат должен выглядеть примерно следующим образом:

2.6 Классификация населенных пунктов

В начало упражнения �

Недостатком полученной карты является то, что все населенные пункты по-

казаны одинаково. Чтобы исправить этого, необходимо разделить их по катего-

риям численности населения. Для этого:

1. В диалоге настройки символов слоя включите режим отображения

Categories (unique values), используя значения поля Население_диапазон

2. Отсортируйте классы численности в нужном порядке, используя стрелоч-

ки.

3. Настройте размер кружка таким образом, чтобы его диаметр менялся от 3
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Глава 2. Создание … 2.6. Классификация населенных …

Рис. 2.4: Образец оформления карты
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2.6. Классификация населенных … Глава 2. Создание …

Рис. 2.5: Оформление векторных слоев

Рис. 2.6: Картографическое изображение с подписями
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Глава 2. Создание … 2.6. Классификация населенных …

Рис. 2.7: Настрояка шкалы размеров значков

до 7 пунктов

Результат:

4. Перейдите на вкладку Labels и переключите подписи в режим нескольких

классов.

5. Импортируйте классы с помощью кнопки Get Symbol Classes.

6. Настройте подписи следующим образом:

• Шрифт Calibri черного цвета

• Размер шрифта должен увеличиваться от низшего класса (менее 10

000) до самого крупного (от 250 000 до 500 000) с 8 до 12 пунктов.

• Подписи городов крупнее 100 000 человек должны быть жирным
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2.7. Маска и подписи стран Глава 2. Создание …

Рис. 2.8: Карта с классифицированными по размеру населенными пунктами

шрифтом.

Результат:

Снимок экрана №3. Классифицированные населенные пункты с подпися-

ми

2.7 Маска и подписи стран

В начало упражнения �

1. Добавьте на карту слойCountries и расположите его между слоямиHillshade

и Snow.

2. Настройте отображение слоя способом Categories (unique values) по по-

лю Name.

3. Установите следующие параметры отображения:
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Глава 2. Создание … 2.8. Настройка компоновки карты

Параметр Значение

Цвет заливки Швейцария — нет заливки, остальные страны — серый 50%

Цвет обводки Нет

Прозрачность слоя 50%

4. Включите подписи стран по полюName, используя следующие параметры:

Параметр Значение

Шрифт Garamond

Размер 24

Цвет Коричневый/Бардовый

Начертание Обычный

5. Также установите следующие параметры размещения:

Параметр Значение

Позиция Type > Land Parcel Placement

Растяжка Распределять символы (Spread Characters)

Плотность размещения Подписывать только крупнейшую часть (Label largest feature part)

Разрешение конфликтов Никогда не удалять (Never Remove)

Образец -

Результат:

Снимок экрана №4. Маска и подписи стран

2.8 Настройка компоновки карты

В начало упражнения �
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2.8. Настройка компоновки карты Глава 2. Создание …

Рис. 2.9: Маскированное картографическое изображение

1. Переключитесь в вид компоновки

2. Настройте макет листа следующим образом:

• Размер А4

• Альбомная ориентировка

3. Подгоните размер фрейма данных таким образом, чтобы карта оказалась

в верхней части листа

4. Установите масштаб равным 1:1 750 000

Результат:

5. Используя настройки по умолчанию, вставьте легенду, включив в нее все

слои, кроме Elevation, Countries и Hillshade

Результат:

6. Измените название показателя для слоя Cities на «число жителей». Умень-

шите размер шрифта до 9 и сделайте его курсивным.

7. Уменьшите размер шрифта для стиля названия слоя Cities до 10 пунктов.

8. Переименуйте все слои в таблице содержания на русский язык в соответ-
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Глава 2. Создание … 2.8. Настройка компоновки карты

Рис. 2.10: Размещение карты в пределах листа
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2.8. Настройка компоновки карты Глава 2. Создание …

Рис. 2.11: Размещение легенды в пределах листа
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Глава 2. Создание … 2.9. Экспорт в графический файл

Рис. 2.12: Регулировка интервала между элементами легенды

ствии с таблицей в начале упражнения. Обратите внимание на то, что в

легенде они переименуются автоматически.

9. Переименуйте заголовок легенды на русский язык.

10. Увеличьте интервал между слоями в легенде до 10 пунктов.

Результат:

11. Вставьте на карту координатную сетку типа Graticule с шагом 1° по широ-

те и долготе. Отключите для градусной сетки показ минут и секунд.

12. Вставьте название карты над картой по центру, используя следующие па-

раметры:

Параметр Значение

Шрифт Arial

Размер шрифта 16

Начертание Полужирный

Разрядка 10 пунктов

13. Вставьте километровую масштабную линейку по нижеприведенному об-

разцу:

14. Добавьте свою фамилию и инициалы справа внизу под легендой.

Снимок экрана №5. Итоговая карта

2.9 Экспорт в графический файл

В начало упражнения �

Экспортируйте карту из режима компоновки в формат PNG с разрешением

300 точек на дюйм.

2.10 Контрольные вопросы

В начало упражнения �
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2.10. Контрольные вопросы Глава 2. Создание …

Рис. 2.13: Карта с градусной сеткой, названием и масштабной линейкой
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Глава 2. Создание … 2.10. Контрольные вопросы

1. Какие типы геометрии допустимы для слоев в базе геоданных? К каким

типам относятся слои, использованные вами в работе?

2. В какой системе координат хранились данные, которые вы использовали

для составления карты?

3. Какая проекция была использована вами в работе? К какому типу по ха-

рактеру искажений она относится?

4. Где хранятся данные, которые используются для классификации символов

при отображении?

5. За что отвечают системные поля Shape и ObjectID?

6. Чем отличается вид компоновки от вида данных?
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2.10. Контрольные вопросы Глава 2. Создание …
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Глава 3

Создание климатической карты

Скачать данные и файл отчета

3.1 Введение

Цель задания — знакомство с моделями пространственных объектов и базой

пространственных данных. Визуализация данных на карте. Оформление леген-

ды и компоновки карты.

Параметр Значение

Теоретическая подготовка Не требуется

Практическая подготовка Модели пространственных данных, модели пространственных объектов, базы пространственных объектов, картографические проекции

Исходные данные Климатические пояса по Алисову (полигональный слой), границы морей и океанов IHO (International Hydrographic Organization), направления основных течений OSCAR (Ocean Surface Current Analyses – Real time), крупнейшие мировые реки и озера, города (данные Esri).

Результат Тематическая карта «Климат и основные объекты гидросферы» масштаба 1:90 000 000

Ключевые слова Модели пространственных данных, модели пространственных объектов, базы пространственных данных, классы пространственных объектов, визуализация пространственных данных, геоинформационное картографирование

3.1.1 Контрольный лист

• Добавить на карту слои базы пространственных данных и оформить их

• Настроить подписи объектов
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3.2. Начало работы Глава 3. Создание климатической карты

• Создать компоновку карты, легенду и координатную сетку

• Экспортировать результат в графический файл

3.1.2 Аннотация

Задание посвящено знакомству с созданием тематических карт на основе баз

пространственных данных. Вы познакомитесь с представлением площадных,

линейных, точечных объектов в базе пространственных данных. Научитесь со-

здавать карты на их основе, оформлять легенду, сетку координат и зарамочные

элементы карты.

3.2 Начало работы

В начало упражнения �

1. Запустите приложение ArcMap и откройте окно Catalog, нажав кнопку

на панели инструментов

2. Найдите вашу папку в дереве каталогов в ней директорию Ex03.

Если вашей директории или вышестоящей директории D:/GIS нет в

списке, подключитесь к ней c помощью кнопки .

В каталоге Ex03 находится база геоданных MapData.gdb, содержащая исход-

ные данные для выполнения задания.

База геоданных — это структурированное хранилище, внутри ко-

торого можно создавать слои данных, группировать их и связывать

различными отношениями.

Внутри базы геоданных могут быть объекты следующих типов:

• — слои векторных данных (классы пространственных объек-

тов),

• — слои растровых данных;

• — обычные таблицы;
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Глава 3. Создание климатической карты 3.2. Начало работы

Класс пространственных объектов (feature class) — это набор

пространственных объектов одного типа геометрии (точки, линии,

полигоны или объемные тела). Для класса могут быть определены

атрибуты, а его представлением является таблица, содержащая как

обычные столбцы (текстовые, числовые и т.д.) так и специальное

поле Shape, в котором хранится информация о геометрии. Каждая

строчка в таблице — это описание одного объекта. В поле ObjectID

хранится уникальный идентификатор каждого объекта.

3. Раскройте базу данных MapData.gdb и изучите ее содержимое, состоящее

из следующих классов:

Класс Содержание

Cities Города

Climates Климатические зоны

Coast Побережье

Countries Страны

Currents Данные о течениях

Lakes Озера

Rivers Крупнейшие реки

Seas Моря

К какому типу геометрии относятся данные классы?

4. Дважды щелкните на слое Climates и перейдите на вкладку XY Coordinate

System.

Внимательно прочитайте информацию. Этот слой хранится в Географической

системе координат (GCS), отнесенной к эллипсоиду WGS-1984. Это означает, что

координаты каждого объекта хранятся в виде широты и долготы. В любой мо-

мент этот слой можно спроецировать в любую проекцию. При этом координаты

будут представлены в метрических единицах, а система координат получит на-

звание Проецированной системы координат (PCS).
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3.3. Оформление базовых слоев Глава 3. Создание климатической карты

3.3 Оформление базовых слоев

В начало упражнения �

1. Ознакомьтесь с главой Оформление векторного слоя в разделе описания

функций.

2. Добавьте на карту слой Countries, просто перетащив его из окна каталога.

3. Дважды щелкните на названии слоя Countries и перейдите на вкладку

Symbology.

4. Внимательно изучите список способов изображения слева. Они разделе-

ны на категории Features (единый символ), Categories (качественные ха-

рактеристики),Quantities (количественные характеристики), Charts (кар-

тодиаграммы), Multiple Attributes (способы изображения по нескольким

атрибутам).Разверните каждую группу и щелкните на каждом способе. Со-

поставьте их с традиционной классификацией способов изображения:
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Глава 3. Создание климатической карты 3.3. Оформление базовых слоев

5. Выберите способ единого символа (Features > Single symbol)

6. Щелкните на кнопке с изображением символа и измените оформление

следующим образом:

Параметр Значение

Цвет заливки (Fill Color) Без заливки
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3.3. Оформление базовых слоев Глава 3. Создание климатической карты

Параметр Значение

Цвет обводки (Outline Color) Серый 50%

Толщина обводки (Outline width) 0,5

Диалог свойств слоя:
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Глава 3. Создание климатической карты 3.3. Оформление базовых слоев

Результат:
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3.3. Оформление базовых слоев Глава 3. Создание климатической карты

7. Измените проекцию карты на проекцию Робинсона (Robinson). Ее мож-

но найти в группе Projected Сoordinate Systems > World. Обратите

внимание на то, как изменятся очертания объектов:

8. Добавьте на карту слой Coast, расположите его поверх слоя Countries и из-

мените цвет линии на Delft Blue:

68



Глава 3. Создание климатической карты 3.3. Оформление базовых слоев

9. Добавьте на карту слой Rivers расположите его поверх слоя Coast и измени-

те цвет линии на Delft Blue, а толщину сделайте равной 0,5 пиксела.

10. Добавьте на карту слой Lakes, расположите его поверх слоя Rivers и изме-

ните его оформление следующим образом:

Параметр Значение

Цвет заливки Sodalite Blue

Цвет обводки Delft Blue

Толщина обводки 0,5

Результат:
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3.3. Оформление базовых слоев Глава 3. Создание климатической карты

11. Сохраните карту в свою директорию Ex03.

12. Добавьте на карту слой Cities, расположите его поверх слоя Lakes и измени-

те его параметры следующим образом:

Параметр Значение

Символ Circle 1

Цвет Черный

Размер 4
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Глава 3. Создание климатической карты 3.3. Оформление базовых слоев

13. Добавьте на карту слой Seas, расположите его внизу таблицы содержания

и измените его параметры следующим образом:

Параметр Значение

Цвет заливки Нет заливки

Цвет обводки Серый 50%

Толщина обводки 0,5

Прозрачность 50%

Результат:
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3.4. Оформление данных о климате и …Глава 3. Создание климатической карты

Снимок экрана №1. Базовые слои

3.4 Оформление данных о климате и морских те-

чениях

1. Добавьте на карту слой Сlimates, расположите его внизу таблицы содержа-

ния.

2. Откройте таблицу атрибутов слоя Сlimates, щелкнув на его названии пра-

вой кнопкой мыши и выбрав командуOpenAttribute Table. Найдите в ней

столбец Type, просмотрите его значения. Это поле таблицы хранит инфор-

мацию о типе климата для каждой области. Вы будете использовать ее для

классификации при отображении данного слоя.

3. Найдите поля Shape и ObjectID.

В поле ObjectID хранится уникальный идентификатор каждого

объекта. Он нужен системе для того, чтобы каждый объект мож-

но было гарантированно найти по некому однозначному крите-

рию.

В поле Shape (вспомните, что слой полигональный) хранится

список координат вершин полигона. Геометрия объектов
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Глава 3. Создание климатической карты3.4. Оформление данных о климате и …

редактируется специальными инструментами, поэтому содер-

жимое поля Shape скрыто от пользователя.

4. Климатические пояса показываются на картах способом качественного фо-

на. Для этого измените оформление слоя Climates следующим образом:

Параметр Значение

Тип визуализатора Categories > Unique values

Поле классификации Type

Сортировка значений От арктического к экваториальному

Цвета полигонов Традиционные цвета климатических поясов (выберите вручную)

Обводка полигонов Нет обводки

Показывать остальные значения Нет

Диалог настройки символики слоя должен выглядеть следующим обра-

зом:
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3.4. Оформление данных о климате и …Глава 3. Создание климатической карты

5. Добавьте на карту слой Сurrents, расположите его поверх слоя Сlimates.

Этот слой содержит данные о течениях OSCAR (Ocean Surface Current

Analyses – Real time), осредненные с 1993 по 2003 год.

Течения относятся к векторным полям. Существует множество

способов визуализации векторных полей. В картографии рас-

пространен способ градиентного поля, при котором стрелки

размещаются по регулярной сетке, их поворот соответствует

направлению векторного поля в точке, а длина — скорости. Для

реализации способа градиентного поля вам нужно выбрать

символ (стрелку), а также указать атрибутивные поля слоя, в

соответствии с которыми будет меняться их направление и

длина.

6. Измените тип символа слоя на символьный маркер и задайте его парамет-

ры следующим образом:

Параметр Значение

Шрифт Esri Geology

Символ Unicode 83

Размер 28

Цвет Серый 70%
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Глава 3. Создание климатической карты3.4. Оформление данных о климате и …

7. Нажмите ОК и еще раз ОК.

8. Чтобы задать направление стрелки, не выходя из диалога свойств слоя на

вкладке Symbology нажмите Advanced > Rotation… и настройте следую-

щие параметры вращения:

Параметр Значение

Поле Direction

Направление Арифметическое

9. Для изменения размера стрелки в зависимости от скорости течения на-

жмите Advanced > Size… Выберите в списке поле Length. Нажмите ОК.
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3.5. Настройка подписей Глава 3. Создание климатической карты

Результат:

10. Сохраните карту.

Снимок экрана №2. Климат и направления морских течений

3.5 Настройка подписей

В начало упражнения �

1. Включите механизм размещения подписей Maplex

2. Дважды щелкните на слое Cities, и перейдите на вкладку Labels.

3. Включите подписи для слоя Cities:
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Глава 3. Создание климатической карты 3.5. Настройка подписей

4. Настройте параметры подписей следующим образом:

Параметр Значение

Label Field Название

Размер 7

Цвет Черный

Разрешение конфликтов Never remove (никогда не удалять)

5. Включите подписи для слоя Rivers со следующими параметрами:

Параметр Значение

Label Field Title

Размер 8

Цвет Delft Blue

Начертание Курсивное

Размещение Curved (криволинейно вдоль)
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3.5. Настройка подписей Глава 3. Создание климатической карты

Параметр Значение

Удалять дубликаты Да

6. Включите подписи для слоя Seas со следующими параметрами:

Параметр Значение

Поле Name

Размер 7

Цвет Delft Blue

7. Переименуйте все слои на русский язык следующим образом:

Исходное название Результирующее название

Cities Города

Climates Климат

Coast Побережье

Countries Страны

Currents Течения

Lakes Озера

Rivers Реки

Результат:
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Глава 3. Создание климатической карты 3.6. Настройка компоновки

8. Сохраните карту.

Снимок экрана №3. Подписи объектов

3.6 Настройка компоновки

В начало упражнения �

1. Переключитесь в вид компоновки с помощью команды менюView—Layout

View.

2. Настройте макет страницы следующим образом:

• Размер А3

• Альбомная ориентировка

3. Подгоните размер фрейма данных таким образом, чтобы карта заняла пло-

щадь всего листа с небольшим запасом.

4. Установите масштаб равным 1:90 000 000 и отцентрируйте карту в пре-

делах листа.
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3.6. Настройка компоновки Глава 3. Создание климатической карты

Результат:

5. Добавьте на карту легенду с помощью команды Insert > Legend, включив

в нее только слои Климат и Течения:

80



Глава 3. Создание климатической карты 3.6. Настройка компоновки

6. В следующем диалоге название легенды оставьте пустым:
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3.6. Настройка компоновки Глава 3. Создание климатической карты

7. Далее все параметры оставьте по умолчанию.

8. Уберите заголовок поля для слоя Климат:

9. Добавьте градусную сетку координат со следующими параметрами:

Параметр Значение

Шаг по X 20

Шаг по Y 20

10. Измените начало расстановки линий сетки для оси Y на 0.

11. Отключите отображение нулевых минут и секунд.

12. Разместите над картой текст «КЛИМАТ И ОСНОВНЫЕ ОБЪЕКТЫ ГИДРО-

СФЕРЫ».
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Глава 3. Создание климатической карты 3.7. Экспорт в графический файл

13. Разместите под картой по центру численный масштаб 1:90 000 000.

14. Разместите в правом нижнем углу карты текст «Выполнил» и свое ФИО.

Результат:

15. Сохраните карту.

Снимок экрана №4. Итоговая карта

3.7 Экспорт в графический файл

В начало упражнения �

1. Экспортируйте карту из режима компоновки в формат PNG с разрешением

300 точек на дюйм с помощью команды File > Export Map. Сохраните его

в свою директорию.

2. Вставьте карту в отчетный файл.

3.8 Контрольные вопросы

В начало упражнения �
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3.8. Контрольные вопросы Глава 3. Создание климатической карты

1. Какие типы геометрии допустимы для слоев в базе геоданных? К каким

типам относятся слои, использованные вами в работе?

2. В какой системе координат хранились данные, которые вы использовали

для составления карты?

3. Какая проекция была использована вами в работе? К какому типу по ха-

рактеру искажений она относится?

4. Где хранятся данные, которые используются для классификации символов

при отображении, изменения их размера и направления?

5. За что отвечают системные поля Shape и ObjectID?

6. Чем отличается вид компоновки от вида данных?
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Глава 4

Создание

социально-экономической карты

Скачать данные и файл отчета

4.1 Введение

Цель задания — знакомство с моделями пространственных объектов и базой

пространственных данных. Визуализация данных на карте. Оформление леген-

ды и компоновки карты.

Параметр Значение

Теоретическая подготовка Модели пространственных данных, модели пространственных объектов, базы пространственных объектов, картографические проекции

Практическая подготовка Не требуется

Исходные данные Сетка субъектов Федерации с привязанной статистикой по населению, государственная граница России, крупнейшие города России, крупнейшие озера, страны.

Результат Тематическая карта «Население России» масштаба 1:35 000 000

Ключевые слова Модели пространственных данных, модели пространственных объектов, базы пространственных данных, классы пространственных объектов, визуализация пространственных данных, геоинформационное картографирование
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4.2. Начало работы Глава 4. Создание социально- …

4.1.1 Контрольный лист

• Добавить на карту слои базы пространственных данных и оформить их

• Настроить подписи объектов

• Создать компоновку карты, легенду и координатную сетку

• Экспортировать результат в графический файл

4.1.2 Аннотация

Задание посвящено знакомству с ГИС на примере создания социально-

экономической карты. Вы познакомитесь с представлением площадных,

линейных, точечных объектов в базе пространственных данных. Научитесь со-

здавать карты на их основе, оформлять легенду, сетку координат и зарамочные

элементы карты, познакомитесь с применением картограмм и картодиаграмм

в геоинформационном картографировании.

4.2 Начало работы

В начало упражнения �

1. Скачайте с сервера каталог Ex04 и положите его в свою директорию.

2. Запустите приложение ArcMap и откройте окно Сatalog, нажав кнопку

на панели инструментов.

3. Подключитесь к рабочему каталогу Ex04 в окне Сatalog:
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Глава 4. Создание социально- … 4.2. Начало работы

В каталоге Ex04находится база геоданныхMapData.gdb, содержащая исход-

ные данные для выполнения задания.

База геоданных — это структурированное хранилище, внутри

которого можно создавать слои данных, группировать их и свя-

зывать различными отношениями.

Внутри базы геоданных могут быть объекты следующих типов:

• — слои векторных данных (классы пространственных объ-

ектов),

• — слои растровых данных;

• — обычные таблицы;

Класс пространственных объектов (feature class) — это на-

бор пространственных объектов одного типа геометрии (точки,

линии, полигоны). Для класса могут быть определены атрибу-

ты, а его представлением является таблица, содержащая столб-

цы разного типа (текстовые, числовые и т.д.). Каждая строчка в

таблице — это описание одного объекта.
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4.3. Создание картограмм Глава 4. Создание социально- …

4. Раскройте базу данных MapData.gdb и изучите классы пространственных

объектов внутри нее:

Класс Содержание

Borders Государственная граница РФ

Cities Города

Lakes Озера

Regions Субъекты федерации

Countries Страны

К какому типу геометрии относятся данные классы?

5. Дважды щелкните на слое Regions и перейдите на вкладку XY Coordinate

System.

Внимательно прочитайте информацию. Этот слой хранится в Географиче-

ской системе координат (GCS), отнесенной к эллипсоиду WGS-1984. Это

означает, что координаты каждого объекта хранятся в виде широты и

долготы. Этот слой можно спроецировать в любую проекцию. При этом

координаты будут представлены в метрических единицах, а система

координат получит название Проецированной системы координат (PCS).

4.3 Создание картограмм

В начало упражнения �

1. Добавьте на карту слой Regions. Для этого просто перетащите его из окна

Каталога на карту.

2. Переименуйте его в «Плотность населения». Для этого дважды (медленно)

щелкните на названии слоя или выделите его и нажмите клавишу F2:
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Глава 4. Создание социально- … 4.3. Создание картограмм

3. Измените проекцию карты на равновеликую коническую проекцию Аль-

берса. Ее можно найти по следующему пути:

Projected Coordinate Systems > Continental > Asia > Asia North Albers

Equal Area Conic

Обратите внимание на то, как изменится форма отображаемых объектов.

4. Откройте таблицу атрибутов слоя. Найдите в ней столбецDensity, просмот-

рите его значения. Это поле таблицы хранит значения плотности населе-

ния по субъектам.

5. Найдите поля Shape и ObjectID.

В поле ObjectID хранится уникальный идентификатор каждого

объекта. Он нужен системе для того, чтобы каждый объект мож-

но было гарантированно найти по некому однозначному крите-

рию.

В поле Shape хранится геометрия объектов. Если слой точечный

— это будут просто пары координат X и Y для каждого объекта.

Для линейных и полигональных слоев это будет уже упорядо-

ченный набор пар координат вершин границы объекта. Геомет-

рия редактируется специальными инструментами, поэтому со-

держимое поля Shape скрыто от пользователя.

6. Дважды щелкните на названии слоя и на вкладке Symbology и выберите

способ изображения Quantity — Graduated colors (Картограммы).

7. Выберите в списке Value Field поле Density, система автоматически сфор-

мирует список классов, созданных методом естественных интервалов.

Существует множество методов классификаций: равных

интервалов, квантилей, стандартных отклонений и т.д. По

умолчанию всегда выбирается метод естественных интер-

валов, т.к. считается, что он в среднем неплохо отражает

особенности распределения. Следует знать, однако, что этот

метод классификации плохо справляется с распределения-

ми, обладающими значительной асимметрией и эксцессом
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4.3. Создание картограмм Глава 4. Создание социально- …

(heavy-tail distribution).

8. Измените число классов на 7:

9. Измените метод классификации. Для этого нажмите Classify. В появив-

шемся диалоговом окне выберите в списке сверху ручной метод задания

интервалов (Manual) и в правом столбце замените первые шесть значений

на следующие: 1, 10, 25, 50, 100, 250. Максимальное значение оставьте без

изменений. Жмите ОК:

10. На вкладке Symbology выберите цветовую шкалу Yellow To Dark Red:
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Глава 4. Создание социально- … 4.3. Создание картограмм

11. Инвертируйте сортировку классов, чтобы наверху оказались максималь-

ные градации:

12. Инвертируйте цветовую шкалу, чтобы цвета соответствовали градациям:

13. В основном диалоге настройки символов исправьте подписи классов (стол-

бец Label) в соответствии с нижеприведенным фрагментом:

14. Нажмите ОК.

15. Переименуйте показатель в «чел/кв. км»:
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4.4. Создание картодиаграмм Глава 4. Создание социально- …

Результат:

Снимок экрана №1. Картограммы плотности населения

16. Сохраните документ карты (File > Save As) в свою директорию Ex4 под

названием Ex4.mxd.

4.4 Создание картодиаграмм

В начало упражнения �

2. Скопируйте и вставьте слой «Плотность населения». Переименуйте его в

«Численность населения»:
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Глава 4. Создание социально- … 4.4. Создание картодиаграмм

3. Разместите новый слой поверх слоя плотности населения.

4. Измените его способ изображения на Картодиаграммы (Quantities >

Graduated Symbols).

5. Выберите для отображения поле SUM_Все_население. Появится шкала клас-

сификации картодиаграмм.

6. Измените цвет кружка на голубой. Для этого нажмите кнопку Template,

выберите значок Circle 2 с тонкой обводкой и смените цвет заливки:

7. Установите число классов равным 6:
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4.4. Создание картодиаграмм Глава 4. Создание социально- …

8. Аналогично предыдущему слою выберите ручной метод классификации

и введите следующие границы классов: 500, 1000, 2500, 5000, 10000. Мак-

симальную границу оставьте прежней:

9. Нажмите ОК.

10. Инвертируйте порядок классов и порядок символов в классификации (ана-

логично предыдущему слою) так чтобы наверху оказались максимальные

значения.

11. Установите на вкладке Symbology максимальный и минимальный размер

значка равным 18 и 4 пункта соответственно:
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Глава 4. Создание социально- … 4.4. Создание картодиаграмм

12. Отредактируйте подписи классов по аналогии с картограммами:

13. Задайте символ фона картодиаграмм в виде полигона с пустой заливкой и

пустой обводкой. Для этого щелкните на кнопке Background и выберите

режим No Color для заливки и для обводки:

14. Нажмите ОК.
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4.5. Оформление … Глава 4. Создание социально- …

Результат:

Снимок экрана №2. Картодиаграммы численности населения

15. Сохраните документ карты

4.5 Оформление общегеографической основы

В начало упражнения �

1. Добавьте на карту слои Borders, Cities, Countries и Lakes. Установите следую-

щий порядок слоев в таблице содержания:

a. Cities

b. Borders

c. Lakes

d. Численность населения

e. Плотность населения

f. Countries

2. Переименуйте вновь добавленные слои следующим образом:
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Глава 4. Создание социально- … 4.5. Оформление …

Исходное название Результирующее название

Cities Города

Borders Граница РФ

Lakes Озера

Countries Страны

3. Присвойте слою Граница РФ единый символ Boundary, National.

4. Присвойте слою Озера единый символ Lake.

5. Измените цвет точек слоя Города на белый.

6. Установите следующие параметры оформления для площадного слоя

Страны:

Параметр Значение

Цвет заливки Серый 10%

Цвет обводки Серый 50%

Толщина обводки 1
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4.6. Настройка подписей Глава 4. Создание социально- …

Результат:

Снимок экрана №3. Карта с элементами общегеографической основы

7. Сохраните документ карты.

4.6 Настройка подписей

В начало упражнения �

1. Включите механизм размещения подписей Maplex:
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Глава 4. Создание социально- … 4.6. Настройка подписей

2. Включите подписи для слоя Города на вкладке Labels. Выберите в качестве

поля для подписей name_2. Остальные настройки оставьте по умолчанию:

3. Включите подписи для слоя Страны. Настройте подписи следующим обра-

зом:

Параметр Значение

Поле (label field) Название
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4.7. Настройка компоновки Глава 4. Создание социально- …

Параметр Значение

Тип размещения Криволинейное (Curved)

Разрядка слов Да

Разрядка букв Да

Подписывать только наибольшую часть Да

Результат:

Снимок экрана №4. Карта с подписями объектов

4. Сохраните документ карты.

4.7 Настройка компоновки

В начало упражнения �

1. Переключитесь в вид компоновки через команду меню View > Layout

View

2. Настройте макет страницы следующим образом:

• Размер А4
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Глава 4. Создание социально- … 4.7. Настройка компоновки

• Альбомная ориентировка

3. Установите масштаб карты равным 1 : 35000000. Подгоните размер фрей-

ма данных таким образом, чтобы он был слегка больше контура России.

Для этого используйте стрелку на панели Tools. Разместите его в пра-

вом верхнем углу карты.

4. Отцентрируйте контур России внутри фрейма (рамки). Для этого исполь-

зуйте лапу на панели Tools.

5. Смените цвет фрейма данных (фона) на светло-голубой.

Результат:

6. Добавьте на карту легенду, включив в нее только слои Численность населе-

ния и Плотность населения. Нажмите Далее.
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4.7. Настройка компоновки Глава 4. Создание социально- …

7. В следующем диалоге название легенды оставьте пустым:
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8. Далее все параметры оставьте по умолчанию.

9. Добавьте сетку координат со следующими параметрами:

Параметр Значение

Тип сетки градусная

Шаг по широте 10

Шаг по долготе 10

10. Отключите отображение нулевых минут и секунд.

11. Разместите над картой текст заголовка карты, используя панель Drawing

или меню Insert:
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4.8. Экспорт в графический файл Глава 4. Создание социально- …

12. Разместите под картой по центру численный масштаб 1 : 30000000.

13. Разместите в правом нижнем углу карты текст «Выполнил» и свое ФИО.

Результат:

Снимок экрана №5. Итоговая карта

14. Сохраните карту.

4.8 Экспорт в графический файл

В начало упражнения �

1. Экспортируйте карту из режима компоновки (File > Export Map…) в фор-
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Глава 4. Создание социально- … 4.9. Контрольные вопросы

мат PNG с разрешением 300 точек на дюйм. Сохраните его в свою директо-

рию.

2. Вставьте карту в отчетный файл

4.9 Контрольные вопросы

В начало упражнения �

1. Какие типы геометрии допустимы для слоев в базе геоданных? К каким

типа относятся слои, использованные вами в работе?

2. В какой системе координат хранились данные, которые вы использовали

для составления карты?

3. Какая проекция была использована вами в работе? К какому типу по ха-

рактеру искажений она относится?

4. Где хранятся числовые данные, которые используются для построения

картограмм и картодиаграмм?

5. За что отвечают системные поля Shape и ObjectID?

6. Чем отличается вид компоновки от вида данных?
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Часть II

Базовые технологии
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Глава 5

Привязка и цифрование

туристской карты

Скачать данные и файл отчета

5.1 Введение

Цель задания— знакомство с привязкой, трансформированием и цифрованием

геоизображений.

Параметр Значение

Теоретическая подготовка Системы координат и проекции на картах, привязка геоизображений, трансформирование геоизображений, цифрование геоизображений. Методы трансформации: аффинное, проективное, полиномиальное, метод резинового листа (сплайны).

Практическая подготовка Знание основных компонент интерфейса ArcGIS Desktop (каталог, таблица содержания, карта). Работа с базой геоданных. Настройка символики и подписей объектов.

Исходные данные Растровые карты для привязки, база пространственных данных на территорию Швейцарии.

Результат База данных со следующими слоями: границы природных зон; линии туристического маршрута; остановки вдоль маршрута; проект карты карта с компоновкой

Ключевые слова Системы координат, проекции, трансформирование координат, пространственная привязка, цифрование, классы пространственных объектов, база пространственных данных,

5.1.1 Контрольный лист

• Привязать растровые карты к опорным данным
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5.2. Привязка карт Глава 5. Привязка и цифрование …

• Создать базу геоданных и классы пространственных объектов

• Наполнить классы пространственных объектов путем цифрования привя-

занных карт

• Наполнить атрибуты объектов значениями

• Разработать символику и подписи для слоев карты

• Подготовить компоновку карты

• Экспортировать карту в графический файл

5.1.2 Аннотация

Задание посвящено знакомству с привязкой растровых карт, созданием и напол-

нением баз пространственных данных путем цифрования, оформлением карт на

их основе.

В задании предлагается привязать в координатную систему карту природ-

ных зон и карту туристического маршрута по территории Швейцарии. По ре-

зультатам цифрования этих карт вы составите туристскую карту, показываю-

щую прохождение маршрута по разным природным зонам.

5.2 Привязка карт

В начало упражнения �

1. Внимательно прочтите разделПривязка растровыхданных (Georeferencing)

в разделе Описание функций.

2. Добавьте на карту слой Countries из базы данных упражнения 3.

3. Добавьте на карту растр SwissRegions.gif. Появится диалог, предупреждаю-

щий вас, что добавляемый файл не имеет пространственной привязки. На-

жмите ОК:
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Глава 5. Привязка и цифрование … 5.2. Привязка карт

4. Убедитесь, что контур страны отображается примерно посередине экрана.

5. Откройте панель инструментов Georeferencing. Выберите в меню коман-

ду Fit to Display, чтобы переместить непривязанный растр на середину

области отображения:
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5.2. Привязка карт Глава 5. Привязка и цифрование …

6. Сделайте растровый слой прозрачным на 50%.

7. Используя инструмент расстановки контрольных точек, укажите 3-6

соответствующих точек по границе страны на характерных выступах кон-

тура:
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Глава 5. Привязка и цифрование … 5.2. Привязка карт

8. Выберите команду меню Georeferencing > Update Georeferencing, чтобы

завершить привязку растра. При этом по умолчанию будет примененоаф-

финное преобразование с минимизацией среднеквадратической ошибки

отклонения исходных и целевых координат:
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5.2. Привязка карт Глава 5. Привязка и цифрование …

Снимок экрана №1. Привязанная карта физико-географических регионов

1. Добавьте на карту слой WineSafariRoute.jpg.

2. Выберите его в списке на панели Georeferencing:

3. Отключите слой SwissRegions.gif в таблице содержания.

4. Привяжите растр WineSafariRoute аналогично предыдущему растру,

используя контрольные точки:
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Глава 5. Привязка и цифрование … 5.3. Создание базы данных и классов …

1.Выберите команду Georeferencing > Update georeferencing, чтобы завер-

шить привязку второго растра.

Снимок экрана №2. Привязанная карта маршрута

5.3 Создание базы данных и классов простран-

ственных объектов

В начало упражнения �

1. Прочитайте параграф База геоданных в разделе Описание функций.

2. Создайте в папке Ex05 базу геоданных под названием RouteMap.gdb.

3. Создайте в базе данных классы пространственных объектов со следующи-

ми параметрами:

Название Модель пространственных объектов Атрибутивные поля Проекция

Regions Полигональная (polygon features) NAME (text) WGS_1984_UTM_Zone_32N (импортируйте у слоя карты)

Routes Линейная (line features) - WGS_1984_UTM_Zone_32N (импортируйте у слоя карты)
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Название Модель пространственных объектов Атрибутивные поля Проекция

Places Точечная (point features) NAME (text) WGS_1984_UTM_Zone_32N (импортируйте у слоя карты)

По завершению создания слоев они автоматически будут добавлены на кар-

ту:

5.4 Цифрование регионов

В начало упражнения �

1. Прочитайте параграф Редактирование в разделе Описание функций.

2. Оставьте включенными только слои Regions, SwissRegions и Countries.
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3. Уберите прозрачность у слоя SwissRegions.

4. Откройте сеанс редактирования для слоя Regions. Появится панель редак-

тирования Editor, а также окно шаблонов объектов Create Features:

5. Щелкните на шаблоне объекта Regions в окне Create Features и выберите

режим цифрования Polygon:
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6. Оцифруйте регион Prealpine Zones в центре карты. По завершению дважды
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Глава 5. Привязка и цифрование … 5.4. Цифрование регионов

щелкните мышкой:

7. Чтобы появилась возможность пристыковать остальные регионы к грани-

цам стран, выделите в слое Countries все страны, кроме Швейцарии, ско-

пируйте их в буфер обмена и вставьте в слой Regions:

8. Выделите опять шаблон Regions в окне Create Features.
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9. Используя режимAuto-Complete Polygon, оцифруйте границы оставших-

ся регионов в следующем порядке:

• Сначала небольшие регионы, примыкающие к границам:

• Затем область второго порядка (горы Юра):
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• Наконец, границу между центральными регионами:

10. Выделите в слое Regions границы стран и удалите их.

11. Выберите команду Editor > Save Edits, чтобы сохранить результаты редак-

тирования.
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Результат:

Снимок экрана №3. Векторный слой физико-географических регионов

5.5 Атрибутирование регионов

В начало упражнения �

1. Уберите заливку регионов, линии сделайте толщиной 1.5-2 пиксела:
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2. Откройте атрибутивную таблицу слоя Regions.

3. Поочередно выделяя каждый объект в таблице или на карте, заполните его

атрибуты в соответствии с легендой:
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4. Сохраните изменения и завершите сеанс редактирования.

Снимок экрана №4. Атрибутированные регионы

5.6 Цифрование маршрутов и точек интереса

В начало упражнения �

1. Выключите слои Regions и SwissRegions.gif.

2. Включите слои WinSafariRoute, Routes и Places.

3. Оцифруйте объекты слоев Places и Routes, используя инструменты панели

Сreate Features:

• Начните с расстановки точек:
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• Увеличьте масштаб, чтобы были хорошо видны изгибы линий:

• Проведите линии через получившиеся точки, повторяя контур

исходной линии на растровой подложке. Каждую линию начинайте

в точке и завершайте двойным щелчком в перекрестке:
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Результат:

4. Заполните названия городов в слое Places.
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5. Сохраните изменения и завершите сеанс редактирования.

Снимок экрана №5. Слои маршрута и пунктов назначения

5.7 Оформление карты

В начало упражнения �

1. Оставьте включенными слои Regions, Routes, Places и Countries. Остальные

слои выключите.

2. Уберите заливку у слоя Countries.

3. Оформите слой Regions методом категорий по полю NAME:
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4. Оформите слои Routes и Places по аналогии с нижеприведенным фрагмен-

том:

5. Откройте панель Labeling и включите Maplex для размещения подписей.

6. Включите подписи для слоя Places со следующими настройками:
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Параметр Значение

Поле для подписей NAME

Шрифт Tahoma

Кегль (размер) 12

Цвет Черный

Начертание Обычное

Результат:

Некоторые подписи могут быть размещены не очень удачно. Чтобы они не

перекрывали линии маршрута и значки выполните следующие действия:

1. Откройте настройки весов подписей Label Weight Ranking на панели

Labeling

2. Установите вес равным 1000 слоям Places и Routes:
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Результат:

3. Добавьте на карту слойHillshadeиз базы данных упражнения 3, разместите

его над слоем Regions и установите прозрачность 80%.
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Результат:

4. Добавьте на карту слой Lakes и присвойте ему символ полигона с голубой

заливкой без обводки.

Результат:

Снимок экрана №6. Оформление карты

5.8 Компоновка карты

В начало упражнения �

1. Переключитесь в режим компоновки.

2. Установите альбомную ориентировку листа.
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5.9. Контрольные вопросы Глава 5. Привязка и цифрование …

3. Оформите компоновку в соответствии с нижеприведенным образцом:

Снимок экрана №7. Компоновка карты

1. Экспортируйте карту в формат PNG с разрешением 300 dpi.

2. Сохраните документ карты.

5.9 Контрольные вопросы

В начало упражнения �

1. В какой последовательности расставляются контрольные точки при при-

вязке данных? Каково их оптимальное расположение?

2. Какой метод трансформирования изображения вы использовали в работе?

3. Как пристыковать один полигон к другому, не оцифровывая их общую гра-

ницу? Опишите последовательность действий.
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Глава 6

Привязка и цифрование

гидрогеологической карты

Скачать данные и файл отчета

6.1 Введение

Цель задания— знакомство с привязкой, трансформированием и цифрованием

геоизображений, элементами базовых технологий ГИС (оверлей, пространствен-

ные запросы).

Параметр Значение

Поток Гидрометпоток, Физпоток

Теоретическая подготовка Системы координат и проекции на картах, привязка геоизображений, трансформирование геоизображений, цифрование геоизображений. Методы трансформации: аффинное, проективное, полиномиальное, метод резинового листа (сплайны). Пространственные запросы, атрибутивные запросы, оверлей.

Практическая подготовка Знание основных компонент интерфейса ArcGIS Desktop (каталог, таблица содержания, карта). Работа с базой геоданных. Настройка символики и подписей объектов.

Исходные данные Слои картографической основы (карт масштаба 1:2 500 000), растровая карта гидрогеологического районирования на район среднего течения Дона.

Результат Слой гидрогеологического районирования в базе данных. Слой рек, обогащенный данными о принадлежности участков рек к артезианским бассейнам. Проект карты с оформленной компоновкой

Ключевые слова Системы координат, проекции, трансформирование координат, пространственная привязка, цифрование, оверлей, пространственные запросы, атрибутивные запросы
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6.2. Оформление базовых слоев Глава 6. Привязка и цифрование …

6.1.1 Контрольный лист

• Привязать растровую карту к опорным данным

• Создать в базе геоданных класс пространственных объектов для районов

• Наполнить класс районов путем цифрования растровой карты

• Заполнить названия районов

• Осуществить оверлей для обогащения слоя рек данными о принадлежно-

сти к бассейнам, выполнить пространственный и атрибутивный запрос

• Подготовить проект гидрогеологической карты с компоновкой

6.1.2 Аннотация

Задание посвящено знакомству с привязкой растровых карт, созданием и напол-

нением баз пространственных данных путем цифрования, использовании овер-

лея, пространственных и атрибутивных запросов. Эти методы входят в число ба-

зовых технологий геоинформатики. С их помощью в дальнейшем вы сможете

решать множество задач. Одним из источников питания рек являются артези-

анские воды. К артезианским водам относятся подземные воды, находящиеся

в водоносных горизонтах, перекрытых и подстилаемых водоупорными (или от-

носительно водоупорными) слоями горных пород, и обладающие гидростатиче-

ским напором. В задании предлагается перевести в векторный вид карту гидро-

геологического районирования среднего течения Дона и далее наполнить этой

информацией участки рек, чтобы в дальнейшем определять источник питания

каждой реки.

6.2 Оформление базовых слоев

В начало упражнения �

1. Скопируйте каталог Ex06 в свою папку.

2. Откройте приложение ArcMap, создайте новый документ карты и сохра-

ните его в свою папку Ex06.
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3. Подключитесь в окне каталога к папке Ex06. Убедитесь, что в ней находит-

ся база геоданных Don.gdb и растровый файл DonArtesian.png.

4. Раскройте базу геоданных и перенесите на карту классы Lakes и Rivers

5. Присвойте слою Lakes символ с голубой заливкой и синей обводкой.

6. Настройте оформление слоя Rivers следующим образом:

• Выберите способ изображения по категориям (уникальные значе-

ния).

• В качестве поля для отображения используйте атрибут Тип. Нажмите

Add All Values.

• Покрасьте все реки в синий цвет. Для этого щелкните на заголовке

первого столбца Symbol и вызовите команду Properties for all

symbols. Выберите точно такой же цвет, что вы использовали для

обводки озер.

• Установите следующие параметры толщины линий:

Слой Толщина линии

Реки постоянные крупные 2 пункта

Реки постоянные средние 1,5 пункта

Остальные классы 1 пункт

Диалог примет следующий вид:

7. Включите опцию подписи рек. Перейдите на вкладу Labelsи отметьте фла-

жок Label features in this layer. Выберите поле Название в качестве поля

для подписей, смените их цвет на темно-синий и установите криволиней-

ное размещение вдоль линии. Нажмите ОК. В результате операции все ре-

ки будут подписаны.

8. Чтобы были подписаны только крупнейшие реки, необходимо использо-

вать определяющий запрос на языке SQL. Для этого откройте снова свой-

ства слоя и на вкладке Labels выберите метод «Define classes of features and

label each class separately». Нажмите кнопку SQL query… и введите в поле
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Рис. 6.1: Рисунок 5
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Глава 6. Привязка и цифрование … 6.2. Оформление базовых слоев

следующий текст запроса:

”CLASS” = 2 OR ”CLASS” = 3

Чтобы избежать ошибок ввода, вы можете дважды щелкнуть на поле CLASS

в списке слева — оно подставится в запрос. Добавьте знак =. Далее нажми-

те кнопкуGet unique valuesи найдите 2-й класс. Щелкните на нем дважды

— после этого название поля подставится в текст запроса. После этого вве-

дите оператор OR и повторите ввод для 3-го класса. Диалог примет следу-

ющий вид:
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9. Нажмите ОК в диалоге свойств слоя. Карта примет следующий вид:
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Глава 6. Привязка и цифрование … 6.3. Привязка карты

10. Сохраните документ карты в свою папку Ex06 под именем Don.mxd.

Снимок экрана №1 — Реки

6.3 Привязка карты

В начало упражнения �

1. Добавьте на карту из базы данных слой DonArtesian.png и поместите его

непосредственно под слоем Rivers. При добавлении слоя появится диало-

говое окно, предупреждающее о том, что файл не имеет привязки. Закрой-

те его.

2. Поместите карту в центр окна ArcMap.

Для выполнения дальнейшей работы прочтите разделПривяз-

ка растровых данных в приложении.

3. Откройте панель инструментов Georeferencing. Убедитесь, что в ее спис-

ке выбран файл DonArtesian. Выберите в ее меню команду Fit to Display,

чтобы переместить непривязанный растр на середину области отображе-
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ния.

4. Поместите растр непосредственно под слоем Rivers.

5. Используя инструмент расстановки контрольных точек, укажите пять кон-

трольных точек в разных частях карты. Желательно, чтобы точки были

равномерно распределены по полю карты (по краям и в центре) и не рас-

полагались на одной линии — это обеспечит хорошие коэффициенты транс-

формации. В качестве точек используйте места впадения притоков и впа-

дения рек в водохранилища. Например, можно использовать точку впаде-

ния реки Хопёр в реку Дон:
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6. Ознакомьтесь с доступными методами трансформирования по кон-

трольным точкам. Для этого в меню Georeferencing выберите команду

Transformation. По умолчанию выбрано аффинное преобразование.

Какие еще виды трансформирования доступны? Чем про-

ективное преобразование отличается от аффинного?

Оставьте выбранным аффинное преобразование.

7. Осуществите трансформирование растра. На панели инструментов

Georeferencing выберите команду меню Georeferencing > Update

Georeferencing. Контрольные точки удалятся.

Картографическое изображение примет следующий вид:
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6.4. Создание слоя … Глава 6. Привязка и цифрование …

Снимок экрана №2 — Привязанная растровая карта

8. Сохраните документ карты в формате mxd в папке отчета.

6.4 Создание слоя гидрогеологического райониро-

вания

В начало упражнения �

1. Создайте новый класс пространственных объектов в базе геоданных

Don.gdb. Для этого:

• На первом шаге назовите слойArtesian, выберите площадную модель

пространственных объектов (Polygon features).
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• На втором шаге выберите систему координат. Оптимально исполь-

зовать ту же систему, что используется в базовых данных. Для этого

ее можно импортировать у существующего слоя. Нажмите Add

Coordinate Systems > Import, найдите и укажите любой слой в базе

данных Don.gdb.

• На 3-м и 4-м шагах оставьте все параметры по умолчанию.

• На 5-м шаге добавьте в первую пустую строку новое поле Basin. Тип

поля — Text. В этом поле вы будете хранить название гидрогеологи-

ческого бассейна.

• Нажмите Finish.

2. Добавьте получившийся слой на карту и разместите его вверху таблицы

содержания.

3. Отключите слои рек и озер.

Для выполнения дальнейшей работы прочтите раздел Редак-

тирование в приложении.

4. Включите режим редактирования слоя. Для этого в его контекстном меню

выберите команду Edit Features > Start Editing.

5. Откройте список шаблонов слоя и посмотрите доступные опции редакти-

рования в нижней части окна.

6. Оцифруйте все бассейны. Выполняйте работу в следующей последователь-

ности.

• Сначала оцифруйте Донецко-Донской бассейн (IV) с помощью обычно-

го инструмента Polygon.

• Далее последовательно пристыкуйте к нему оставшиеся бассейны с

помощью инструмента Auto Complete Polygon. Замкните их по гра-

нице листа.

7. После того как редактирование районов завершено, сохраните изменения,

выбрав команду Editor > Save Edits.

8. Откройте таблицу атрибутов слоя районов. Поочередно выделяя каждый

из них (для этого щелкните в самом начале строки), введите в поле Basin
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его название, ориентируясь по карте. Слово «бассейн» не вводите:

9. После ввода названий снова сохраните изменения.

10. Завершите редактирование, выбрав команду Editor > Stop Editing.

11. Измените оформление слоя в соответствии с цветами на исходном растре.

12. Включите подписи районов по полю Basin.

13. Отключите слой растровой карты. Включите снова слои рек и озер и пе-

реместите их вверх таблицы содержания. Картографическое изображение

примет следующий вид:
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14. Сохраните документ карты в папке отчета.

Снимок экрана №3 — Слой артезианских бассейнов

6.5 Оформление карты

В начало упражнения �

1. Добавьте на карту слои Boundaries (границы) и Cities (города). Используйте

для их отображения способ Categories и настройте отображение разными

символами классов границ, а также городов в соответствии с численно-

стью населения. При оформлении подписей городов используйте метод

классифицированных подписей (прочтите соответствующий раздел в

файле Описание функций). Пример результирующего изображения:
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Снимок экрана №4 — Карта

2. Переключитесь в режим компоновки и оформите легенду карты. Добавьте

название «Гидрогеологическое районирование среднего течения Дона», а так-

же масштаб и свои ФИО.

3. Экспортируйте результирующую карту в файл в формате PNG и вставьте

ее в отчет.

Следующие разделы являются дополнительными и выполня-

ются на усмотрение преподавателя. Перед их выполнением це-

лесообразно ознакомиться с разделом Выборка объектов в прило-

жении.

6.6 Пространственный запрос (дополнительно)

В начало упражнения �

Для получения информации о взаимном положении объектов или поиске

объектов, основанном на их местоположении, вы можете использовать три ме-
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тода:

• Вычисление расстояний

• Пространственный запрос

• Оверлей

Вычисление расстояний позволяет оценить попарные расстояния между

объектами, найти для каждого объекта ближайший к нему. Пространственный

запрос осуществляет выборку объектов, находящихся в указанных топологиче-

ских отношениях с другими объектами. Например, вы можете сказать «выбрать

реки, находящиеся целиком внутри (completely within) Московского артезианского

бассейна» или смягчить запрос, указав «выбрать реки, пересекающие (intersect)

Московский артезианский бассейн». Частным случаем пространственного запро-

са также является поиск объектов по координатам, диапазону координат или

произвольно заданной области. В этом случае пользователь чаще всего обводит

на карте прямоугольником интересующую его зону, при этом выбираются

объекты, пересекающие или находящиеся целиком внутри выделенной зоны.

Рассмотрим, как можно выберать реки, принадлежащие Приволжско-

Хоперскому бассейну.

1. Выделите на карте Приволжско-Хоперский бассейн, используя инстру-

мент на панели Tools.

2. Откройте диалог пространственной выборки (Selection > Select by

Location)

3. Выберите в диалоге пространственной выборки слой Rivers в качестве вы-

бираемого (target) и слой Artesian в качестве выбирающего (source). От-

метьте галочкой пункт Use Selected Features — это позволит выбирать с

использованием уже выбранных объектов.

4. Выберите метод выборки intersect the source layer feature — пересечение.

5. Нажмите Apply. Будут выбраны реки, пересекающие выбранный артези-

анский бассейн:
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6. Выберите метод выборки are completely within the source layer feature (полно-

стью внутри).

7. Нажмите Apply. Будут выбраны реки, находящиеся полностью внутри вы-

бранного бассейна:

8. Очистите выборку с помощью инструмента Clear Selected Features:
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Глава 6. Привязка и цифрование … 6.7. Оверлей (дополнительно)

6.7 Оверлей (дополнительно)

В начало упражнения �

Оверлей (от англ. overlay — наложение), в отличие от пространственного за-

проса, создает новые данные путем геометрической композиции входных слоев.

Полученные участки наследуют атрибуты от каждого слоя. Эта операция базиру-

ется на стандартных отношениях множеств, таких как пересечение, объедине-

ние и симметрическая разность. Оверлей позволяет понять, какие комбинации

объектов встречаются в пространстве. Так, если в качестве аргументов служат

реки и бассейны, то в результате выполнения оверлея реки будут разрезаны на

участки в соответствии с границами бассейнов.

Для выполнения оверлея вы будете использовать инструменты геообработ-

ки.

Геообработка (geoprocessing) в терминологии ArcGIS — это анализ

и преобразование пространственных данных. Инструменты геооб-

работки находятся в Арктулбоксе (ArcToolbox), где они сгруппиро-

ваны по назначению. Некоторые наборы инструментов, такие как

Spatial Analyst и 3D Analyst, с которыми вы познакомитесь на следу-

ющих занятиях, являются дополнительными модулями ArcGIS.

С помощью оверлея можно разбить речную сеть на сегменты, принадлежа-

щие разным бассейнам, а полученным сегментам автоматически присвоить на-

звание бассейна.
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1. Щелкните по базе данных Don.gdb правой кнопкой мыши и выберите

пункт Make Default Geodatabase. Эта команда указывает системе, что

все результаты обработки данных (новые слои) следует помещать в

выбранную базу геоданных.

2. Откройте ArcToolbox с помощью кнопки на главной панели инстру-

ментов.

3. Раскройте группу инструментов Analysis Tools > Overlay. Здесь можно

найти различные режимы оверлея.

4. Запустите инструмент Identity, который находит геометрическое пересе-

чение двух слоев и присваивает атрибуты второго слоя участкам первого

слоя.

5. Заполните его параметры следующим образом:

Параметр Значение

Input features Rivers

Identity Features Artesian

Output Feature Class <Ваша папка>\Ex06\Don.gdb\Rivers_Identity

JoinAttributes ALL

Диалог инструмента примет следующий вид:
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После выполнения инструмента слой будет добавлен на карту. Раскройте

его таблицу атрибутов, чтобы убедиться, что каждому участку реки присвоена

принадлежность к артезианскому бассейну (часть строк будет пустой, так как

созданный вами слой артезианских бассейнов покрывает не всю территорию):

6.8 Атрибутивный запрос (дополнительно)

В начало упражнения �
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6.8. Атрибутивный запрос … Глава 6. Привязка и цифрование …

Атрибутивный запрос позволяет искать объекты по значениям их атрибутов.

В результате выполнения оверлея вы можете найти участки рек, принадлежащие

артезианским бассейнам, по информации, содержащейся в поле Basin.

1. Откройте диалог атрибутивной выборки (меню Selection > Select by

Attributes).

2. Выберите в качестве выбираемого слой Rivers_Identity.

3. Введите следующий текст запроса:

”Basin” = 'Приволжско-Хоперский'

4. На карте будут выделены водотоки, принадлежащие данному артезиан-

скому бассейну. Обратите внимание на то, что выборка теперь полностью

совпадает с границами бассейна.

5. Откройте таблицу атрибутов слоя Rivers_Identity и укажите опцию Show

Selected records, чтобы показывать только выбранные объекты:

6. Скомпонуйте окна приложения таким образом, чтобы было видно одно-

временно окно атрибутивного запроса, таблицу атрибутов слоя со столб-

цом Basin, а также картографическое изображение с выделенными реками.

Окно приложения примет следующий вид:
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7. Сохраните документ карты.

6.9 Контрольные вопросы

В начало упражнения �

1. В какой последовательности расставляются контрольные точки при при-

вязке данных? Каково их оптимальное расположение?

2. Какой метод трансформирования изображения вы использовали в работе?

В чем его суть?

3. Как пристыковать один полигон к другому, не оцифровывая их общую гра-
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ницу? Опишите последовательность действий.

4. Что позволяют делать атрибутивная и пространственная выборки? (допол-

нительно)

5. В чем суть операции оверлея слоев? Чем эта операция отличается от про-

странственной выборки? (дополнительно)
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Глава 7

Привязка и цифрование

административной карты

Скачать данные и файл отчета

7.1 Введение

Цель задания— знакомство с привязкой, трансформированием и цифрованием

геоизображений, элементами базовых технологий ГИС (оверлей, пространствен-

ные запросы).

Параметр Значение

Теоретическая подготовка Системы координат и проекции на картах, привязка геоизображений, трансформирование геоизображений, цифрование геоизображений. Методы трансформации: аффинное, проективное, полиномиальное, метод резинового листа (сплайны). Пространственные запросы, атрибутивные запросы, оверлей.

Практическая подготовка Знание основных компонент интерфейса ArcGIS Desktop (каталог, таблица содержания, карта). Работа с базой геоданных. Настройка символики и подписей объектов.

Исходные данные Cлои картографической основы OpenStreetMap, растровая карта районов Лондона.

Результат База данных со слоем границ районов Лондона. Результаты выборки и статистика по количеству отелей в пределах каждого района. Картодиаграммы по числу отелей в каждом районе. Проект карты с оформленной компоновкой

Ключевые слова Системы координат, проекции, трансформирование координат, пространственная привязка, цифрование, оверлей, пространственные запросы, атрибутивные запросы, библиотеки символов, картодиаграммы
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7.2. Добавление референцных данных Глава 7. Привязка и цифрование …

7.1.1 Контрольный лист

• Привязать растровую карту к опорным данным

• Дополнить класс районов путем цифрования растровой карты

• Заполнить названия новых районов

• Определить путем пространственного запроса количество отелей в каж-

дом районе.

• Построить картодиаграммы по полученным значениям с использованием

нестандартных библиотек символов

• Подготовить проект карты с компоновкой

7.1.2 Аннотация

Задание посвящено знакомству с привязкой растровых карт, созданием и напол-

нением баз пространственных данных путем цифрования, оформлением карт на

основе баз данных. В этом задании вы также познакомитесь с запросами, с по-

мощью которых можно ограничивать число отображаемых объектов.

В задании предлагается выполнить координатную привязку карты районов

Лондона и оцифровать недостающие районы для создания персональной БГД

«Административные районы Лондона». Далее, используя запросы к БГД, по

каждому району определить количество входящих в него отелей, и построить

социально-экономическую карту, которая показывает способом картодиа-

грамм количество отелей в каждом районе. Работа завершается оформлением

компоновки карты.

7.2 Добавление референцных данных

В начало упражнения �

1. Скопируйте каталог Ex07 в свою папку и разархивируйте внутри него файл

London.zip — он содержит базу геоданных для выполнения упражнения.

2. Подключитесь в окне Каталога к вашей папке Ex07. Убедитесь, что в ней
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находится база геоданных London.gdb и растровый файл InnerLondon.png:

3. Раскройте базу геоданных и перенесите на карту класс пространственных

объектов Roads, присвойте ему символ в виде черной линии толщиной 0,5

пункта.

4. Добавьте на карту также слой Water и присвойте ему символ Lake (голубой

полигон с синей обводкой). Картографическое изображение примет следу-

ющий вид:

Снимок экрана №1. Картографическая основа

5. Сохраните документ карты в свою папку Ex07 под именем London.mxd.

7.3 Привязка карты

В начало упражнения �

1. Добавьте на карту из окна каталога слой InnerLondon.png и поместите его

под слои Water и Roads. При добавлении слоя появится диалоговое окно,

предупреждающее о том, что файл не имеет привязки. Закройте его.

2. Расположите карту в центре окна ArcMap.
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7.3. Привязка карты Глава 7. Привязка и цифрование …

Для выполнения дальнейшей работы прочтите разделПривяз-

ка растровых данных в приложении.

3. Откройте панель инструментов Georeferencing. Выберите в ее меню ко-

манду Fit to Display, чтобы переместить непривязанный растр на середи-

ну области отображения.

4. Используя инструмент расстановки контрольных точек на панели

Georeferencing, укажите по крайней мере 3 контрольные точки в разных

частях города:

Щелкайте сначала на растре, затем на векторном слое. В качестве точек ис-

пользуйте перекрестки дорог, которые вы можете найти как на растре, так

и на картографической основе. Например, и на растре и на основе хорошо

распознается перекресток на западной окраине Хемпстеда:

Желательно, чтобы точки были равномерно распределены по полю карты

(по краям и в центре) и не располагались на одной линии — это обеспечит

хорошие коэффициенты трансформации.
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5. Ознакомьтесь с доступными методами трансформирования по контроль-

ным точкам. Для этого в меню на панели Georeferencing выберите ко-

манду Transformation. По умолчанию выбрано аффинное преобразова-

ние. При пяти контрольных точках будет доступно также проективное пре-

образование. Оставьте выбранным аффинное преобразование:

6. Осуществите трансформирование растра. Для этого на панели инстру-

ментовGeoreferencing выберите команду менюGeoreferencing > Update

Georeferencing. После выполнения трансформирования контрольные

точки удалятся.

Картографическое изображение примет следующий вид:
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7.4. Создание слоя городских районов Глава 7. Привязка и цифрование …

Снимок экрана №2 Привязанный растровый слой

7. Сохраните документ карты в папке отчета.

7.4 Создание слоя городских районов

В начало упражнения �

1. Отключите слой дорог и слой гидрографии, оставив видимой только под-

ложку.

2. Добавьте на карту класс пространственных объектовDistricts. Он содержит

районы северного берега Темзы. Вам необходимо его дополнить, оцифро-

вав районы южного берега реки:
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Для выполнения дальнейшей работы прочтите раздел Редак-

тирование в приложении.

3. Включите режим редактирования слоя Districts. Для этого в его контекст-

ном меню выберите команду Edit Features > Start Editing.

4. Откройте список шаблонов слоя, нажав кнопку Create Features на панели

Editor и посмотрите доступные опции.

5. Оцифруйте недостающие городские районы. Выполняйте работу в следу-

ющей последовательности:

• Сначала оцифруйте район Wandsworth с помощью обычного инстру-

мента Polygon.

• Далее последовательно пристыкуйте к нему оставшиеся районы юж-

ного берега с помощью инструмента Auto-Complete Polygon.

• Участки, примыкающих к реке, аккуратно проведите по береговой

линии аналогично районам северного берега.

6. После того как редактирование районов завершено, сохраните изменения,

выбрав команду Editor > Save Edits.

7. Откройте таблицу атрибутов слоя районов (Ctrl + двойной щелчок мышью

по названии слоя). Поочередно выделяя каждый из новых районов, введи-

те в поле Name его название, ориентируясь по карте.

8. После ввода названий снова сохраните изменения.

9. Завершите редактирование, выбрав команду Editor > Stop Editing.
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7.5. Расчет статистики по районам Глава 7. Привязка и цифрование …

10. Измените оформление слоя следующим образом: сделайте пустую залив-

ку, а обводку сделайте оранжевого цвета толщиной 1,5 пункта.

11. Включите подписи районов по полю Name.

12. Отключите слой растровой карты.

13. Включите слой дорог и установите ему прозрачность, равную 60%.

Картографическое изображение примет следующий вид:

Снимок экрана №3. Оцифрованные городские районы с подписями

14. Сохраните документ карты.

7.5 Расчет статистики по районам

В начало упражнения �

В данной части работы предлагается определить количество отелей, кото-

рые попадают в пределы каждого района, затем построить картодиаграммы по

полученным значениям. Для этого будет использован следующий алгоритм:

• Выбрать текущий район.
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• Выбрать здания, попадающие в его пределы (пространственный запрос).

• Из полученной выборки оставить только здания, являющиеся отелями

(атрибутивный запрос).

• Записать число отобранных зданий в атрибут Hotels текущего района.

Эти операции необходимо повторить для каждого района.

Перед выполнением анализа следует создать атрибутивное поле, в котором

будет храниться число отелей. Для этого:

1. Остановите сеанс редактирования, если это не было сделано ранее (Editor

> Stop Editing).

2. Откройте таблицу атрибутов слоя.

3. Выберите команду менюAdd Field… (если она не активна, это значит, что

вы не остановили сеанс редактирования на панели Editor).

4. Введите название поляHotels и тип поля Short Integer. Диалог примет сле-

дующий вид:
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7.5. Расчет статистики по районам Глава 7. Привязка и цифрование …

5. Нажмите ОК. Поле будет добавлено в слой.

6. Добавьте на карту класс building_points из базы геоданных London.gdb. Раз-

местите его под слоем districts. В данном слое каждая точка соответствует

зданию.

7. Откройте атрибутивные таблицы слоев districts и buildings и расположите

их друг над другом в левой части окна:
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8. Включите редактирование слоя districts и выберите в его таблице первую

строчку (нужно щелкнуть на заголовке слева от строки).

Для выполнения дальнейшей работы прочтите раздел Выбор-

ка объектов в приложении.

9. Откройте диалог пространственной выборки (Selection > Select by

Location) и диалог атрибутивной выборки (Selection > Select by >

Attributes). Расположите их рядом.

10. Выберите в диалоге пространственной выборки слой building_points в каче-

стве выбираемого (target) и слой districts в качестве выбирающего (source).

Отметьте галочкой пунктUse Selected Features— это позволит выбирать с

использованием уже выбранного района. Диалог примет следующий вид:
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11. Нажмите кнопку Apply — на карте должны выбраться здания, попавшие в

пределы выбранного района. Не закрывайте диалог.

12. Перейдите в диалог атрибутивной выборки. В качестве выбираемого слоя
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Глава 7. Привязка и цифрование … 7.5. Расчет статистики по районам

укажите building_points и смените режим выборки на Select from current

selection. В этом режиме будет осуществляться подвыборка среди уже вы-

бранных объектов.

13. Введите следующий атрибутивный запрос, чтобы отобрать отели: type =

'hotel' Диалог примет следующий вид:
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14. Нажмите Apply. Не закрывайте диалог атрибутивной выборки. На карте

останутся выбранными только те здания текущего района, которые

являются отелями. Чтобы ознакомиться с их списком, перейдите в атри-
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бутивную таблицу слоя building_points и включите режим показа только

выбранных объектов (Show selected records):

Внизу таблицы вы можете увидеть число выбранных объектов (на рисунке

их 8, у вас может получиться другое число, если выделен другой район).

15. Внесите указанное число в атрибутивную таблицу слоя districts для теку-

щего выбранного района:

16. Выберите следующий район в таблице слоя districts (на рисунке выше это

будет район Islington).

17. Повторите шаги 5–10 для всех оставшихся районов. На всем протяжении

выполнения этих операций у вас должны быть открыты таблицы обоих

слоев, а также диалоговые окна атрибутивной и пространственной выбор-

ки.

18. Сохраните документ карты

Законченная таблица должна содержать в поле Hotels число отелей для каж-

дого района:
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7.6. Построение картодиаграмм Глава 7. Привязка и цифрование …

Снимок экрана №4. Атрибутивная таблица с числом отелей по каждому

району

7.6 Построение картодиаграмм

В начало упражнения �

1. Отключите слой building_points.

2. Создайте точки для размещения картодиаграмм числа отелей. Для этого

• Щелкните правой кнопкой мыши по базе данных London.gdb и выбе-

рите пункт Make Default Geodatabase, чтобы результаты обработки

складывались в эту базу.

• Откройте ArcToolbox и запустите инструмент геообработки Data

Management Tools > Features > Feature to Point.
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• Укажите в качестве Input Features слой Districts. Исправьте название

выходного класса на Hotels. Диалог примет следующий вид:

3. Нажмите ОК. Созданный слой точек будет добавлен на карту.

4. Создайте картодиаграммы на основе полученных точек. Для этого:

• Включите режим Graduated Symbols на вкладке Symbology.

• Выберите поле Hotels в качестве поля по которому будет произво-

диться классификация.

• Аналогично первому упражнению, отредактируйте границы классов.

Предлагается выделить следующие классы: менее 5, 5-9, 10-19, 20-29,

30 и более. Для этого необходимо нажать кнопку Classify и заменить

границы первых четырех классов на 4, 9, 19, 29. Максимальное значе-

ние не трогайте. Нажмите ОК.

• Измените шаблон картодиаграммы на значок отеля. Для этого снача-

ла прочтите разделы Подключение библиотек символов и поиск сим-

волов по названию в разделе Описание функций. Нажмите кнопку

Template на вкладке Symbology. Далее подключите библиотеку Civic

и найдите в ней символ Hotel Information 1. Выберите его и нажмите

ОК.

• Отредактируйте подписи классов, изменив первый на «less than 5», а

последний — на «30 and more».

• Измените максимальный и минимальный размер значка на 48 и 16

соответственно. Диалог настройки символов примет следующий

вид:
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5. Нажмите ОК.

6. Сохраните документ карты

7.7 Настройка оформления других слоев

В начало упражнения �

Требуется отредактировать оформление слоев, чтобы получить картографи-

ческое изображение хорошего стиля и качества.

1. Расположите слои в следующем порядке сверху вниз: Hotels — Roads —

Water — Districts — InnerLondon.

2. В настройках слоя Districts:

• Измените цвет заливки на серый 10%.

• Измените символ обводки на Boundary, County. Увеличьте его толщи-

ну до 6 пунктов, а цвет установите серый 20%.

• Замените стандартный шрифт подписей на более современный
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Euphemia, установите размер 8 ижирное начертание. Включите гало

подписей, чтобы они хорошо читались на фоне.

3. Для слоя Water отключите обводку, оставив только голубую заливку.

4. Необходимо запретить подписям районов перекрывать значки карто-

диаграмм. Для этого откройте панель Labeling, откройте на ней меню

Labeling и убедитесь, что включен механизм размещения подписей

Maplex. Далее нажмите кнопку Label Weight Ranking:

В открывшемся диалоге исправьте значение Feature Weight для слоя

Hotels на 1000.
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Любому слою может быть присвоен вес от 0 до 1000. Чем вы-

ше вес, тем меньше вероятность, что слой будет перекрываться

подписями.

Нажмите ОК. Картографическое изображение примет следующий вид:
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Глава 7. Привязка и цифрование … 7.8. Компоновка

Снимок экрана №5. Картодиаграммы числа отелей по городским райо-

нам

5. Сохраните документ карты

7.8 Компоновка

В начало упражнения �

Оформите компоновку карты с легендой в соответствии со следующим об-

разцом.

Для этого:

1. Установите масшта равным 1:100 000.

2. Для заголовка карты используйте также шрифт Euphemia синего цвета.

3. Под заголовок подложите прямоугольник серого цвета 30%.

4. Добавьте масштабную линейку в милях синего цвета.
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5. Добавьте легенду к слою Hotels, отключите в ней названия самого слоя и

единиц измерения, чтобы остались только плашки и их подписи.

6. Добавьте к фрейму данных рамку серого цвета 30%. Для этого в свойствах

фрейма данных на вкладке Frame выберите границу Border и измените ее

параметры. Выровняйте прямоугольник названия по верхнему правому

углу карты.

По завершению оформления Экспортируйте карту в файл формата PNG в

вашей директории Ex07 с разрешением 150 точек на дюйм, чтобы вставить ее в

отчет.

7.9 Контрольные вопросы

В начало упражнения �

1. В какой последовательности расставляются контрольные точки при при-

вязке данных? Каково их оптимальное расположение?

2. Какой метод трансформирования изображения вы использовали в работе?

3. Как пристыковать один полигон к другому, не оцифровывая их общую гра-

ницу? Опишите последовательность действий.

4. Что такое атрибутивная и пространственная выборка? В чем их отличие?
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Глава 8

Привязка табличных данных

Скачать данные и файл отчета

8.1 Введение

Цель задания — научиться использовать статистические данные для построе-

ния социально-экономических карт методом картограмм и картодиаграмм.

Параметр Значение

Теоретическая подготовка Соединение таблиц в реляционных базах данных, внешний и внутренний ключ соединения, картограммы, картодиаграммы

Практическая подготовка Знание основных компонент интерфейса ArcGIS Desktop (каталог, таблица содержания, карта). Работы с базой пространственных данных. Настройка символики и подписей объектов.

Исходные данные Слои статистических единиц Евросоюза NUTS и таблицы показателей с портала NUTS

Результат Карта количества транспортных средств в Швейцарии по единицам 3-го уровня, карта плотности и структуры населения Швейцарии по единицам 3-го уровня

Ключевые слова Статистические данные, картограммы, картодиаграммы, соединение таблиц, визуализация статистических данных.

8.1.1 Контрольный лист

• Скачать слои административно-территориального деления с сайта NUTS.

• Скачать статистические таблицы NUTS на уровень 3.

• Присоединить таблицы статистики к слою административных единиц.
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8.2. Скачивание географических … Глава 8. Привязка табличных данных

• Создать карту количества автомобилей способом картодиаграмм.

• Создать карту населения способом картограмм и секторных картодиа-

грамм.

8.1.2 Аннотация

В основе многих социально-экономических карт лежат статистические данные,

которые обычно предоставляются в табличном виде. Задание посвящено зна-

комству с созданием карт в среде ГИС на основе табличных данных. В качестве

примера используется официальная статистика Евросоюза, размещенная на сай-

те NUTS. Попутно при выполнении задании вы познакомитесь с операцией со-

единения таблиц.

8.2 Скачивание географических данных с сайта

NUTS

В начало упражнения �

1. Перейдите на главную страницу NUTS и прочитайте краткую информа-

цию на ней.

2. Выберите в правой части окна пункт меню NUTS Geodatafiles at GISCO.

3. Скачайте файлыNUTS 2010 для масштаба 1:3Million в формате Personal GDB

и сохраните их себе в каталог Ex08.

8.3 Скачивание таблиц с сайта NUTS

В начало упражнения �
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Глава 8. Привязка табличных данных 8.3. Скачивание таблиц с сайта NUTS

1. На главной странице NUTS выберите в правой части окна пункт меню

Statistics on regions and cities.

2. На сайте статистикиNUTS выберите пунктDatabase, чтобы перейти к про-

смотру таблиц базы данных:

3. Найдите таблицу плотности населения по регионам Population density -

NUTS 3 regions (demo_r_d3dens) и нажмите иконку слева от нее:

4. Нажмите Table Customization > Show, чтобы настроить содержание таб-

лицы:

5. Установите режим Codes, чтобы в первом столбце отображались уникаль-

ные идентификаторы вместо названий единиц.
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8.4. Скачивание структурных таблиц … Глава 8. Привязка табличных данных

6. Нажмите кнопку Download, чтобы скачать таблицу:

7. В появившемся окне нажмите кнопкуDownload in Excel format, не меняя

никаких настроек.

Скачайте аналогичным образом таблицу Stock of vehicles by category andNUTS 2

regions (tran_r_vehst), содержащую статистику по количеству зарегистрированных

транспортных средств в регионах.

8.4 Скачивание структурных таблиц с сайта NUTS

В начало упражнения �

1. Найдите таблицу Population on 1 January by broad age groups and sex - NUTS 3

regions и откройте ее.

2. Нажмите кнопку Select Data в заголовке сайта:
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Глава 8. Привязка табличных данных 8.4. Скачивание структурных таблиц …

3. В левой части окна выберите вкладку AGE, отметьте галочками все пункты

и нажмите UPDATE, чтобы обновить таблицу:

4. Нажмите вкладку VIEW Table в верхней части окна, чтобы перейти к про-

смотру таблицы.

5. Схватите мышкой показатель Age и переместите его в таблицу на место

показателя TIME:
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В результате таблица должна приобрести искомую структуру, в которой

показана структура населения по 3 категориям: до 15 лет (дети), 15-64 года

(трудоспособные) и старше 64 лет (пенсионеры). Помимо этого есть поле

Unknown для населения неустановленной возрастной категории:

6. Включите режим показа кодов вместо названий единиц.

7. Скачайте таблицу в формате Microsoft Excel.

8.5 Форматирование таблиц для загрузки в ГИС

В начало упражнения �

Чтобы скачанные таблицы можно было использовать в ГИС, их нужно отфор-

матировать следующим образом:

1. Удалите все строки выше заголовка.
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Глава 8. Привязка табличных данных 8.5. Форматирование таблиц для …

2. Переименуйте поле GEO/TIME в GEO.

3. Переименуйте поля таким образом, чтобы:

• Они не содержали пробелов, символов “ / “, “ -” и тому подобных.

Символ подчеркивания “_” допускается.

• Название поля начиналось с буквы.

4. Установите столбцам показателей числовой формат с необходимым чис-

лом десятичных знаков.

5. Сохраните таблицы под названиями:

• Density.xls (плотность населения),

• Population.xls (структура населения),

• Vehicles.xls (число зарегистрированных транспортных средств).

Пример преобразования таблиц представлен на рисунках ниже.

Было:

Стало:
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8.6. Подготовка проекта Глава 8. Привязка табличных данных

8.6 Подготовка проекта

В начало упражнения �

1. Откройте ArcMap и создайте новый документ карты в каталоге Ex08.

2. Добавьте на карту слой Countries из базы данных предудыщего упражне-

ния.

3. Добавьте на карту слой NUTS_RG_03M_2010 из базы данных, которую вы

скачали с сайта. Она находится в каталоге PGDB/data:

4. Присвойте добавленному слою символ полигона без заливки с обводкой

красного цвета и переименуйте его в NUTS.

5. Выделите в таблице слоя NUTS строку, в которой NUTS\_ID = “CH”, кото-

рая соответствует региону Швейцарии. Обратите внимание на то, что таб-

лица может быть отсортирована не по алфавиту, а по статусу единицы:
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Глава 8. Привязка табличных данных 8.6. Подготовка проекта

6. Выделите все регионы, находящиеся внутри выделенной единицы,

используя пространственный запрос со следующими параметрами:

Параметр Значение

Слой искомых объектов NUTS

Слой-источник NUTS

Пространственный запрос Are within the layer feature
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8.7. Отображение картодиаграмм по … Глава 8. Привязка табличных данных

Результат:

7. Создайте новый слой на основе выбранных объектов он получит на-

звание «NUTS selection».

8. Отключите исходный слой NUTS.

8.7 Отображение картодиаграмм по единицам 2-

го уровня

В начало упражнения �

1. Скопируйте слой NUTS selection, вставьте и назовите его Транспортные

средства (NUTS 2).

2. С помощью определяющего запроса в окне конструктора запроса вклю-

чите единицы 2-го уровня, введя строку:

\[STAT\_LEVL\_CODE\] = 2

При вводе строки используйте двойной щелчок на названии вместо ввода

текста вручную.
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Глава 8. Привязка табличных данных 8.7. Отображение картодиаграмм по …

Результат:

3. Добавьте на карту листData таблицыVehicles и переименуйте его вVehicles:

4. Раскройте таблицу слоя Транспортные средства, чтобы просмотреть со-

став атрибутивных полей. Таблица содержит поле NUTS_ID, содержащее

уникальные идентификаторы единиц NUTS.

187



8.7. Отображение картодиаграмм по … Глава 8. Привязка табличных данных

5. Присоедините таблицу VEHICLES к слою Транспортные средства, исполь-

зуя следующие параметры:

Параметр Значение

Ключевое поле слоя NUTS_ID

Присоединяемая таблица VEHICLES

Ключевое поле таблицы GEO

Раскройте таблицу слоя Транспортные средства (NUTS 2), чтобы убедиться
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Глава 8. Привязка табличных данных 8.7. Отображение картодиаграмм по …

в результате:

6. Включите для слоя способ градуированных символов (картодиаграм-

мы), используя следующие параметры:

Параметр Значение

Поле показателя 2011 год

Размер значка От 15 до 60

Метод классификации Равноинтервальный с шагом 200 (Defined Interval)

Фоновый символ Без заливки

Цвет диаграммы выберите по своему вкусу. Диалог примет следующий
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8.7. Отображение картодиаграмм по … Глава 8. Привязка табличных данных

вид:

7. Переименуйте название показателя в таблице слоев в «тысяч штук».

Результат:
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Глава 8. Привязка табличных данных 8.8. Отображение картограмм по …

8.8 Отображение картограмм по единицам 3-го

уровня

В начало упражнения �

1. Скопируйте слойNUTS selectionи назовите его «Плотность населения (NUTS

3)».

2. Включите единицы 3-го уровня, по аналогии с единицами 2-го уровня.

3. Добавьте на карту лист Data таблицы Density и переименуйте его в

DENSITY.

4. Присоедините таблицу DENSITY к слою Плотность населения, используя

те же поля, что и в случае слоя транспорта.

5. Включите для слоя метод отображенияGraduated Colors (картограммы),

используя следующие параметры:

Параметр Значение

Поле статистики 2011 год

Цветовая шкала От желтого к коричневому (по умолчанию)

Метод классификации Дженкса (естественных интервалов)

Количество интервалов 5
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8.8. Отображение картограмм по … Глава 8. Привязка табличных данных

Диалог свойств слоя примет следующий вид:

6. Переименуйте название показателя в таблице содержания в «чел/кв. км.».

7. Перенесите слой со статистикой транспорта так, чтобы он располагался

поверх слоя плотности населения и увеличьте толщину обводки полиго-

нов до 1.5 пиксела.

Результат позволяет одновременно показывать статистику по двум уровням
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Глава 8. Привязка табличных данных 8.9. Отображение структурных …

иерархии:

8.9 Отображение структурных картодиаграмм по

единицам 3-го уровня

В начало упражнения �

1. Скопируйте слойNUTS selectionи назовите его «Структура населения (NUTS

3)».

2. Включите единицы 3-го уровня.

3. Добавьте на карту лист Data таблицы Population и переименуйте его в

POPULATION.

4. Присоедините таблицу POPULATION к слою Структура населения.

5. Определите русскоязычные псевдонимы полям на вкладке Fields:

• Y_LT15 — моложе 15 лет,

• Y_15_64 — от 15 до 64 лет,

• Y_GE65 — старше 64 лет,

• TOTAL — человек.

Результат:
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8.9. Отображение структурных … Глава 8. Привязка табличных данных

6. Включите для слоя метод отображения Pie Charts (секторные диаграм-

мы), используя следующие параметры:

Параметр Значение

Поля статистики моложе 15 лет, от 15 до 64 лет, старше 64 лет

Цвета Выберите на свой вкус

Минимальный размер 5

Размер По полю “Человек” (TOTAL)
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Глава 8. Привязка табличных данных 8.9. Отображение структурных …

Диалог примет следующий вид:

Результат:

Структура населения в целом очень похожа по регионам, при этом незначи-

тельно варьируется численность населения пенсионного и нетрудоспособного

населения.
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8.10. Оформление итоговых карт Глава 8. Привязка табличных данных

8.10 Оформление итоговых карт

В начало упражнения �

1. Добавьте на карту слой городов из базы данных задания 3.

2. С помощью определяющего запроса оставьте только те города, у кото-

рых значение поля Pop\_Rank <= 6. Это города с населением 50 000 чело-

век и более:

3. Оформите слой городов аналогично заданию 3, разделив их на классы.

4. Включите подписи стран.

5. Перекрасьте страны в нейтрально-серый цвет.

6. Установите масштаб карты равным 1:2 000 000.

7. Переключитесь в режим компоновки и установите альбомную ориенти-

ровку.

8. Подгоните размер фрейма таким образом, чтобы он охватывал страну с

небольшим запасом.
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Глава 8. Привязка табличных данных 8.11. Экспорт карты числа …

Результат:

Пока что не обращайте внимания на то, что слои перекрывают друг друга.

При экспорте вы будете оставлять включенным только один из них.

9. Добавьте на карту легенду, включив в нее слои Транспортные средства,

Структура населения и Плотность населения.

10. Переведите элементы легенды на русский язык и сотрите заголовок леген-

ды.

11. Вставьте заголовок карты «ШВЕЙЦАРИЯ» и масштабную линейку.

8.11 Экспорт карты числа транспортных средств

1. Отключите слои плотности населения и структуры населения. В легенде

останется только слой с картодиаграммами.

2. Отредактируйте подписи классов таким образом, чтобы убрать у них

незначащие нули.
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8.12. Экспорт карты населения Глава 8. Привязка табличных данных

Результат:

3. Экспортируйте карту в графический файл формата PNG c разрешением

300 dpi.

8.12 Экспорт карты населения

В начало упражнения �

1. Включите слои плотности населения и структуры населения. Отключите

слой транспортных средств.

2. Включите отображение названия слоя в легенде для слоя Структура насе-

ления.

3. Уберите незначащие нули в подписях классов слоя плотности населе-

ния, оставив один знак после запятой.
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Глава 8. Привязка табличных данных 8.13. Контрольные вопросы

Результат:

4. Экспортируйте карту в графический файл формата PNG c разрешением

300 dpi.

8.13 Контрольные вопросы

В начало упражнения �

1. Каким требованиям должны отвечать таблицы для их успешной загрузки

в ГИС?

2. Что такое соединение таблиц? Опишите последовательность действий для

соединения таблиц в ArcGIS?

3. Где хранятся числовые данные, которые используются для построения

картограмм и картодиаграмм?

4. Как должны быть организованы данные показателей в таблице для постро-

ения структурных картодиаграмм?
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Глава 9

Привязка адресных данных

Скачать данные и файл отчета

9.1 Введение

Цель— научиться выполнять пространственную привязку адресных данных ме-

тодом геокодирования и построение карт на их основе.

Параметр Значение

Теоретическая подготовка Геокодирование, адресные локаторы и их типы, интерполяция по данным в нерегулярно расположенных точках, методы интерполяции.

Практическая подготовка Знание основных компонент интерфейса ArcGIS Desktop (каталог, таблица содержания, карта). Настройка символики и подписей объектов. Выделение объектов на карте. Пространственные и атрибутивные запросы. Оверлей. Инструменты геообработки.

Исходные данные Таблица адресов ресторанов McDonald’s на территорию Манхэттена (Нью-Йорк) с данными о средней посещаемости. Картографический сервис Esri Streets. Сервис геокодирования NYSGIS.

Результат Геокодированные точки адресов. Визуализация точек значками разного диаметра в соответствии с посещаемостью. Поле посещаемости, построенное по точечным данным. Проект карты с элементами компоновки (легенда, масштаб).

Ключевые слова Геокодирование, адресный локатор, интерполяция данных.

9.1.1 Контрольный лист

• Подключить картографический сервис Esri Streets

• Подключить сервис геокодирования NYSGIS

• Добавить на карту таблицу с адресами и геокодировать их в автоматиче-
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9.2. Подключение к сервисам Глава 9. Привязка адресных данных

ском режиме

• Исправить вручную несопоставленные точки

• Визуализировать точки значками разного диаметра в соответствии с чис-

лом посетителей

• Построить по точкам поле посещаемости методом естественных соседов

(Natural Neighbor).

• Оформить итоговую карту распределения

9.1.2 Аннотация

Задание посвящено знакомству с геокодированием и построением непрерыв-

ных полей на основе точечных данных. Геокодирование — это определение коор-

динат объектов по их географическим текстовым описаниям, которые, как пра-

вило, выражены в виде адресов и/или почтовых кодов.

На основе точечных данных часто восстанавливают поле распределения

некоторого показателя. В случае социально-экономических показателей это та-

кие поля являются абстрактными и показываются псевдоизолиниями. Несмотря

на то, что признак может не иметь истинно непрерывного распределения (как в

случае этого задания — посещаемость ресторанов), показ с помощью изолиний

бывает наглядным, дает лучшее представление о дифференциации территории,

чем просто значки.

В работе вам предлагается совместно использовать эти 2 метода.

ВНИМАНИЕ: для выполнения задания необходимо подключение к

сети Интернет.

9.2 Подключение к сервисам

В начало упражнения �

1. Добавьте на карту в качестве основы картографический сервис Esri Streets.

Его можно выбрать, используя команду Add Basemap на главной панели

инструментов:
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Глава 9. Привязка адресных данных 9.2. Подключение к сервисам

В появившемся диалоге выберите Streets:
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9.2. Подключение к сервисам Глава 9. Привязка адресных данных

Если подключение произошло корректно, появится картографическое

изображение.

2. Увеличьте масштаб карты таким образом, чтобы был хорошо виден Манх-

эттен:
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Глава 9. Привязка адресных данных 9.2. Подключение к сервисам

3. Подключитесь к ГИС-серверу официального портала штата Нью-Йорк. Для

этого в окне каталога выберите команду GIS Servers > Add ArcGIS Server

и в появившемся диалоге выберите Use GIS Services (использовать ГИС-

сервисы), нажмите Далее:
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9.3. Геокодирование адресов Глава 9. Привязка адресных данных

4. В следующем диалоге в параметр Server URL скопируйте и вставьте сле-

дующий адрес и нажмите Finish (имя пользователя и пароль вводить не

надо):

https://gisservices.its.ny.gov/arcgis/rest/services/

Если соединение прошло удачно, в списке ГИС-серверов появится новое

подключение к ГИС-серверу. Внутри него среди прочих сервисов должен

располагаться адресный локатор Street_and_Address_Composite:

5. Подключитесь в окне Каталога к вашей папке Ex09 и создайте в ней но-

вую базу геоданных под названием Ex09. Назначьте ее базой данных по

умолчанию.

9.3 Геокодирование адресов

В начало упражнения �

1. В окне Каталога раскройте таблицу NYMcDonalds.xlx и перетащите ее пер-

вый лист на карту:
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Глава 9. Привязка адресных данных 9.3. Геокодирование адресов

2. Откройте таблицу, чтобы просмотреть ее содержимое. В ней есть несколь-

ко полей, отвечающих за адрес, а также поле Visitors, хранящее информа-

цию о среднем числе посетителей, обслуживаемых за один час:

3. Выберите в контекстном меню таблицы опциюGeocode Addresses, чтобы

приступить к геокодированию:
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9.3. Геокодирование адресов Глава 9. Привязка адресных данных

В появившемся диалоге необходимо добавить сервис геокодирования, к

которому вы осуществили подключение ранее.

4. Нажмите Add… и, используя навигацию по папкам, перейдите в каталог

GIS Servers и найдите сервис геокодирования Street_and_Address_Composite.

Выделите его и нажмите Add:
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Глава 9. Привязка адресных данных 9.3. Геокодирование адресов

5. Далее выделите его и нажмите ОК:

6. В появившемся диалоге настроек геокодирования необходимо выбрать

поля атрибутивной таблицы, из которых будет браться адресная инфор-

мация. Заполните его следующим образом:
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9.3. Геокодирование адресов Глава 9. Привязка адресных данных

Параметр Значение

Street or Intersection Address

City or Placename City

State State

Output Shapefile or Feature Class …\Ex09\Ex09.gdb\NYMcDonalds

Выберите в поле Save as Type фильтр File and Personal Geodatabase Feature

Class

Остальные параметры оставьте по умолчанию и нажмите ОК. После вы-

полнения геокодирования появится диалог, сообщающий процент удачно

геокодированных адресов (Matched). Нажмите Rematch, чтобы приступить

к исправлению ошибок:

Появится диалог сопоставления адресов, а на карту будет добавлены

удачно геокодированные точки. Выберите в списке Show Results режим

Unmatched Addresses. Не закрывая диалог, увеличьте изображение

таким образом, чтобы точки было хорошо видно:
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Глава 9. Привязка адресных данных 9.3. Геокодирование адресов

Снимок экрана №1. Автоматически геокодированные точки на карте и

список негеокодированных точек

Возникшие проблемы сопоставления адресов почти во всех случаях обуслов-

лены тем, что для зданий на перекрестках указано сразу 2 адреса (427 10TH AVE

& 34TH). Такая форма адреса не соответствует требованиям геокодера. Исклю-

чение составляет адрес «139TH& ADAM CLAYTON POWELL», в котором не указан

номер дома ни по одной из улиц. Его вы обработаете отдельно.

1. Для разрешения неоднозначности выполните следующие действия:

• Выделите строку с идентификатором «10» в таблице. В поле Street

or Intersection в нижней левой части окна сотрите знак & и все что

после него. Строка «154 W 14TH ST & 7TH AVE» должна превратиться

в строку «154 W 14TH ST»:

• Нажмите Search. Среди полученных вариантов выберите имеющий

ранг Score равный 100 (полное совпадение). Если таких адресов
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9.3. Геокодирование адресов Глава 9. Привязка адресных данных

несколько, следует выбрать тот, что имеет заполненное поле House

(дом).

• Нажмите Match, чтобы сопоставить адрес. Результат должен выгля-

деть следующим образом:

2. Повторите эту последовательность действий для всех оставшихся строк.

3. Для кафе, располагающегося на перекрестке 139TH & ADAM CLAYTON

POWELL вам необходимо узнать точный адрес по одной из этих улиц.

Найдите этот адрес, используя поисковые возможности сети Интернет и

введите его полностью (включая номер дома и полное название улицы) в

поле Street or Intersection.

После выполнения правок все адреса должны быть сопоставлены и диалог

примет следующий вид:
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Снимок экрана №2. Результат ручного сопоставления адресов

4. Нажмите Close, чтобы завершить геокодирование.

5. Сохраните документ карты в свою папкуEx09под названиемEx09_Geocoding.mxd.

9.4 Визуализация посещаемости в точках

В начало упражнения �

1. Визуализируйте слой полученных точек методом значков. Выберите спо-

соб изображения Quantities — Graduated Symbols и задайте следующие

параметры:

Параметр Значение

Поле отображения Visitors

Классификация С равным интервалом через 100

Размеры кружков От 8 до 24
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Параметр Значение

Цвет кружков Голубой

Диалог настройки свойств слоя примет следующий вид:

2. Установите прозрачность значков на вкладке Display равной 50%.

3. Переименуйте слой в «Рестораны McDonalds», а значение подписи показа-

теля в заголовке легенды измените на «чел/час». Картографическое изоб-

ражение примет следующий вид:
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Глава 9. Привязка адресных данных 9.4. Визуализация посещаемости в …

4. Откройте панель инструментов Labeling и включите механизм Maplex,

чтобы получить доступ к расширенным настройкам подписей.

5. Включите подписи точек по полю Address. Установите размер шрифта рав-

ным 7.

Чтобы полученные надписи не загораживали значки, необходимо устано-

вить значкам высокий вес при размещении подписей.

6. Нажмите кнопку Label Weight Ranking на панели Labeling:
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7. В открывшемся диалоге установите значение веса точек равным 1000:

8. НажмитеОК. После выполнения этих действий подписи будут размещены

в стороне от значков:
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Снимок экрана №3. Градуированные значки с подписями

9. Сохраните документ карты

9.5 Построение поля посещаемости

В начало упражнения �

Наглядность представления пространственного распределения можно

повысить, построив по точкам непрерывное поле и отобразив его методом

послойной окраски. Восстановление поля по точечным данным делается

с помощью интерполяции. Методы интерполяции расположены в группе

инструментов Spatial Analyst Tools > Interpolation.

1. Запустите инструмент интерполяции данных Spatial Analyst Tools

> Interpolation > Natural Neighbor (метод естественного соседа) и

заполните его параметры следующим образом:

Параметр Значение

Input Point Features Рестораны McDonalds

Z Value Field Visitors

Output Raster …\Ex09\Ex09.gdb\Visitors

Output Cell Size 50

Метод естественного соседа осуществляет интерполяцию на основе диа-

граммы Вороного точек. Полученный растр будет добавлен на экран. Пе-

реименуйте его в «Посещаемость»:
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2. Дважды щелкните на растре, перейдите на вкладку Symbology и измените

параметры его отображения следующим образом:

Параметр Значение

Способ отображения Classified

Классификация С равным интервалом через 100

Шкала От желтого к темно-красному

219



9.5. Построение поля посещаемости Глава 9. Привязка адресных данных

Диалог настройки слоя примет следующий вид:

3. Перейдите на вкладку Display и установите параметр прозрачности

(Transparency) равным 20%, чтобы сделать послойную окраску по-

лупрозрачной. Нажмите ОК. Картографическое изображение примет

следующий вид:

220



Глава 9. Привязка адресных данных 9.6. Оформление карты

Снимок экрана №4. Поле распределения посещаемости

4. Сохраните документ карты

9.6 Оформление карты

В начало упражнения �

Переключитесь в режим компоновки и установите масштаб карты равным
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1:100 000. Оформите карту в соответствии с нижеприведенным образцов, экспор-

тируйте ее в графический файл и вставьте в отчет.
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9.7. Контрольные вопросы Глава 9. Привязка адресных данных

9.7 Контрольные вопросы

В начало упражнения �

1. Что такое геокодирование?

2. Можно ли получить доступ к базовым картам и инструментам геокодиро-

вания по сети, не имея их на своем компьютере? Если да, то что для этого

необходимо сделать?

3. В чем заключается процесс ручного сопоставления адресов и почему воз-

никает необходимость в этом?

4. Какой метод интерполяции вы использовали в работе для построения по-

ля распределения? В чем заключается принцип его работы? (для ответа

прочтите справку инструмента)
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Векторный анализ
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Глава 10

Анализ пространственных

взаимосвязей

Скачать данные и файл отчета

10.1 Введение

Цель— научиться определять пространственную приуроченность двух явлений

на основе процента взаимного покрытия их площадей (методом оверлея).

Параметр Значение

Теоретическая подготовка Оверлей пространственных объектов, геометрическое определение вероятности как отношения мер (площадей), соединение таблиц в реляционных базах данных, внешний и внутренний ключ соединения.

Практическая подготовка Знание основных компонент интерфейса ArcGIS Desktop (каталог, таблица содержания, карта). Работы с базой пространственных данных. Настройка символики и подписей объектов. Владение базовыми ГИС-технологиями: пространственные и атрибутивные запросы, оверлей.

Исходные данные База данных ГИС «Сатино».

Результат Таблица взаимного покрытия площадей типов рельефа и подтипов почв.

Ключевые слова Базовые технологии ГИС, оверлей, геометрическая вероятность.

10.1.1 Контрольный лист

• Добавить на карту слои типов почв и рельефа, оформить их
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• Произвести оверлей слоев

• Произвести слияние данных и соединение таблиц

• Подсчитать процент покрытия площадей

10.1.2 Аннотация

Задание посвящено знакомству с пространственным анализом на основе вектор-

ных данных. Векторная модель представляет объекты в виде отдельных геомет-

рических фигур с набором атрибутов. Она является объектно-ориентированной

и удобна для анализа формы, размеров объектов, их взаимной конфигурации в

пространстве. Одним из широко используемых методов анализа на основе век-

торных данных является оверлей.

При оверлее происходит наложение двух или более слоев, в результа-

те чего образуется их графическая композиция. Полученные участ-

ки наследуют атрибуты от каждого слоя. Эта операция базируется

на стандартных отношениях множеств, таких как пересечение, объ-

единение и симметрическая разность.

С помощью оверлея можно, например, установить, к каким генетическим

типам рельефа приурочены различные типы и подтипы почв. В общем случае

оверлей позволяет установить, какие комбинации объектов встречаются в про-

странстве. В задании предлагается исследовать методом оверлея взаимосвязь

типов рельефа и типов и подтипов почв.

10.2 Визуальный анализ векторных слоев

В начало упражнения �

В первую очередь при анализе данных следует провести их визуальную оцен-

ку, которая может натолкнуть на отыскание закономерностей во взаимном рас-

положении объектов.

1. Скопируйте папку Ex10 из серверной директории в свой рабочий каталог

с помощью Проводника.
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2. Откройте ArcMap и в нем — окно Catalog.

3. Найдите базу геоданных Satino.gdb в своем каталоге Ex10 и перенесите

на карту два тематических слоя: SoilTypes (Типы почв) и RelTypes

(Типы рельефа) из группы Thematic.

4. Поместите слой Типы рельефа вниз таблицы содержания, откройте его

свойства (двойным щелчком на названии) и перейдите на вкладку

Symbology.

5. Выберите тип отображения Categories и в нем — режимMatch to Symbols

In a Style, который позволяет настроить символы в соответствии с заранее

определенным стилем.

6. В качестве определяющего поля Value field выберите Тип рельефа. Далее

нажмите кнопку Browse и выберите стиль Satino.style, лежащий в вашем

каталоге Ex10. Нажмите кнопкуMatch symbols. Снимите флажок со строч-

ки All other values. Окно свойств слоя должно принять вид, аналогичный

представленному на рисунке. Нажмите ОК.

7. Настройте отображение слоя Типы почв в виде полигонов без заливки с яр-

ко красной обводкой толщиной 1.5 пиксела. Чтобы сделать полигон без за-

ливки, необходимо выбрать в меню Fill Color режим No Color. Нажмите

ОК:

8. Выберите инструмент идентификации и щелкните в пределах карты

на любом полигоне.

9. Переведите инструмент идентификации в многослойный режим. Для это-

го в окне Identify раскройте верхний список Identify From и выберите

пунктAll layers. Попробуйте идентифицировать полигоны в разных участ-

ках карты, обращая внимания на информацию, которая отображается в

окне идентификации.

Проанализируйте совмещенное изображение границ типов почв и

рельефа. Есть ли какие-то совпадения или подобия их рисунков в

пределах речных долин, междуречий, малых эрозионных форм?

Теперь, когда данные исследованы визуально и путем идентификации, мож-
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Рис. 10.1: Рис. 2. Настройка способа изображения в соответствии с предопреде-
ленным стилем
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Рис. 10.2: Рис. 3. Выбор режима отображения полигонов без заливки231
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Рис. 10.3: Рис. 4. Переключение инструмента идентификации в многослойный
режим 232
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но перейти к их анализу с помощью оверлея. Предварительно следует организо-

вать рабочее пространство, чтобы результаты анализа хранились в структуриро-

ванном виде и не смешивались с базовыми слоями.

10.3 Организация рабочего пространства

В начало упражнения �

Поскольку в процессе оверлея будет создан новый слой (а затем еще и

другие), возникает задача хранения вновь создаваемых данных. База геоданных

Satino содержит базовые слои, и производные результаты лучше помещать в

другое хранилище.

1. Сохраните документ карты в свой каталогEx10под именемEx10_Оверлей.mxd

2. Откройте окноCatalog и обратите внимание на то, в нем наверху появился

домашний каталог под именем Home - Фамилия/Ex10.. Раскройте его.

Домашний каталог — директория файловой системы, в которой

хранится документ карты, с которым вы работаете в данный

момент. Обычно в том же каталоге стараются хранить и сами

данные (если они не берутся из внешней СУБД), чтобы избе-

жать путаницы.

3. Щелкните правой кнопкой мыши по домашнему каталогу и выберитеNew

> File Geodatabase для того, чтобы создать новую базу геоданных.

4. Назовите ее Ex10.gdb

5. Щелкните по Ex10.gdb правой кнопкой мыши и выберите пункт Make

Default Geodatabase. Эта команда указывает программе, что все резуль-

таты обработки данных следует помещать в выбранную базу геоданных.

10.4 Оверлей слоев методом пересечения

В начало упражнения �

Оверлей осуществляется в ArcGIS с помощью инструментов геообработки.
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Геообработка (geoprocessing) в терминологии ArcGIS — это анализ и

преобразование пространственных данных. Доступ к инструментам

геообработки осуществляется через окно ArcToolbox, где они сгруп-

пированы по назначению. Некоторые наборы инструментов, такие

как Spatial Analyst и 3D Analyst, являются дополнительными модуля-

ми ArcGIS, предназначенными для решения специализированного

круга задач: растровый анализ, трехмерный анализ, сетевой анализ

и т.д.

1. Откройте ArcToolbox с помощью красной кнопки на панели инстру-

ментов.

2. Раскройте группу инструментов Analysis Tools > Overlay. Здесь можно

найти различные режимы оверлея.

Чем отличаются друг от друга режимы оверлея Intersect,

Symmetrical Difference и Union?*

3. Запустите инструмент Intersect, который ищет геометрическое пересече-

ние нескольких слоев. Изучите пояснительную иллюстрацию в правой ча-

сти окна.

4. Перенесите из таблицы содержания в список Input features слой Ти-

пы почв, затем слой Типы рельефа

Обратите внимание на то, что система автоматически определи-

ла адрес и название выходного класса объектов в следующем виде:

D:/GIS/207/CAR/Петров/Ex10/Ex10.gdb/SoilTypes/Intersect

5. Замените SoilTypes_Intersect на SoilsRelief_Intersect, чтобы из названия было

ясно, что с чем пересекается.

6. Параметр Join Attributes оставьте ALL. В этом режиме результат оверлея

унаследует все поля из обоих слоев.

7. Диалог инструмента Intersectпримет вид, аналогичный представленному

на рисунке. Запустите вычисления, нажав кнопку ОК.

8. Дождитесь, пока в таблицу содержания добавится слой SoilsRelief_Intersect

и переименуйте его в Комбинации почвы-рельеф. Для этого выделите слой
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Рис. 10.4: Рис. 5. Диалог инструмента Intersect
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в таблице содержания и нажмите F2 на клавиатуре, либо найдите пункт

Rename в контекстном меню.

9. Поместите полученный оверлеем слой между слоями типов почв и релье-

фа, и настройте его отображение в виде полигона без заливки с черной

обводкой толщиной 4 пиксела. Там, где границы совпадают с контурами

типов рельефа, они будут черного цвета, а там где они совпадают с конту-

рами типов почв, будет красная линия с черной обводкой.

10. Раскройте атрибутивную таблицу слоя Комбинации почвы-рельеф.

Какие поля содержатся в атрибутивной таблице полученного слоя?

Сравните его границы с границами двух исходных слоев.*

10.5 Слияние результатовпересечения с цельюпо-

лучения показателя пространственной связи

В начало упражнения �

Поскольку каждый полигон в оверлейном слое содержит значение ти-

па/подтипа почвы и типа рельефа, появляется возможность установить

приуроченность типов и подтипов почв к определенным типам рельефа.

Чтобы подсчитать долю каждого типа рельефа в площади каждого подти-

па почв, необходимо просуммировать площади каждой их уникальной комби-

нации. Например, дерново-карбонатные выщелоченные почвы (Д-в-к) на кру-

тых эрозионных склонах встречаются в пределах Сатинского полигона в виде

6 разрозненных участков, имеющих некоторую суммарную площадь. Эта пло-

щадь, деленная на суммарную площадь почв подтипа Д-в-к даст вероятностный

критерий приуроченности почв Д-в-к к крутым эрозионным склонам. То же са-

мое касается остальных комбинаций подтипов почв и типов рельефа.

С точки зрения рабочих процессов ГИС, операцию следует разбить на 5 ша-

гов:

• подсчет суммарной площади каждой комбинации подтипа почв и типа ре-

льефа;
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• подсчет суммарной площади каждого подтипа почв;

• добавление поля, в которое будет записана процентная доля;

• соединение таблиц комбинаций и подтипов почв по названию подтипа

почв;

• деление площади комбинации на площадь подтипа почв и запись резуль-

тата в соответствующее поле.

Объединение разрозненных объектов, обладающих одинаковым

набором атрибутов, осуществляется с помощью операции слияния

(Dissolve). Причем, если объекты примыкают друг к другу, граница

между ними будет стерта, а если объекты разнесены в простран-

стве, на выходе получится сложный составной объект (Multipart

feature), состоящий из нескольких полигонов. Слияние — это один

из методов генерализации.

10.6 Подсчет суммарной площади каждой комби-

нации подтипа почв и типа рельефа

В начало упражнения �

1. Откройте в ArcToolbox инструмент геообработкиData Management Tools

> Generalization > Dissolve. Изучите пояснительный рисунок в правой ча-

сти окна интерфейса.

2. Выберите в качестве значения параметра Input Features слой Комбинации

почвы-рельеф

3. В списке Dissolve Fields следует отметить поля SoilType, SoilSubtype и

RelType, тем самым можно будет найти все уникальные комбинации

подтипов почв и типов рельефа.

Поле SoilType необходимо отметить для того, чтобы в таблице ре-

зультирующего слоя сохранилась информация о типах почв. Это не

повлияет на сам результат, поскольку количество комбинаций типа

и подтипа почв равно количеству самих подтипов.
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4. Введите название выходного класса SoilsRelief_Intersect_Dissolve. Диалог ин-

струмента Dissolve примет вид, аналогичный представленному на рисун-

ке ниже.

5. Остальные параметры оставьте по умолчанию и нажмите ОК.

6. После того как результат появится в таблице содержания, назовите полу-

ченный слой Слияние комбинаций почвы-рельеф.

7. Отключите этот слой в таблице содержания.

10.7 Подсчет суммарной площади каждого подти-

па почв

В начало упражнения �

1. Запустите инструмент Dissolve еще раз.

2. Выберите в качестве Input Features слой Типы почв.

3. В списке Dissolve fields выберите поля SoilType и SoilSubtype.

4. Введите название выходного класса SoilTypes_Dissolve.

5. Остальные параметры оставьте по умолчанию и нажмите ОК.

6. Назовите полученный слой Слияние подтипов почв. В данном слое в ре-

зультате операции слияния каждый подтип почв будет представлен един-

ственным объектом, а в его поле Shape_Areaбудет записана суммарная пло-

щадь данного подтипа

7. Отключите этот слой в таблице содержания.

10.8 Добавление нового поля для результирующих

значений

В начало упражнения �

1. Откройте таблицу слоя Слияние комбинаций почвы-рельеф.
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Рис. 10.5: Рис. 6. Инструмент Dissolve, выполняющий слияние объектов по набо-
ру атрибутов
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2. Выберите в окне таблицы пункт меню Table Options > Add Field…

3. В диалоге введите название поля Percent.

4. Выберите тип поля Float (с плавающей точкой). Оставьте остальные пара-

метры по умолчанию и нажмите ОК.

10.9 Соединение таблиц по названию подтипа

почв

В начало упражнения �

Для расчета пространственной взаимосвязи необходимо поделить площадь

каждой комбинации на площадь соответствующего подтипа почв. Эти площади

находятся сейчас в разных таблицах — Слияние подтипов почв и Слияние комби-

наций почвы-рельеф. Их можно соединить по полю Подтип.

Соединение таблиц (table join) — операция, в результате которой к

одной таблице временно добавляются столбцы из другой таблицы.

Чтобы установить соответствие между строками исходной и присо-

единяемой таблицы, необходимо иметь в каждой таблице поле с об-

щими для них значениями. Например, это может быть числовой код

объекта или, как в нашем случае, подтип почв.

1. Перейдите в контекстное меню слоя Слияние комбинаций почвы-рельеф и

выполните команду Joins and Relates > Join. Внимательно изучите содер-

жимое появившегося диалога.

2. Выберите Подтип в качестве поля 1, по которому будет делаться соедине-

ние:

3. Выберите Слияние подтипов почв в качестве присоединяемой таблицы 2.

4. Выберите Подтип в качестве поля, по которому будет присоединяться таб-

лица Слияние подтипов почв.

5. Нажмите OK.

Что изменилось в атрибутивной таблице слоя Слияние комбинаций
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Рис. 10.6: Рис. 7. Диалог настройки соединения таблиц241



10.10. Вычисление результирующих … Глава 10. Анализ пространственных …

почвы-рельеф?

10.10 Вычисление результирующих значений

В начало упражнения �

1. Откройте таблицу слоя Слияние комбинаций почвы-рельеф.

2. Щелкните правой кнопкой мыши на заголовке поляPercent, вызовитеField

Calculator и введите туда указанное ниже выражение для подсчета про-

цента площади. Вы можете просто набрать 100 *, а затем дважды щелк-

нуть по названию каждого поля в списке, чтобы не вписывать их вручную:

100 * [SoilsRelief_Intersect_Dissolve.SHAPE_Area] /

[SoilTypes_Dissolve.SHAPE_Area]

Калькулятор поля (field calculator) используется для вычисления

значений атрибутов. Вы можете, например, умножить значе-

ние одного поля на 100 и записать в другое, соединить несколь-

ко текстовых полей в одно предложение или просто скопиро-

вать значение одного поля в другое.

3. Нажмите ОК. Посмотрите получившиеся значения в поле Percent.

4. Удалите соединение таблиц через контекстное меню слоя Слияние комби-

наций почвы-рельеф командой Joins and Relates > Remove Joins > Remove

All joins.

5. В атрибутивной таблице слоя Слияние комбинаций почвы-рельеф щелкни-

те на любом поле правой кнопкой мыши и выберите команду Advanced

Sorting.

6. Выберите в качестве первого поляПодтип и установите порядок сортиров-

ки Ascending (в сторону увеличения).

7. Выберите в качестве второго поля Percent и порядок сортировки

Descending (в сторону уменьшения).

8. Растяните таблицу таким образом, чтобы хорошо было видно поле типа

почв, поле подтипа почв, поле типа рельефа и поле Percent.
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9. Нажмите ОК.

10. Отключите оба слоя слияния в таблице содержания.

11. Сохраните документ карты.

Получившаяся таблица отображает для каждого подтипа почвы типы ре-

льефа в порядке уменьшения их доли в площади. Первая строка для каж-

дого подтипа почвы устанавливает наиболее вероятный тип рельефа.

Какие почвыпоказываютнаибольшую связь с определеннымтипом

рельефа?

12. Отсортируйте таблицу только по убыванию значений в поле Percent (нажав

дважды и еще раз дважды на нем) и выделите строки, в которых значение

процента в поле Percent более 75.

13. Скомпонуйте окно приложения так, чтобы было видно целиком карту, а

также выделенные в таблице строки, а также столбцы Тип, Подтип, Тип

рельефа и поле Percent. Окно примет вид, аналогичный представленному

на рисунке:

Снимок экрана №1 — Окно карты и результирующая таблица

14. Сохраните документ карты

10.11 Контрольные вопросы

В начало упражнения �

1. Как с помощью оверлея можно получить показатель связи между двумя

явлениями?

2. Если есть два полигона с совпадающими атрибутами, что произойдет с их

площадью после выполнения операции Dissolve?

3. В чем суть операции соединения таблиц? Что должно быть в двух таблицах

для их соединения?

4. Каким образом можно вычислить поле с использованием значения друго-

го поля? Опишите последовательность действий.
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Рис. 10.7: Рис. 8. Результаты оверлейного анализа
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Глава 11

Анализ пространственных

соотношений

Скачать данные и файл отчета

11.1 Введение

Цель задания — научиться определять соотношение типов подстилающей по-

верхности по регулярной сетке для метеорологических моделей и моделей фор-

мирования поверхностного стока средствами ГИС-технологий.

Параметр Значение

Теоретическая подготовка Оверлей пространственных объектов, соединение таблиц в реляционных базах данных, внешний и внутренний ключ соединения.

Практическая подготовка Знание основных компонент интерфейса ArcGIS Desktop (каталог, таблица содержания, карта). Работы с базой пространственных данных. Настройка символики и подписей объектов. Владение базовыми ГИС-технологиями: пространственные и атрибутивные запросы, оверлей.

Исходные данные Cлои картографической основы OpenStreetMap

Результат Слой регулярной сетки, для каждой ячейки которого определено соотношение типов подстилающей поверхности. Картодиаграммы типов подстилающей поверхности. Проект карты с компоновкой.

Ключевые слова Регулярная сетка, оверлей, соединение таблиц, картодиаграммы
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11.2. Оформление базовых слоев Глава 11. Анализ пространственных …

11.1.1 Контрольный лист

• Построить регулярную сетку с заданными параметрами.

• Определить долю каждого типа подстилающей поверхности в площади

ячеек.

• Присоединить получившиеся столбцы к слою регулярной сетки.

• Экспортировать результаты в текстовый файл.

• Визуализировать результат способом картодиаграмм.

• Оформить карту в режиме компоновки.

11.1.2 Аннотация

В задачах климатического и метеорологического моделирования, а также моде-

лирования поверхностного стока важную роль играет характер подстилающей

поверхности, а именно соотношение водопроницаемых и водоупорных поверх-

ностей, соотношение леса, воды, открытых грунтов, городских территорий и т.д.

Подготовка этих данных осуществляетсясредствами ГИС на основе картографи-

ческих данных и данных дистанционного зондирования.

В задании вам предлагается сформировать регулярную сетку и с помощью

оверлея определить соотношение типов поверхностей по каждой ячейке. Резуль-

таты далее экспортируются в текстовый файл для дальнейшего использования

при моделировании, а на основе полученных данных оформляется карта соот-

ношения типов поверхностей методом картодиаграмм.

11.2 Оформление базовых слоев

В начало упражнения �

1. Скопируйте каталог Ex11 в свою папку.

2. Подключитесь в окне каталога к вашей папке Ex11. Убедитесь, что в ней

находится база геоданных LandCover.gdb:

3. Добавьте на карту следующие слои и раскрасьте их в соответствии с цве-
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Глава 11. Анализ пространственных … 11.3. Построение регулярной сетки

тами:

Слой Цвет

Hydro Голубой

Green Зеленый

Industrial Оранжевый

Buildings Темно-серый

4. Сохраните документ карты в свою папку под названием LandCover.mxd.

Снимок экрана №1. Типы подстилающей поверхности

11.3 Построение регулярной сетки

В начало упражнения �

1. Создайте новую базу геоданных. Для этого в окне каталога щелкните пра-

вой кнопкой мыши по вашей папке <Фамилия>\Ex11и выберитеNew > File

Geodatabase.

2. Назовите базу геоданных Ex11.

3. Щелкните по Ex11.gdb правой кнопкой мыши и выберите пункт Make

Default Geodatabase. Эта команда указывает системе, что все результаты

автоматической обработки данных следует помещать в выбранную базу

геоданных.

4. Откройте ArcToolbox с помощью иконки на панели инструментов.

5. Запустите инструмент геообработки Data Management Tools > Sampling

> Create Fishnet и заполните его параметры следующим образом.

Параметр Значение

Output Feature Class /Ex11/Ex11.gdb/fishnet_1000

Template Extent Same as Layer Buildings

Cell Size Width 1000
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11.3. Построение регулярной сетки Глава 11. Анализ пространственных …

Параметр Значение

Cell Size Height 1000

Number of Rows 0

Number of Columns 0

Create Label Points Нет

Geometry Type POLYGON

Остальные параметры оставьте по умолчанию. Диалог инструмента при-

мет следующий вид:

6. Нажмите ОК. После выполнения расчетная сетка будет добавлена на

экран.

7. Разместите слой Fishnet поверх других слоев и смените его символ на чер-

ную линию толщиной 1 пункт.

8. Сохраните документ карты.
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Глава 11. Анализ пространственных … 11.4. Подсчет доли водных объектов в …

11.4 Подсчет доли водных объектов в площади

ячеек

В начало упражнения �

1. Запустите инструмент Analysis Tools > Statistics > Tabulate Intersection.

2. Заполните его параметры следующим образом:

Параметр Значение

Input Zone Features fishnet_1000

Zone Fields OID

Input Class Features Hydro

Output Table <Ваша папка>/Ex11/Ex11.gdb/fishnet_1000_Hydro

Остальные параметры оставьте по умолчанию. Диалог примет следующий

вид:

3. Нажмите ОК, после выполнения таблица результатов будет добавлена в

таблицу содержания.
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11.6. Добавление и инициализация … Глава 11. Анализ пространственных …

4. Откройте таблицу и посмотрите значения в поле PERCENTAGE — они отра-

жают долю объекта в площади ячейки.

11.5 Подсчет доли прочих типов поверхности в

площади ячеек

В начало упражнения �

Повторите операцию подсчета доли площади для оставшихся трех слоев, ис-

пользуя следующие параметры:

Входной слой Выходной слой

Green Fishnet_1000_Green

Industrial Fishnet_1000_Industrial

Buildings Fishnet_1000_Buildings

11.6 Добавление и инициализация атрибутивных

полей

В начало упражнения �

1. Откройте таблицу атрибутов слоя Fishnet.

2. Добавьте в нее поле, которое будет хранить значение доли водных объек-

тов. Для этого выберите в главном меню таблицы команду Add Field… и

заполните параметры появившегося диалога следующим образом:

Параметр Значение

Name Hydro

Type Float
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Глава 11. Анализ пространственных … 11.7. Присоединение таблицы с долей …

Остальные параметры оставьте по умолчанию.

3. Добавьте аналогичным образом поля Green, Industrial, Building, а также

Other, которое будет использоваться для хранения доли прочих поверхно-

стей.

4. Используя калькулятор поля, заполните каждое поле значением 0.

5. Сохраните документ карты.

11.7 Присоединение таблицы с долей водных объ-

ектов

В начало упражнения �

Соединение таблиц (join) — операция, в результате которой к од-

ной таблице добавляются столбцы из другой таблицы. При этом тре-

буется, чтобы строки добавленных столбцов присоединились к нуж-

ным строкам основной таблицы. Порядок строк и их число в обе-

их таблицах, как правило, не одинаковы. Чтобы установить соответ-

ствие между строками исходной и присоединяемой таблицы, необ-

ходимо иметь в каждой таблице поле с общими для них значениями.

Это поле именуется ключевым.

1. Откройте слой Fishnet на редактирование.

2. Присоедините таблицу Fishnet_1000_Hydro к слою Fishnet. Для этого открой-

те свойства слоя Fishnet, перейдите на вкладку Joins & Relates и нажмите

Add в группе Joins.

3. Укажите его параметры следующим образом:

Параметр Значение

OID Поле, содержащее уникальный идентификатор каждой записи

Fishnet_1000_Hydro Присоединяемая таблица

OID Поле в присоединяемой таблице, которое соответствует полю 1 в исходной
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Параметр Значение

Keep Only Matching Records Будут сохранены только те записи, для которых найдены совпадения поля OID

При указании свойств соединения отметьте флажком опцию Keep Only

Matching records. Диалог соединения таблиц примет следующий вид:
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Глава 11. Анализ пространственных … 11.7. Присоединение таблицы с долей …

4. Используя калькулятор поля, перенесите значения из присоединенного
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11.7. Присоединение таблицы с долей … Глава 11. Анализ пространственных …

столбца PERCENTAGE в столбецHydro слоя Fishnet. Для этого щелкните пра-

вой кнопкой мыши по заголовку столбца Hydro и выберите в контекстном

меню команду Field Calculator. В появившемся диалоге введите следую-

щий текст команды (см рисунок ниже):

[fishnet_1000_Hydro.PERCENTAGE]

Для подстановки названия поля в строку просто дважды щелкните на нем

в списке. Обратите внимание на точечную нотацию. Текст до точки — это

название таблицы. Текст после точки — название поля.

Диалог примет следующий вид:
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5. Нажмите ОК. Значения будут скопированы их одного столбца в другой.

6. Удалите соединение таблиц.
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11.8 Присоединение таблиц прочих типов поверх-

ностей

В начало упражнения �

Повторите операцию соединения для таблиц Fishnet_1000_Green, Fishnet_1000_Industrial

и Fishnet_1000_Buildings. После присоединения вычислите на их основе соответ-

ствующие поля в таблице Fishnet. Не забудьте перед каждым новым соединением

удалять предыдущее.

11.9 Вычисление доли прочих поверхностей

В начало упражнения �

С помощью калькулятора поля вычислите долю прочих поверхностей в поле

Other, используя следующее выражение:

100 - [Hydro] - [Green] - [Industrial] - [Buildings]

После вычисления завершите сеанс редактирования слоя.

11.10 Вычисление координат центров ячеек

В начало упражнения �

Для использования данных при моделировании важно знать координаты

центров ячеек.

1. Добавьте столбцы X и Y типа Long Integer в таблицу слоя Fishnet.

2. Вычислите их с помощью калькулятора геометрии. Для этого щелкните на

столбцеX правой кнопкой мыши и в контекстном меню выберите команду

Calculate Geometry.

3. В появившемся диалоге выберите режим X Coordinate of Centroid и на-

жмите ОК:
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4. Повторите операцию для столбца Y.

5. Сохраните документ карты.

После выполнения всех операций атрибутивная таблица слоя Fishnet долж-

на принять приблизительно следующий вид:

Снимок экрана №2. Атрибутивная таблица слоя расчетной сетки

257



11.11. Экспорт таблицы в файл Глава 11. Анализ пространственных …

11.11 Экспорт таблицы в файл

В начало упражнения �

Экспортируйте результирующую таблицу в текстовый файл для ее дальней-

шего использования. Для этого:

1. В главном меню таблицы выберите команду Export….

2. В поле Output Table нажмите кнопку указания места сохранения файла и

перейдите в ваш каталог Ex11.

3. Смените тип файла на текстовый и назовите его Results.txt:

4. Откройте получившийся файл через Проводник, чтобы просмотреть его

содержимое.

Снимок экрана №3. Файл данных расчетной сетки

11.12 Построение картодиаграмм

В начало упражнения �

Для визуализации соотношения типов поверхностей по ячейкам удобно ис-
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пользовать картодиаграммы.

1. Установите масштаб изображения 1:100 000.

2. Измените способ изображения слоя Fishnet на Pie Charts (картодиаграм-

мы).

3. Добавьте столбцы Hydro, Green, Industrial, Buildings и Other в поля картодиа-

граммы и раскрасьте их в соответствии с рисунком:

4. Нажмите кнопку Size и установите диаметр кружка равным 18 пунктам.

5. Символ Background сделайте без заливки и с черной обводкой. Нажмите

ОК.

6. Установите прозрачность для всех слоев 70%, чтобы подложка не мешала

восприятию картодиаграмм. Документ карты примет следующий вид:
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Снимок экрана №4. Картодиаграммы

11.13 Оформление компоновки карты

В начало упражнения �

Оформите карту на один из фрагментов территории, на котором встречают-

ся ячейки с разным типом поверхности. Для этого:

1. Переключитесь в режим компоновки.

2. Переименуйте слой Fishnet_1000 в Типы подстилающей поверхности.

3. Установите масштаб карты равным 1:100 000 и переместите изображение

на выбранный вами участок территории.

4. Добавьте легенду для слоя Типы подстилающей поверхности

5. Добавьте заголовок карты.

6. Добавьте масштаб.
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7. Экспортируйте карту в файл LandCover.png в свою директорию Ex11.

8. Вставьте карту в отчетный файл.

9. Сохраните документ карты.

11.14 Контрольные вопросы

В начало упражнения �

1. С помощью какого инструмента можно построить регулярную сетку? Как

изменить размер ячейки? Как изменить число ячеек?

2. С помощью какого инструмента можно подсчитать долю объектов одного

слоя в площади объектов другого слоя? Получившийся слой является про-

странственным или это обычная таблица?

3. Что такое соединение таблиц? Что должно присутствовать в каждой таб-

лице для выполнения соединения?

4. Как визуализировать слой способом картодиграмм? Опишите последова-

тельность действий.
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Глава 12

Анализ транспортных сетей

Скачать данные и файл отчета

12.1 Введение

Цель — научиться решать различные задачи логистики и оптимизации разме-

щения с помощью сетевого анализа.

Параметр Значение

Теоретическая подготовка Понятие о сетевой модели данных, граф дорожной сети, сетевой анализ и его основные задачи: кратчайший маршрут, зона обслуживания, ближайший пункт обслуживания, размещение-распределение, управление парком транспортных средств.

Практическая подготовка Знание основных компонент интерфейса ArcGIS Desktop (каталог, таблица содержания, карта). Инструмент геообработки. Настройка символики и подписей объектов. Выделение объектов на карте. Пространственные и атрибутивные запросы. Оверлей. Инструменты ArcToolbox.

Исходные данные Cлои картографической основы OpenStreetMap, граф дорожной сети на основе данных OpenStreetMap на территорию Москвы.

Результат Маршрут до магазина. Зоны обслуживания магазина от 1 до 5 минут. Маршруты до ближайших магазинов. Результат размещения магазинов. Зонирование территории по принадлежности к магазинам. Проект карты зонирования с компоновкой

Ключевые слова Сетевой анализ, граф дорожной сети, оптимизация размещения, логистика.

12.1.1 Контрольный лист

• Добавить на карту, слой улиц и слой зданий, граф дорожной сети

• Поставить точку магазина и точку потребителя, построить маршрут

• Поставить барьер на маршруте и перестроить маршрут с учетом барьера
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• Рассчитать зоны обслуживания магазина от 1 до 5 минут движения на ав-

томобиле

• Поставить еще одну точку магазина и 5 точек потребителя, рассчитать

маршруты до ближайшего магазина

• Добавить на карту точки потребителей, расставить 7 точек потенциальных

магазинов, выполнить анализ с выбором 4 мест из потенциальных

• Выполнить районирование территории по зонам обслуживания магази-

нов.

• Оформить карту с основными элементами компоновки (легенда, масштаб

и т.д.)

12.1.2 Аннотация

Задание посвящено знакомству с сетевым анализом. Задачи, предлагаемые в за-

дании, связаны с определением оптимальных маршрутов, построением зон об-

служивания, определением ближайших сервисных точек, размещением сервис-

ных точек. Данные задачи активно используются в логистике — оптимизации

перевозок, а также в геомаркетинге и оптимизации местоположения пунктов об-

служивания (магазинов, складов, пожарных депо и т.д.). В основе решения этих

задач лежит сетевая модель данных, являющаяся частным случаем векторной

модели. В сетевой модели дорожная сеть представляется в виде графа.

12.2 Оформление базовых слоев

В начало упражнения �

1. Подключитесь к базе геоданных Ex12.gdb в вашей папке Ex12.

2. Добавьте на карту слои Buildings (здания) и Streets (улицы).

3. Присвойте зданиям цвет серый (20%), уберите обводку (Outline Color > No

Color).

4. Установите масштаб равным 1:10 000 для удобной работы с картой.

5. Включите подписи зданий со следующими параметрами:
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Параметр Значение

Поле подписи A_HSNMBR

Цвет подписи Серый 80%

Размер подписи 6 пунктов

6. Присвойте дорогам серый цвет (60%) и включите их подписи со следую-

щими параметрами:

Параметр Значение

Поле подписи Name (tag value)

Цвет подписи Черный

Размер подписи 8 пунктов

Начертание Жирное

7. Добавьте на карту граф дорожной сети OSM, который находится в наборе

данных OSM_nd базы геоданных Ex12. В появившемся диалоге скажите No

(Нет), чтобы не добавлять на карту поворотные точки и прочие вспомога-

тельные элементы графа.

8. Задайте линиям графа такой же символ как и дорогам.

9. Сохраните документ карты в свою директорию Ex12 под названием

Ex12_Network.mxd.

Примерный результат должен выглядеть так:
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Снимок экрана №1 — Базовые слои: улицы, здания, граф дорожной сети

12.3 Построение маршрута

В начало упражнения �

1. Включите модуль Network Analyst с помощью команды главного меню

Customize—Extensions

2. Включите панель инструментов Network Analyst:

Если все правильно, в ниспадающем списке панели будет отображаться

граф дорожной сети OSM_nd

3. Создайте слой вычисления маршрутов с помощью команды Network

Analyst > New Route:
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4. Откройте окно Network Analyst Window:

Предположим, что по адресу ул. Профсоюзная, д.9 находится магазин. Вы

проживаете по адресу ул. Шверника, д. 19. Необходимо построить прямой и об-

ратный автомобильный маршрут.

1. Выделите в списке набор Stops, и, используя инструмент Create Network

Location, поставьте на графе дорожной сети 2 точки:
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• Рядом со зданием ул. Профсоюзная, д. 9

• Рядом со зданием ул. Шверника, д. 19

2. Нажмите Solve, чтобы построить прямой маршрут:

Снимок экрана №2. Прямой маршрут

3. Поменяйте точки местами в окне Network Analyst чтобы построить об-

ратный маршрут. Для этого перетащите нижнюю точку вверх списка. За-

пустите еще раз Solve:
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Снимок экрана №3. Обратный маршрут

Допустим, по адресу проспект 60-летия Октября, д.29к1 ведутся ремонтные

работы и движение перекрыто. Поставьте в этом месте барьер и перестройте

маршрут. Для этого:

1. Выделите в окне Network Analyst пункт Point Barriers > Restriction и

поставьте точку на граф рядом со зданием проспект 60-летия Октября,

д.29к1.

2. Перестройте маршрут:

Снимок экрана №4 Обратный маршрут с барьером

3. Сохраните документ карты.
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12.4 Определение зоны обслуживания

В начало упражнения �

Необходимо определить, какие здания попадают в зону доступности мага-

зина в пределах 1-5 минут движения на автомобиле.

1. Отключите в таблице содержания слой Route (снимите галочку).

2. Создайте слой вычисления зон обслуживания с помощью команды

Network Analyst > New Service Area.

3. Выделите в окне Network Analyst слой Facilities (пункты обслуживания) и

используя тот же инструмент Create Network Location, поставьте точку

по адресу ул. Профсоюзная, д. 2/22 (пересечение с ул. Дмитрия Ульянова).

4. Установите время езды до магазина равным 2 минуты. Для этого дважды

щелкните на слое Service Area в таблице содержания, перейдите на вкладку

Analysis Settings и поменяйте следующие настройки:

Параметр Значение

Default Breaks 2

Direction Towards Facility

Режим Towards Facility означает, что движение будет моделиро-

ваться от потребителя к точке обслуживания

5. Нажмите Solve на панели Network Analyst, чтобы построить зону обслу-
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живания:

Снимок экрана №5. Зона обслуживания 2 мин

6. Постройте иерархию зон обслуживания от 1 до 5 минут. Для этого поме-

няйте значение параметра Breaks в настройках слоя Service Area на 1 2 3 4

5 (через пробелы):

7. Перезапустите расчет зон обслуживания.

Примерный результат должен выглядеть следующим образом:
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Снимок экрана №6 Иерархия зон обслуживания от 1 до 5 мин

Получив зоны обслуживания, вы можете выделить с их помощью здания и

провести экономико-географический анализ. Для этого можно воспользоваться

пространственной выборкой.

1. Раскройте список Polygons в окне Network Analyst, чтобы увидеть леген-

ду слоя. Выберите зону Graphic Pick 1: 1 – 2, она соответствует интервалу

движения от 1 до 2 минут до магазина. Соответствующий полигон подсве-

тится на карте.

2. Откройте диалог пространственной выборки (Selection > Select By

Location). Задайте в качестве целевого слоя (Target) Buildings, а в качестве

слоя-источника (Source) — Polygons из группы Service Area. Отметьте

галочкой Use selected features, чтобы пространственный запрос осу-

ществлялся выбранной зоной. Диалог пространственной выборки примет

следующий вид:
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3. Нажмите ОК. На карте будут отобраны здания, попадающие в заданный

интервал транспортной доступности:
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Снимок экрана №7. Выборка зданий

Полученную выборку зданий вы можете далее использовать для проведе-

ния статистического и географического анализа.

4. Сохраните документ карты

12.5 Определение ближайшего пункта обслужива-

ния

В начало упражнения �

Предположим, что есть 2 магазина и 5 семей, которые живут в разных рай-

онах. Необходимо определить, какой магазин является ближайшим для каждой

семьи и построить маршрут.

1. Отключите слой Service Area в таблице содержания и снимите выборку со

всех объектов.

2. Создайте слой определения ближайшего пункта обслуживания с помощью
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команды Network Analyst > New Closest Facility.

3. Используя навыки предыдущего анализа, поставьте два пункта обслужи-

вания (Facilities) по адресам:

• Ул. Вавилова д. 48

• Ул. Новочеремушкинская, д. 23

4. Поставьте 5 пунктов потребления (Incidents) по адресам:

• Ул Шверника, д. 19

• Ленинский проспект, д. 44

• Нахимовский проспект, д. 67

• Проспект 60-летия Октября, д. 19

• Ул. Кржижановского, д. 16к1

5. Нажмите Solve, чтобы запустить расчет маршрутов.

Инструмент выберет ближайшие пункты обслуживания (магазины) для каж-

дого потребителя и построит маршруты:

Снимок экрана №8. Ближайшие пункты обслуживания
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12.6 Размещение—распределение

В начало упражнения �

Задача размещения—распределения (location-allocation) звучит следующим

образом: есть N потенциальных точек для размещения пунктов обслуживания

(магазины, кафе, пожарные станции, транспортные узлы, сервисные центры и

т.д.), а также K точек потребления (обычно это здания, из которых выезжают

люди за услугами, или к которым эти услуги поставляются). Необходимо из N

точек обслуживания выбрать n ≤ N точек таким образом, чтобы минимизиро-

вать некую стоимостную функцию (например, суммарное время движения от

каждого пункта потребления до ближайшего пункта обслуживания). После чего

распределить точки по ближайшим пунктам обслуживания. Данный тип анализа

позволяет также моделировать противостояние конкурирующих сетей обслужи-

вания и подбирать оптимальные места размещения пунктов для максимального

охвата рынка.

1. Отключите слой Closest Facility в таблице содержания

2. Создайте слой размещения—распределения с помощью командыNetwork

Analyst > New Location-Allocation.

3. Расставьте потенциальные пункты обслуживания (Facilities) по следую-

щим адресам:

• Ул. Большая Черемушкинская, д.11к3

• Ул. Дмитрия Ульянова, д. 42

• Ул. Профсоюзная, д. 19

• Ленинский проспект, д. 67

• Ленинский проспект, д. 44

• Проспект 60-летия Октября, д. 19к1

• Ул. Дмитрия Ульянова, 26к1

4. Добавьте на карту слой Points из базы геоданных Ex12. Это слой центрои-

дов зданий, необходимый для загрузки точек потребления.

5. Сделайте точки черного цвета диаметром 3 пункта

Изображение примет следующий вид:
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6. Загрузите точки в пункты потребления. Для этого щелкните правой кноп-

кой мыши на строке Demand Points окна Network Analyst и выберите ко-

манду Load Locations:
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7. В появившемся диалоге выберите в списке Load From слой Points и нажми-

те ОК. Потребуется некоторое время, чтобы точки привязались к графу до-

рожной сети. За процессом вы можете следить в строке состояния прило-

жения (внизу).
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8. Дважды щелкните на слое Location-Allocation в таблице содержания, чтобы

изменить настройки анализа. Перейдите на вкладку Advanced Settings:
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9. Попробуйте выбрать различные варианты решения задачи в списке

Problem Type и прочитайте их описание. Подумайте, где можно приме-

нить такой анализ.

10. Выберите режим Minimize Impedance (минимизировать суммарное время

движения от потребителей к ближайшим пунктам обслуживания).

11. Установите количество отбираемых кандидатов (Facilities to Choose) рав-

ное 4.
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12. Установите направление движения Demand to Facility (потребитель к услу-

гам) на вкладке Analysis Settings:

13. Нажмите ОК и запустите решение задачи на панели Network Analyst. Бу-

дут выбраны 4 наиболее оптимальных пункта обслуживания, а здания бу-

дут распределены между ними в виде веерной диаграммы. Программа вы-

даст предупреждение, что некоторые точки оказались непривязанными

— проигнорируйте его. Это связано с тем, что некоторые здания по кра-

ям области транспортно недоступны, поскольку к ним требуется подъезд

извне изучаемого района. Вы можете их видеть по отсутствию исходящих

линий.
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Снимок экрана №9. Результат размещения—распределения

14. Сохраните документ карты

12.7 Районирование города по зонам обслужива-

ния

В начало упражнения �

На основе полученного распределения можно произвести районирования

территории. Для этого вы построите диаграмму Вороного точек потребления и

объедините полигоны, отнесенные к одному пункту обслуживания.

1. Исключите нераспределенные точки. Для этого дважды щелкните

на слое Demand Points в таблице содержания, перейдите на вкладку

Definition Query, нажмите Query Builder и введите следующий запрос:

282



Глава 12. Анализ транспортных сетей 12.7. Районирование города по зонам …

”FacilityID” IS NOT NULL

2. Создайте в вашем каталоге Ex12 базу геоданных Regions.gdb и назначьте ее

базой данных по умолчанию:
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3. Откройте ArcToolbox.

4. Запустите инструмент геообработки Analysis Tools > Proximity > Create

Thiessen Polygons и заполните его параметры следующим образом:

Параметр Значение

Input Features Location-Allocation\Demand Points

Output Features …\Ex12\Regions.gdb\DemandPoints_Voronoy

Output Fields ALL

Запустите инструмент. Полученный слой будет добавлен на карту и будет

иметь следующую структуру:
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Диаграмма Вороного обладает следующим свойством: какую бы точ-

ку мы не взяли внутри каждого полигона, она будет ближе к центро-

иду этого полигона, чем к любому другому центроиду.

Объединив полигоны Вороного, точки которых отнесены к одному и тому

же пункту обслуживания, вы получите районирование территории по зонам об-

служивания. Для этого:

1. Запустите инструмент Data Management Tools > Generalization >

Dissolve и заполните его параметры следующим образом:

Параметр Значение

Input Features DemandPoints_Voronoy

Output Feature Class …\Ex12\Regions.gdb\Regions

Dissolve Field(s) FacilityID

Остальные параметры оставьте по умолчанию. Диалог инструмента при-

мет следующий вид:
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2. НажмитеОК. После обработки слой районирования будет добавлен на кар-

ту.

3. Отключите слои диаграммы Вороного, а также точек зданий.

4. Переместите слой Regions под слои зданий и дорог.

5. Измените оформление слоя Regions следующим образом:

• Способ изображения Categories > Unique Values

• Поле отображения Facility ID

• Цвета отображения спокойные, пастельные, одинаковые по насы-

щенности.

• Обводка полигонов отсутствует. Чтобы убрать обводку сразу у всех

плашек, щелкните на заголовке столбца Symbol, выберите пункт

Properties for All Symbols и установите параметр Outline Color в

положение No Color.

Примерный вид диалога свойств слоя Regions выглядит следующим обра-

зом:
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6. Нажмите ОК, чтобы завершить оформление

7. В группе Location-Allocation оставьте включенным только слой Facilities.

8. Выгрузите отобранные пункты в отдельный слой. Для этого в окне

Network Analyst выделите в списке Facilities пункты, помеченные звез-

дочками (зажав клавишу Ctrl). Далее в контекстном меню слоя Facilities

выберите команду Export Data.
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9. Сохраните выборку в базу геоданных Regions.gdb под названием Selected:
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10. На вопрос добавить ли созданный слой на карту, ответьте утвердительно.

Переименуйте слой в «Пункты обслуживания». Визуализируйте слой мето-

дом категорий (Categories — Unique Values) по полю Name. В качестве

символа используйте кружки диаметром 16 пунктов. Цвет кружков при-

ведите в соответствии с цветом зоны, но сделайте его более ярким и насы-

щенным.

11. Проделайте аналогичную операцию для не выбранных пунктов обслужи-

вания, выделив их в списке. Сохраните их в базу геоданных под названи-

ем Rejected. Полученный слой на карте назовите «Не выбранные пункты об-

служивания» Присвойте полученному слою единый символ в виде темно-

серого кружка диаметром 12 пунктов.

12. Включите подписи номеров районов по полю FacilityID (размер шрифта 18)

13. Отключите слой Location-Allocation целиком.

Ваш проект примет следующий вид:
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Снимок экрана №10. Районирование территории

12.8 Компоновка карты

В начало упражнения �

Оформите карту в режиме компоновки в соответствии с нижеприведенным

образцом. Экспортируйте результат в графический файл и вставьте его в отчет.

12.9 Контрольные вопросы

В начало упражнения �

1. Какой слой необходим для проведения сетевого анализа?

2. Какую задачу позволяет решить инструмент Route?

3. Какую задачу позволяет решить инструмент Service Area?
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4. Можно ли построить сразу несколько зон обслуживания? Как это сделать?

5. Какую задачу позволяет решить инструмент Closest Facility?

6. Какую задачу позволяет решить инструмент Location-Allocation?

7. Какая последовательность действий позволяет перейти от распределений

точек к площадному районированию территории?
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Глава 13

Анализ гидрографических сетей

Скачать данные и файл отчета

13.1 Введение

Цель задания — научиться моделировать речную сеть с помощью геометриче-

ских методов.

Параметр Значение

Теоретическая подготовка Сетевая модель данных, сетевой анализ, определение кратчайшего маршрута.

Практическая подготовка Знание основных компонент интерфейса ArcGIS Desktop (каталог, таблица содержания, карта). Работы с базой пространственных данных. Настройка символики и подписей объектов.

Исходные данные База данных ГИС “Сатино”.

Результат Набор данных геометрической сети в базе пространственных данных. Результаты сетевого анализа

Ключевые слова Геометрические сети, сетевой анализ

13.1.1 Контрольный лист

• Добавить на карту слои линейной и площадной гидрографии

• Оцифровать недостающие сегменты линейного слоя гидрографии

• Разрезать линейный слой гидрографии в узлах сочленения водотоков
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• Построить геометрическую сеть на основе полученного линейного слоя

• Выполнить упражнения по анализу построенной геометрической сети

13.1.2 Аннотация

Речные системы, транспортные и инженерные коммуникации — это приме-

ры пространственных сетей. Сети играют огромную роль в географическом

пространстве, их можно найти практически на любой карте, они учитывают-

ся в виде факторов во многих географических задачах. Основная функция

сетей — перенос вещества и данных. Отличительной особенностью сетей

является направленность линейных отрезков и их топологическая связность в

местах сочленения, таких как слияния рек, перекрестки дорог, разветвления

трубопроводов.

В этом задании вы приобретете навыки по созданию и редактированию ли-

нейных и точечных объектов, построите геометрическую сеть речной системы

на их основе и научитесь делать простой сетевой анализ — построение маршру-

тов, трассировка водотоков вверх по течению. Полученные навыки пригодятся

при изучении сетей других типов: инженерных и транспортных.

13.2 Создание набора данных речной сети

В начало упражнения �

1. Откройте ArcMap.

2. Сохраните карту через команду меню File > Save в вашей директории Ex13

под именем Ex13_Реки.mxd. Это необходимо для того, чтобы у вас появи-

лась домашняя директория в окне каталога.

3. Откройте окно Каталога. Найдите вверху домашнюю директорию

Home — это каталог Ex13, куда вы сохранили документ карты.

4. Добавьте на карту слои WaterPolygon и WaterLine из базы

Satino.gdb.
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Перед вами два представления речной сети: линейное и площадное.

Подумайте, в каких задачах необходимо одно представление, а в ка-

ких — другое?

Чтобы обеспечить связность гидрографической сети, следует преобразовать

площадное представление крупных водотоков в линейное. Для этого необходи-

мо вручную оцифровать осевую линию реки, притянуть устья притоков к этой

осевой линии, а затем разрезать осевую линию в узлах пересечения (в дальней-

шем это позволит при трассировке «сворачивать» с одного водотока на другой).

1. Щелкните правой кнопкой мыши по домашнему каталогу (Home) и выбе-

рите New > File Geodatabase для того, чтобы создать новую базу геодан-

ных.

2. Назовите ее Ex13.

3. Щелкните по Ex13.gdb правой кнопкой мыши и выберите пункт Make

Default Geodatabase. Эта команда указывает системе, что все результаты

обработки данных следует помещать в выбранную базу геоданных.

4. Добавьте в базу геоданных Ex13.gdb новый набор данных Hydro. Для это-

го щелкните правой кнопкой мыши на названии базы геоданных и в кон-

текстном меню выберите New > Feature Dataset (Рис. 1).

5. В появившемся окне введите название набора данных Hydro.

6. В следующем окне вам просят задать проекцию. Щелкните на кнопке

Add Coordinate System и в ниспадающем меню выберите команду Import.

Найдите слой Border базе геоданных Satino.gdb и дважды кликните на нем.

Параметры проекции автоматически подставятся из созданного ранее

слоя. Убедитесь, что проекция называется WGS_1984_UTM_Zone_37N.

7. Нажмите Далее и во всех оставшихся диалогах оставьте параметры по

умолчанию.

8. Создайте новый класс пространственных объектов Streams внутри набора

данных Hydro. Для этого щелкните правой кнопкой мыши по набору дан-

ных Hydro и в контекстном меню выберите пункт New—Feature Class.

9. В первом диалоге введите название класса Streams, его псевдоним (alias)
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Рис. 13.1: Рис. 1. Создание нового набора данных (Feature Dataset)
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Водотоки и из ниспадающего списка выберите тип класса Line Features

(Рис. 2). Нажмите Далее два раза, чтобы пропустить второй диалог.

В появившемся (третьем) диалоге (Рис. 3) вас просят определить состав

атрибутивных полей для слоя. Здесь можно сделать это вручную, однако

мы воспользуемся импортом.

10. Нажмите кнопку Import и найдите класс WaterLine в базе геоданных

Satino.gdb, дважды щелкните на нем. Названия и типы полей автоматиче-

ски подставятся в список (Рис. 3).

11. Нажмите Finish. Проверьте, чтобы в вашей таблице содержания было 3

слоя: Водотоки, Гидрография (линии) и Гидрография (полигоны).

13.3 Копирование и цифрование линий водотоков

В начало упражнения �

Для того чтобы собрать речную сеть, можно скопировать уже существующие

линейные водотоки в созданный вами слой, а затем оцифровать недостающие

водотоки (Протва и Исьма).

Цифрование— это процесс получения векторных объектов на осно-

ве изображения. При ручной оцифровке пользователь ГИС самосто-

ятельно рисует линии, обводит полигоны, расставляет точки поверх

растрового изображения, в котором эти объекты нарисованы. Суще-

ствуют также методы цифрования, которые решают эту задачу в по-

луавтоматическом режиме, когда система пытается самостоятельно

распознать и векторизовать объекты, а пользователь затем исправ-

ляет ошибки и недочеты в результатах цифрования. Типичный при-

мер — перевод отсканированной бумажной топографической карты

в набор векторных слоев базы пространственных данных.

1. Щелкните правой кнопкой мыши на слое Водотоки и выберите пункт ме-

ню Edit Features > Start Editing, чтобы начать редактирование.

2. Выделите все водотоки из слоя Гидрография (линии). Для этого щелкните
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Рис. 13.2: Рис. 2. Диалог создания линейного класса пространственных объектов
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Рис. 13.3: Рис. 3. Определение атрибутивных полей для класса Streams
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Рис. 13.4: Рис. 4. Панель Create Features

правой кнопкой мыши по слою Гидрография (линии) и в контекстном меню

выберите пункт Selection > Select All. Скопируйте выделенные водотоки

в буфер обмена через команду главного меню Edit > Copy.

3. Вставьте скопированные объекты в слой Водотоки. Для этого воспользуй-

тесь стандартной командой главного меню Edit > Paste и в появившемся

диалоге выберите в качестве целевого слой Водотоки.

4. Снимите выделение с водотоков, нажав кнопку Clear Selected

Features на панели инструментов Tools.

5. Удалите слой Гидрография (линии) из таблицы содержания. В этом задании

он больше вам не понадобится.

6. Переключитесь в окно Create Features c помощью кнопки на панели

Tools (Рис. 4) и выберите Водотоки в списке цифруемых объектов:

7. Приблизьтесь к верховьямПротвы в западной части карты. Для навигации

используйте колесико мыши (масштабирование) и кнопку C на клавиатуре

(перемещение). Рекомендуемый диапазон масштабов для цифрования —
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1:1 500–1:2000. Вы можете его отслеживать вверху окна.

8. Щелкните посередине полигона в месте начала реки и начните цифровать

линию примерно по осевой линии полигона с определенным интервалом.

Щелкните мышью в месте, где вы хотите поставить точку, затем переме-

стите курсор к месту следующей точки, щелкните еще раз, и так далее. Не

увлекайтесь и не расставляйте точки слишком часто. Оцифруйте осевую

линию Протвы целиком с запада на восток — это займет у вас некоторое

время.

9. Когда линия будет полностью оцифрована, щелкните дважды мышью в по-

следней точке, или нажмите F2.

Советы по цифрованию:

Если вам мешает плавающее окно дополнительных функ-

ций, нажмите клавишу TAB.

Если ваш курсор подошел к границе окна, зажмите клавишу

C на клавиатуре и переместите карту. Отпустите клавишу C и

продолжайте цифрование.

Если выпоставили точку не в томместе, где хотели, нажмите

Ctrl + Z, чтобы отменить действие.

Если вы случайно завершили цифрование раньше, чем тре-

буется, начните с последней точки. Ничего страшного, если у

вас получится 2-3, а не одна линия — их всегда можно объеди-

нить.

Если вы хотите сдвинуть вершину, выберите стрелку на па-

нели редактирования и дважды щелкните на линии — появят-

ся вершины. После того, как сдвинете нужные точки, щелкните

курсором на пустом месте карты.

Если курсор в узком месте назойливо притягивается к гра-

нице реки, попробуйте увеличить масштаб изображения.

10. Повторите операцию цифрования для реки Исьмы от ее верховья до устья.

Последнюю точку поставьте на осевой линии Протвы.
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Рис. 13.5: Рис. 5. Оцифровка осевой линии реки и окно Create Features

302



Глава 13. Анализ гидрографических … 13.4. Притягивание (снэппинг) …

11. Сохраните изменения, выбрав на панели Editor команду Editor > Save

Edits.

12. Снимите выделение с водотоков, нажав кнопку Clear Selected

Features на панели инструментов Tools.

13. Нажмите глобус Full extent, чтобы все объекты поместились на

экране.

13.4 Притягивание (снэппинг) притоков и разре-

зание осевой линии основных рек

В начало упражнения �

Вы помните, что ранее оцифрованные притоки Протвы и Исьмы были

пристыкованы к полигональной границе реки. Возникает вопрос: сохранил-

ся ли этот характер соседства после того, как вы заменили полигональное

представление рек на линейное?

1. Найдите устье реки Межиловки при впадении в Протву (западная часть по-

лигона) и увеличьтесь так, чтобы было хорошо видно место впадения.

Какая топологическая ошибка может быть замечена в месте

впадения ручья в Протву?

2. Возьмите стрелку на панели Editor и дважды щелкните на линии ру-

чья. Должны появиться вершины. Потяните за последнюю вершину и при-

стыкуйте ее к линии реки (Рис. 6). Щелкните на пустом месте, чтобы за-

вершить редактирование.
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3. Повторите операцию для всех остальных ручьев. Перемещайтесь по карте,

используя клавишу C. Не забудьте также про Исьму. Сохраните изменения,

выбрав команду Editor > Save Edits

Помимо сохранения связности для геометрической сети очень важно, что-

бы линии были разрезаны на сегменты между пересечениями. Это необ-

ходимо для того чтобы отличать реальные узлы от перекрытий (сравните

обычный перекресток и эстакаду!).

4. Выделите на карте Протву и приблизьтесь к месту впадения в нее реки

Межиловки.

5. Найдите на панели Editor инструмент разрезания линии и щелкните

мышью в месте впадения ручья в Протву. Линия Протвы разобьется этой

точкой на 2 части.

6. Повторите процедуру с выделением Протвы и разрезанием для всех

остальных притоков.

7. Разрежьте аналогичным образом остальные водотоки.

8. Сохраните изменения, выбрав команду Editor > Save Edits. Завершите ре-
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дактирование, выбрав команду Editor > Stop Editing.

9. Сохраните документ карты.

13.5 Установка точки стока

В начало упражнения �

Подготовленных вами данных уже достаточно для того, чтобы построить

геометрическую сеть. Однако в общем случае сеть является двунаправленной

(например, транспортная), а наша сеть имеет вполне определенное направление

— вниз по течению. Чтобы задать это направление, необходимо создать новый

точечный слой и поставить в нем одну точку, расположенную ниже всего по те-

чению.

1. Перейдите в окно Каталога, щелкните правой кнопкой мыши по набору

данных Hydro и выберите пункт New > Feature Class.

2. Задайте классу имя Sink и точечный тип Point Features. Остальные парамет-

ры оставьте по умолчанию.

3. Смените символ слоя Sink на кружок голубого цвета диаметром 10 пиксе-

лов.

4. Включите режим редактирования с помощью команды Edit Features >

Start Editing, в окне Create Features выберите Sink и поставьте точку на

восточной оконечности реки Протвы (правый край карты).

5. Сохраните изменения и завершите режим редактирования.

6. Добавьте на карту слой горизонталей ContoursBasic из базы данных

Satino.gdb и смените цвет линий на бледно-серый. Переместите его вниз

в качестве основы.

7. Отключите слой Гидрография (полигоны) и нажмите кнопку Full

extent, чтобы вся территория полигона поместилась на экране.

Снимок экрана№1. Линейный слой водотоков, горизонтали и точка стока
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Рис. 13.6: Рис. 7. Линейный слой водотоков, горизонтали и точка стока
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13.6 Построение и настройка геометрической сети

В начало упражнения �

Ваши данные полностью готовы к тому, чтобы построить на их основе гео-

метрическую сеть.

1. Перейдите в окно Каталога, щелкните правой кнопкой мыши по набору

данных Hydro и выберите пункт New > Geometric Network.

2. Оставьте Hydro_Net в качестве имени по умолчанию и установите рассто-

яние принудительного снэппинга линий равным 1 м (Рис. 8). Эта опция

будет полезна, если вы где-то не дотянули устье притока до реки. Оно до-

тянется автоматически. Нажмите Далее.

3. В следующем окне нажмите Select All, чтобы выбрать слои, участвующие

в построении сети (Рис. 9). Нажмите Далее.

4. Перед вами окажется диалог настройки ролей. Junction — это узел, Edge —

это ребро. Для слоя Sink установите значение параметра Sources & Sinks

равным Yes. Система будет знать, что этот слой содержит точки, являющи-

еся истоками либо стоками (Рис. 10). Нажмите Далее.

5. Во всех остальных диалогах оставьте параметры по умолчанию. Нажмите

Finish в последнем диалоге, чтобы завершить создание сети.

6. После того как будет построена геометрическая сеть, в таблицу содержа-

ния добавятся 3 новых слоя: Водотоки (ребра сети), Hydro_Net_Junctions (со-

членения в сети) и Sink (точка стока). Удалите новые слои Водотоки и Sink,

поскольку они дублируют старые

7. Включите режим редактирования и откройте таблицу атрибутов слоя Sink.

8. Установите для единственной точки в этом слое поле AncillaryRole равным

2 (Sink). Если список не отображается, просто введите в ячейку 2. Обратите

внимание на то, что есть и противоположный вариант — Source (исток).

9. Сохраните изменения, выбрав пункт меню Editor > Save Edits.

10. Щелкните правой кнопкой мыши на пустом поле вверху окна и откройте

панель инструментов Utility Network Analyst, предназначенную для ра-

боты с геометрической сетью (Рис. 12).
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Рис. 13.7: Рис. 8. Имя геометрической сети и параметры снэппинга
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Рис. 13.8: Рис. 9. Выбор слоев, участвующих в построении сети
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Рис. 13.9: Рис. 10. Установка ролей слоев в геометрической сети
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Рис. 13.10: Рис. 11. Установка роли точки стока

Рис. 13.11: Рис. 12. Панель инструментов Utility Network Analyst для работы с гео-
метрическими сетями
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Рис. 13.12: Рис. 13. Неопределенное направление течения в геометрической сети

11. Выберите в меню пункт Flow > Display Arrows для того чтобы система

автоматически показала направление течения. Вдоль отрезков будут по-

казаны кружки, означающие, что направление еще не задано (Рис. 13).

12. Нажмите кнопку Set Flow Direction. Кружки должны смениться стре-

лочками, указывающими направление течения. Просмотрите разные ча-

сти карты и убедитесь в том, что направление течения задано одинаково

верно для всех водотоков (Рис. 14).

Снимок экрана№2. Геометрическая сеть с определенным направлением

течения

13. Завершите сеанс редактирования, выбрав на панели Editor пункт меню

Editing > Stop Editing. В появившемся диалоге нажмите Да.

Вы закончили подготовку и настройку геометрической сети. Теперь она до-

ступна для анализа и редактирования.
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Рис. 13.13: Рис. 14. Определенное направление течения в геометрической сети

13.7 Анализ и редактирование геометрической се-

ти

В начало упражнения �

Самое интересное в сетевых моделях — это возможность их анализа. Напри-

мер, если зафиксирована точка прорыва на трубопроводе, можно определить все

расположенные далее сегменты и ответвления сети, которые пострадают в ре-

зультате аварии. Для замыкающего створа на реке можно определить все прито-

ки, расположенные выше по течению или быстро трассировать путь воды вниз

по течению вплоть до устья основной реки бассейна. При анализе транспортных

сетей часто решается задача прокладки кратчайшего маршрута, расчета зон до-

ступности и управления парком транспортных средств.

При анализе геометрических сетей в ArcGIS используются флаги и

барьеры. Флаг — это точка, относительно которой осуществляется

трассировка сети. Барьер— это точка, запрещающая проход по реб-
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Рис. 13.14: Рис. 15. Меню флагов и барьеров

ру графа или его вершине.

1. Откройте меню флагов и барьеров на панели инструментов Utility

Network Analyst и выберите флаг для вершины (первая иконка на Рис.

15).

2. Поставьте флажок в месте впадения реки Межиловки в Протву.

3. В списке Trace Task выберите задачу Trace Upstream (трассировать вверх

по течению) и нажмите кнопку Solve.

Инструмент анализа выделит водотоки, расположенные выше по течению

относительно заданной точки. Весь их сток в конечном счете попадает в

данную точку (Рис. 16).

Снимок экрана №3. Водотоки выше по течению относительно заданной

точки

4. Смените задачу на Trace Downstream и опять нажмите кнопку Solve.

Инструмент анализа построит маршрут вниз по течению

5. Поставьте еще один флажок в верховьях ручья Язвицы и запустите анализ

в режиме Find Path. Будет построен маршрут между двумя точками (Рис.

17).

Снимок экрана №4. Маршрут между двумя точками

6. Поставьте точечный барьер (вторая справа иконка на Рис. 15) в месте впа-

дения Исьмы в Протву и попробуйте еще раз рассчитать маршрут.

Что произошло с расчетом маршрута после того, как вы поста-

вили барьер?

7. Очистите флаги и барьеры, выбрав Analysis > Clear Flags и Analysis >

Clear Barriers.
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Рис. 13.15: Рис. 16. Трассировка водотоков, расположенных выше по течению
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Рис. 13.16: Рис. 17. Маршрут между двумя точками

316



Глава 13. Анализ гидрографических … 13.8. Контрольные вопросы

8. Попробуйте поэкспериментировать с разными режимами расчетов в ме-

ню Trace Task и расстановкой флагов и барьеров.

Геометрическая сеть отличается также тем, что это топологический фор-

мат хранения данных — она хранит связность ребер и вершин, что бывает

удобно при редактировании и совершенно необходимо при анализе.

9. Включите режим редактирования снова и приблизьтесь к месту впадения

любого ручья в Протву.

10. Выделите узел сочленения и переместите его в сторону.

Что происходит при перемещении узла сети? Остаются ли реб-

ра на своих местах?**

Сохраните документ карты еще раз.

13.8 Контрольные вопросы

В начало упражнения �

1. Каким требованиям должны отвечать гидрографические данные, чтобы

их можно было представить в виде геометрической сети?

2. Какие функции выполняют флаги и барьеры при решении задач сетевого

анализа?

3. Какие задачи можно решать с помощью анализа геометрических сетей?

4. Какие преимущества при редактировании данных дает топологическая

структура данных?
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Растровый анализ
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Глава 14

Оптимизация местоположения

Скачать данные и файл отчета

14.1 Введение

Цель — овладеть основами растрового анализа в ГИС на примере решения зада-

чи поиска оптимального местоположения для размещения объектов.

Параметр Значение

Теоретическая подготовка Растровая модель пространственных данных, вычисление евклидова расстояния на плоскости, методы классификации числовых рядов, оверлей с весовыми коэффициентами (взвешенный оверлей).

Практическая подготовка Знание основных компонент интерфейса ArcGIS Desktop (каталог, таблица содержания, карта). Инструменты геообработки. Работы с базой пространственных данных. Настройка символики и подписей объектов. Базовые технологии ГИС (пространственные и атрибутивные запросы, оверлей).

Исходные данные База данных ГИС «Сатино».

Результат Слой базы пространственных данных, содержащий участок с наиболее оптимальной суммой критериев

Ключевые слова Классификация числовых рядов, растровая модель данных, взвешенный оверлей, евклидово расстояние.

14.1.1 Контрольный лист

• Конвертировать слой землепользования в растровое представление

• Построить и классифицировать растр углов наклона рельефа

• Построить и классифицировать растры расстояний до водотоков и домов
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• Осуществить взвешенный оверлей полученных растров

• Конвертировать класс с максимальной суммой баллов в векторное пред-

ставление и выбрать участок, удовлетворяющий критерию минимальной

площади.

14.1.2 Аннотация

В первых заданиях вы познакомились с редактированием векторных данных.

Для ряда практических задач более удобным оказывается растровое представ-

ление. Оно хорошо подходит для анализа географического пространства, кото-

рое обладает постоянно меняющимися характеристиками среды. Растровая мо-

дель топологически неразрывна, что позволяет моделировать различные поля и

перенос вещества в пространстве из одной ячейки в другую. В силу своей регу-

лярности растровая модель проста в обработке, поскольку все операции можно

унифицировать, ориентируясь на матрицу ячеек. В частности, к растровым сло-

ям удобно применять операции алгебры карт, такие как сложение, вычитание,

суммирование — что и используется данном задании.

Вам предстоит решить задачу выбора оптимального местоположения участ-

ка для строительства производственного объекта. Критерии выбора следующие:

• оптимальные зоны для размещения — открытые пространства, такие как

выгоны, пустыри, луга, вырубки и т.д;

• предельный угол наклона рельефа — 12,5°;

• участок должен располагаться в непосредственной близости от автомо-

бильных дорог;

• участок должен располагаться в непосредственной близости от крупных

водотоков, поскольку требуется водоснабжение;

• необходимая площадь участка — не менее 30 000 м2.

Таким образом, в анализе участвует 5 факторов: тип землепользования,

углы наклона рельефа, расстояние до автодорог, расстояние до водотоков, пло-

щадь участка. Поскольку расстояния и углы наклона меняются в пространстве

непрерывно, для их анализа удобно использовать растровое представле-
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ние. К нему же необходимо привести типы землепользования, применив

векторно-растровое преобразование. Каждый из полученных слоев далее

следует классифицировать по балльной шкале от 1 до 10 и затем получить

взвешенную сумму баллов по всей территории. Оптимальное местоположение

будет соответствовать участкам с максимальной суммой баллов. Среди них

необходимо удовлетворяющие критерию минимальной площади.

Для выполнения анализа и преобразований данных вы будете использовать

инструменты геообработки.

Геообработка (geoprocessing) в терминологии ArcGIS — это анализ

и преобразование пространственных данных. Инструменты геооб-

работки находятся в ArcToolbox, где они сгруппированы по функци-

ональному назначению.

14.2 Подготовка рабочего пространства

В начало упражнения �

1. Скопируйте папку Ex14 из каталога упражнений на сервере в свой локаль-

ный рабочий каталог на диске D с помощью Проводника. Раскройте ее

после копирования на своем компьютере.

2. Откройте документ под названием Ex14_Selection.mxd.

3. Создайте новую базу геоданных. Для этого откройте окноArcCatalog, пра-

вой кнопкой мыши щелкните вверху по вашей папке Ex14 и выберитеNew

> File Geodatabase.

4. Назовите ее Ex14.gdb.

5. Щелкните по Ex14.gdb правой кнопкой мыши и выберите пункт Make

Default Geodatabase. Эта команда указывает приложению, что все резуль-

таты автоматической обработки данных следует помещать в выбранную

базу геоданных.
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14.3 Преобразование слоя типов землепользова-

ния в растровое представление

В начало упражнения �

Поскольку в анализе будут участвовать растровые слои с различными рассто-

яниями и углами наклонов, необходимо и данные по землепользованию приве-

сти к растровому виду.

1. Найдите в базе геоданных Satino.gdb слой LandUse в группе Thematic и пе-

ренесите его в таблицу содержания карты.

2. Визуализируйте слой Землепользование способом категорий, используя по-

ле Тип участка (Land_Type). Выбирать цвета не требуется, т.к. далее вы бу-

дете использовать растровый слой.

3. Диалоговое окно примет вид, аналогичный представленному на рисунке.

4. Нажмите ОК, чтобы завершить настройку способа изображения.

5. Откройте ArcToolbox с помощью кнопки на панели инструментов.

6. Запустите инструмент Conversion Tools > To Raster > Polygon to Raster.

7. Заполните его параметры следующим образом:

Параметр Значение

Input Features Землепользование

Value Field Land_Type

Output Raster Dataset <Фамилия>\Ex14\Ex14.gdb\LandUse_R

Cellsize 2,5

В поле Output point features вам потребуется заменить только название

класса объектов (LandUse_R).

Диалог примет следующий вид:
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Рис. 14.1: Рис. 1. Настройка способа изображения для типов землепользования
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После завершения работы инструмента конвертации в таблицу содержа-

ния добавится новый слой.

8. Выделите его, нажмите F2 и переименуйте в Землепользование (растр).

9. Дважды щелкните по созданному слою и перейдите на вкладку

Symbology.

10. Смените поле отображенияValue field на Land_type. В легенду автоматиче-

ски подставятся все найденные значения. Присвойте классам подходящие

цвета в соответствии с их типом.

11. Удалите векторный слой Землепользование из таблицы содержания. Далее

в этом упражнении он не понадобится.

12. Нажмите ОК. Переместите растровый слой наверх и нажмите кноп-

ку . Окно карты примет вид, аналогичный представленному на

рисунке:

Снимок экрана №1. Растровый слой типов землепользования

Увеличьте масштаб до величины порядка 1:2 000. Изучите отличия

векторного и растрового слоя, поочередно отключая и включая век-

торный слой. Чем они отличаются?

14.4 Расчет углов наклона

В начало упражнения �
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Рис. 14.2: Рис. 3. Визуализация типов землепользования в растровом виде
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Рис. 14.3: Рис. 6. Инструмент Slope для вычисления углов наклона

1. Найдите слой DEM в базе геоданных Satino.gdb и перенесите его в табли-

цу содержания карты. Поместите его вниз таблицы содержания под слой

Землепользование (растр).

2. Запустите инструмент вычисления углов наклона Spatial Analyst Tools >

Surface > Slope и заполните его параметры следующим образом:

Параметр Значение

Input Raster DEM

Output Raster <Фамилия>\Ex14\Ex14.gdb\Slope

Остальные параметры в диалоге оставьте по умолчанию. Его окно примет

вид, аналогичный представленному на рисунке:

3. Нажмите ОК, чтобы запустить расчеты.

4. После того как слой углов наклона Slope добавится в таблицу содержания,

переименуйте его в Углы наклона.

Обратите внимание на то, что значения углов были классифицированы на

несколько интервалов, которым был присвоен цвет:
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Эта классификация является динамической (то есть, применяется при визу-

ализации слоя и никак не отражается на его хранении) и при желании ее можно

поменять ее на вкладке Symbology в свойствах слоя.

14.5 Расчет расстояний

В начало упражнения �

14.5.1 Дороги

Чтобы определить участки, наиболее подходящие с точки зрения транспортной

доступности, можно построить растр, в каждой ячейке которого будет содержит-

ся расстояние (евклидово) до ближайшей дороги.

1. Добавьте на карту слой дорог General/Roads из базы геоданных Satino.

2. Откройте пункт меню Selection > Select by attributes, выберите для

выборки слой Дороги и тропы и в конструктор запроса введите следующее

выражение: ”Description” = 'Асфальтированные' OR ”Description”
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Рис. 14.4: Рис. 4. Выборка автомобильных дорог в диалоге атрибутивного запроса

= 'Проселочные'

Выборка позволит учитывать для при анализе только дороги (в слое также

содержатся тропы). Окно запроса примет вид, аналогичный представлен-

ному на рисунке. Нажмите ОК:

3. Постройте растр расстояний для выбранных дорог. Для этого запустите

инструмент Spatial Analyst Tools > Distance > Euclidian Distance.

4. Выберите в качестве параметра Input Raster or Feature слойRoads. Осталь-

ные параметры оставьте по умолчанию. Диалог примет следующий вид:

330



Глава 14. Оптимизация … 14.5. Расчет расстояний

5. Нажмите ОК. Получившийся растр будет добавлен на карту. Переименуй-

те его в Расстояния до дорог.

6. Очистите выборку в слое дорог, нажав кнопку Clear Selected

Features на панели инструментов Tools. Окно приложения примет следу-

ющий вид (обратите внимание на то, что расстояния были вычислены не

для всех дорог, а только для выбранных):
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14.5.2 Водотоки

Выполните расчет расстояний до водотоков самостоятельно, руководствуясь

краткой схемой:

1. Добавить на карту слой General/WaterPolygon (Гидрография (Полигоны))

2. Выбрать вручную крупные реки (Протва, Исьма) с помощью инструмента

Select Features By Rectangle на панели инструментовTools. Чтобы

выбрать последовательно несколько объектов, вы можете зажать клавишу

Shift:

3. Запустить инструмент Euclidian Distance для слоя Гидрография (полигоны).

Все параметры оставить по умолчанию.

4. Получившийся после расчетов слой переименовать в Расстояния до водо-

токов. Если все выполнено правильно, то результат должен быть пример-

но следующим:
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14.6 Классификация углов наклона

В начало упражнения �

Поскольку в анализе будет участвовать несколько факторов, необходимо

привести их значения к общей балльной шкале от 1 до 10. Для этого используется

классификация растра.

1. Запустите инструмент классификации Spatial Analyst Tools > Reclass >

Reclassify.

2. Выберите в качестве Input raster слой Углы наклона.

3. Нажмите кнопку Classify…, чтобы настроить классы.

4. Раскройте список методов классификации вверху диалогового окна.

Какие методы классификации доступны в инструменте Reclass?

Какие принципы в них заложены? Попробуйте выбрать разные

методы классификации и посмотрите, как меняются границы

классов.
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Рис. 14.5: Рис. 5. Классификация значений углов наклона методом естественных
интервалов

5. Выберите режим естественных интервалов Natural Breaks (Jenks) и устано-

вите количество интервалов равным 10. Окно диалога примет вид, анало-

гичный представленному на рисунке.

Метод естественных интервалов минимизирует дисперсию

внутри каждого класса и максимизирует отличия между

классами.

6. Нажмите ОК, чтобы завершить настройку метода классификации.

7. Нажмите кнопкуReverse new values, чтобы инвертировать значения клас-

сов (меньшие углы наклона должны иметь больший вес).
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Рис. 14.6: Рис. 6. Инструмент Reclassify

8. Остальные параметры оставьте по умолчанию. Окно диалога примет вид,

аналогичный представленному на рисунке:

9. Нажмите ОК, чтобы запустить выполнение инструмента.

10. После того как в таблицу содержания будет добавлен слой классифициро-

ванных углов наклона, переименуйте его в Углы наклона (классы).

11. Через свойства слоя на вкладке Symbology присвойте классам шкалу от

зеленого к красному, так чтобы класс 1 был красным, а класс 10 был зе-

леным. Если у вас получилось наоборот, нажмите мышкой на заголовке

столбца Symbol и выберите в меню Flip Colors (сменить порядок цветов

на противоположный):

12. Нажмите ОК в диалоге свойств слоя, чтобы закрыть его. Изображение

должно принять следующий вид:
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Рис. 14.7: Рис. 9. Функция Flip Colors

Снимок экрана №2. Классифицированные углы наклона

13. Сохраните документ карты.

14.7 Классификация расстояний

В начало упражнения �
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Рис. 14.8: Рис. 11. Классификация расстояний до дорог методом геометрических
интервалов

14.7.1 Дороги

1. Запустите инструмент Reclassify. Выберите в качестве Input raster слой

Расстояния до дорог.

2. Нажмите кнопку Classify…, чтобы настроить классы.

3. Настройте метод классификации на Geometric Intervals, и установите чис-

ло интервалов равным 10. Метод геометрических интервалов позволяет

сконцентрировать зоны с высокими баллами на небольшом расстоянии от

дорог. Диалог настройки классификации примет вид, аналогичный пред-

ставленному на рисунке. Нажмите ОК:
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Рис. 14.9: Рис. 12. Инструмент Reclassify для классификации расстояний до дорог

4. Нажмите кнопку Reverse New Values, чтобы инвертировать номера клас-

сов и максимальный балл получили классы с малыми расстояниями.

5. Переименуйте выходной класс в Reclass_Euc_Roads. Остальные параметры

оставьте по умолчанию. Диалог инструмента примет вид, аналогичный

представленному на рисунке:

6. Запустите вычисления, нажав кнопку ОК.

7. После того, как классифицированный растр расстояний до дорог появится

на карте, переименуйте его в Расстояния до дорог (классы).

8. Настройте отображение нового слоя на красно-зеленую шкалу, как обыч-

но.

9. Удалите из таблицы содержания оригинальный слой Расстояния до дорог.
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14.7.2 Водотоки

Выполните классификацию самостоятельно в соответствии со следующим пла-

ном:

1. Запустить инструмент Reclassify для слоя Расстояния до водотоков.

• В качестве метода классификации выбрать Quantile (квантили), чис-

ло классов — 10. Исправьте в столбце справа последнее значение на

2400, чтобы заведомо включить максимум.

• Инвертировать номера классов

• Переименовать выходной слой в Reclass_Euc_Water.

2. Получившийся слой назватьРасстояния до водотоков (классы)и раскрасить

в стандартной зелено-красной шкале.

3. Удалить из таблицы содержания оригинальный слой Расстояния до водо-

токов.

4. Снять выборку с объектов гидрографии.

5. Сохранить карту.

Снимок экрана№3. Классифицированный растр расстояний до водотоков

14.8 Нахождение мест с наилучшей комбинацией

факторов с помощью взвешенного оверлея

В начало упражнения �

Наилучшие участки соответствуют территориям, где сумма баллов по

всем факторам максимальна. Соединение значений (в том числе и сложение)

по нескольким слоям, располагающимся друг над другом, осуществляется с

помощью растрового оверлея.

1. Запустите инструмент Spatial Analyst Tools > Overlay > Weighted

Overlay.

2. Исправьте значения полей From, To и By на 1, 10 и 1, соответственно. Тем

самым вы укажете, что необходимо полученные суммы ранжировать по
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Рис. 14.10: Рис. 13. Диалог выбора слоя для взвешенного оверлея

баллам с 1 до 10 с шагом в 1 балл.

3. Щелкните на кнопке добавления слоя вверху диалога.

4. В появившемся диалоге выберите Углы наклона (классы) в списке Input

Raster. Поле Input field поставьте по умолчанию. Нажмите ОК:

Обратите внимание на появившуюся таблицу: она выводит значения клас-

сов, взятые из слоя (столбец Field), и позволяет сменить их (столбец Scale

Value) при выполнении оверлея.

Необходимо запретить строительство на участках с углами наклона более

12,5 градусов. Такие углы наклона возможны в классах 1-5 (в соответствии

с проведенной классификацией).

5. Щелкните на ячейке поля Scale Value напротив 1 класса и выберите из спис-

ка значение Restricted (запрещен).

6. Повторите эту операцию для 2, 3, 4 и 5 класса. Диалог инструмента примет

вид, аналогичный представленному на рисунке:

7. Добавьте в таблицу оверлея слои Расстояния до дорог (классы) и Расстоя-

ния до водоемов (классы) с помощью кнопки . Не меняйте значения

классов в таблице.

8. Сверните таблицы классов, нажав кнопку в начале каждой строки. Диа-

лог примет следующий вид:
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Глава 14. Оптимизация … 14.8. Нахождение мест с наилучшей …

Рис. 14.11: Рис. 14. Настройка параметров классов для слоя углов наклона релье-
фа
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14.8. Нахождение мест с наилучшей … Глава 14. Оптимизация …

Рис. 14.12: Рис. 15. Диалог взвешенного оверлея после добавления первых трех
слоев.
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Глава 14. Оптимизация … 14.8. Нахождение мест с наилучшей …

Рис. 14.13: Рис. 16. Добавление в таблицу оверлея слоя Землепользование
(растр).

9. Добавьте в таблицу оверлея слой Землепользование (растр). Однако на этот

раз выберите для него в качестве поля со значениями классов Land_Type:

10. Присвойте различным классам земель веса соответственно Рис. 17. Обра-

тите внимание на то, что больший вес имеют территории, более доступ-

ные для размещения площадки. Заболоченные земли и объекты гидрогра-

фии необходимо запретить для выбора, указав им класс Restricted. В эту же

категорию попадают участки, где нет данных.

Осталось определиться с тем, какие факторы будут иметь максимальный

вес. Заказчик решил, что приоритет в наборе факторов следует отдать бли-

зости к автодорогам. Среди остальных факторов меньше внимания можно

уделить углам наклона рельефа, поскольку они уже были ограничены па-

раметром Restricted.

11. Заполните веса в колонке %Influence следующим образом:

• Углы наклона — 15

• Расстояния до дорог — 35

• Расстояния до водоемов — 20

• Землепользование — 30.

После заполнения весов диалог примет вид, аналогичный представленно-

му на рисунке:

12. Нажмите ОК, чтобы запустить вычисления.
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14.8. Нахождение мест с наилучшей … Глава 14. Оптимизация …

Рис. 14.14: Рис. 17. Настройка значений класса пригодности для слоя Землеполь-
зование (растр)
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Глава 14. Оптимизация … 14.8. Нахождение мест с наилучшей …

Рис. 14.15: Рис. 18. Диалог инструмента Weighted Overlay после окончательной
настройки параметров
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14.9. Конвертация результирующих … Глава 14. Оптимизация …

13. После того, как результат оверлея будет добавлен в таблицу содержания,

переименуйте слой в Комбинация факторов.

14. Примените к полученному слою стандартную красно-зеленую шкалу.

Изучите получившееся изображение. Насколько оно отвечает тем

требованиям, которые выдвигались при анализе факторов? Отме-

чается ли близость темно-зеленых участков в дорогам, водоемам?

Каким цветом закрашены участки с крутыми склонами?

14.9 Конвертация результирующих зон в вектор-

ный формат

В начало упражнения �

В качестве потенциальных мест на размещение площадки следует выбрать

10-балльные участки. Затем можно конвертировать эти участки в векторный

формат, чтобы получить границы.

1. Откройте атрибутивную таблицу слоя комбинаций и выделите строку со

значением 10. Пикселы этого классы подсветятся на карте.

2. Запустите инструмент Conversion Tools > From Raster > Raster to

Polygon.

3. Выберите в качестве входного слой Комбинация факторов и нажмите ОК.

4. Переименуйте получившийся слой в Потенциальные участки. Обратите

внимание, что полигональные объекты были построены только для тех

пикселов, которые вы выделили на экране.

5. Смените цвет выделенных полигонов на ярко-желтый и нажмите кнопку

Full extent, чтобы вся карта поместилась на экран.

14.9.1 Выбор участков, имеющих необходимую площадь

Для выбора участков по площади следует использовать атрибутивный запрос
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Глава 14. Оптимизация … 14.9. Конвертация результирующих …

Рис. 14.16: Рис. 19. Результат анализа: ярко-желтые полигоны участков, опти-
мальные для строительства. Выделен полигон, имеющий необходимую площадь
более 30 000 м2

1. Откройте пункт меню Selection > Select by attributes, выберите для вы-

борки слой Потенциальные участки.

2. В конструктор запроса введите следующее выражение: ”Shape_Area” >

30000

Нажмите ОК. Результат вашей работы должен быть похож на рисунок ни-

же:

Снимок экрана №4. Результат анализа: выбранный участок

3. Сохраните документ карты.
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14.10. Контрольные вопросы Глава 14. Оптимизация …

14.10 Контрольные вопросы

В начало упражнения �

1. Чем растровое представление данных отличается от векторного? Почему

мы использовали растр представления расстояний?

2. Что вычисляет инструмент Euclidian Distance? Что означает величина в

каждой ячейке растра по результатам его выполнения?

3. В чем смысл реклассификации растра? Для чего ее можно использовать?

4. Как работает взвешенный оверлей?
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Глава 15

Анализ цифровой модели рельефа

Скачать данные и файл отчета

15.1 Введение

Цель — научиться на основе цифровой модели рельефа выделять водотоки и их

водосборные бассейны в автоматическом режиме. Осуществлять расчет стати-

стики по высотам в рамках выделенных бассейнов

Параметр Значение

Теоретическая подготовка Растровая модель пространственных данных. Цифровые модели рельефа (ЦМР) и их типы, построение ЦМР, построение производных поверхностей (углы наклона, направление тока, площадь водосбора). Гидрологический анализ ЦМР и его принципы.

Практическая подготовка Знание основных компонент интерфейса ArcGIS Desktop (каталог, таблица содержания, карта). Настройка символики и подписей объектов. Создание базы геоданных и классов пространственных объектов. Инструменты геообработки ArcToolbox. Создание компоновки карты: название легенда, масштаб, градусная сетка.

Исходные данные Цифровая модель рельефа по данным топографической карты масштаба 1:200 000.

Результат Карта водотоков и их водосборных бассейнов, построенная по ЦМР, с указанием средней высотой каждого бассейна.

Ключевые слова Цифровая модель рельефа, гидрологический анализ ЦМР.

15.1.1 Контрольный список

• Добавить на карту цифровую модель рельефа и визуализировать ее мето-

дом послойной окраски
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15.2. Оформление данных Глава 15. Анализ цифровой модели …

• Построить растр направлений тока

• Построить растр площади водосбора

• Выделить тальвеги путем запроса

• Присвоить тальвегам порядок по методу Стралера

• Векторизовать тальвеги

• Получить устья тальвегов

• Разделить устья впадающих водотоков

• Привязать полученные точки к растру аккумуляции тока

• Построить водосборные бассейны

• Конвертировать полученные бассейны в векторный вид

• Рассчитать статистику по высотам в пределах бассейнов

• Привязать рассчитанную статистику к площадям бассейнов

• Подписать бассейны по значению средней высоты

• Завершить оформление карты в режиме компоновки

15.1.2 Аннотация

Цифровые модели рельефа играют важную роль в гидрологическом и геоморфо-

логическом анализе. Одно из основных приложений ЦМР, позволивших значи-

тельно упростить анализ речных систем, — это автоматизированное построение

водосборов и расчет их морфометрических характеристик.

В задании вам предстоит автоматически выделить тальвеги и водосборы по

цифровой модели рельефа. Тальвеги будут классифицированы вами согласно их

порядкам, а для каждого бассейна определена средняя высота. Задание заверша-

ется оформлением карты в режиме компоновки.

15.2 Оформление данных

В начало упражнения �

1. Скопируйте каталог Ex15 в свою папку.
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Глава 15. Анализ цифровой модели … 15.2. Оформление данных

2. Подключитесь в окне каталога к вашей папке Ex15. Убедитесь, что в ней

находится база геоданных Ex15.gdb.

3. Используя контекстное меню базы данных, назначьте ее базой данных по

умолчанию.

4. Добавьте на карту слой dem. Это цифровая модель рельефа в растровом

формате.

5. Измените оформление слоя следующим образом:

Параметр Значение

Способ отображения Classified

Интервал С равным шагом (Defined Interval), сечение 20 м.

Цветовая шкала Scale_termo2:

Диалог примет следующий вид:

6. Измените красный цвет шкалы на оранжевый. Для этого в контекстном ме-
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15.2. Оформление данных Глава 15. Анализ цифровой модели …

ню цветовой шкалы выберите команду Properties…. В появившемся диа-

логе дважды щелкните на бело-красном градиенте и замените красный

цвет на оранжевый Electron Gold:

7. Завершите настройку шкалы, нажав ОК и еще раз ОК.

8. Измените сортировку значений на вкладке Symbology таким образом,

чтобы вверху оказались самые большие высоты. Нажмите ОК, чтобы

закрыть диалог настройки слоя.

9. Измените название слоя dem на «Послойная окраска».

10. Дополнительно к послойной окраске постройте горизонтали, чтобы

усилить пластику рельефа. Для этого запустите инструмент геообработки

Spatial Analyst Tools > Surface > Contour и заполните его параметры

следующим образом:

Параметр Значение

Input Raster Послойная окраска
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Глава 15. Анализ цифровой модели … 15.2. Оформление данных

Параметр Значение

Output Polyline Features …\Ex15\Ex15.gdb\contours

Contour interval 20

Величина сечения рельефа указывается в параметре Contour Interval.

Остальные параметры оставьте по умолчанию и нажмите ОК. Получен-

ный слой будет добавлен на карту.

11. Переименуйте слой в «Горизонтали» и измените его оформление следую-

щим образом:

Параметр Значение

Цвет линии Черный

Толщина линии 0,2

Прозрачность 90%

Изображение примет следующий вид:
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15.3. Направление тока Глава 15. Анализ цифровой модели …

Снимок экрана№1.Изображение рельефа методом горизонталей с послой-

ной окраской

Сохраните документ карты в свою папкуEx15 под именемEx15_DemAnalysis.mxd.

15.3 Направление тока

В начало упражнения �

Растр направления тока показывает в каждой ячейке направление макси-

мального уклона. Он необходим для построения водосборных бассейнов и про-

чих задач гидрологического и морфометрического анализа.

Для построения растра направлений тока запустите инструмент Spatial

Analyst Tools > Hydrology > Flow Direction и заполните его параметры

следующим образом:

Параметр Значение

Input Raster Послойная окраска

Output flow direction raster …\Ex15\Ex15.gdb\dir

Нажмите ОК. Полученный слой будет добавлен на карту:
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Глава 15. Анализ цифровой модели … 15.4. Водосборная площадь …

Снимок экрана №2. Растр направления тока

15.4 Водосборная площадь (аккумуляция тока)

В начало упражнения �

Растр аккумуляции тока в каждой ячейке хранит количество ячеек, дрениру-

емых выше по склону. Фактически, это число показывает водосборную площадь

для каждой ячейки. Площадь водосбора необходима для автоматического выде-

ления водотоков (тальвегов) по цифровой модели рельефа.

1. Для построения растра аккмуляции тока запустите инструмент Spatial

Analyst Tools > Hydrology > Flow Accumulation и заполните его парамет-

ры следующим образом:

Параметр Значение

Input Raster dir
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15.4. Водосборная площадь … Глава 15. Анализ цифровой модели …

Параметр Значение

Output flow accumulation raster …\Ex15\Ex15.gdb\acc

Нажмите ОК. Полученный слой будет добавлен на карту.

2. Чтобы сделать отображение растра аккумуляции тока более наглядным,

откройте его свойства и на вкладке Symbology измените растяжку гисто-

граммы на метод Histogram Equalize (Выравнивание гистограммы):

Картографическое изображение примет следующий вид:
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Глава 15. Анализ цифровой модели … 15.5. Выделение и классификация …

Снимок экрана №3. Растр аккумуляции тока

15.5 Выделение и классификация водотоков

В начало упражнения �

Выделение тальвегов осуществляется на основе растра аккумуляции тока.

Вы просто задаете запрос следующего вида: «Водотокам принадлежат те пиксе-

лы, в которых значение аккумуляции тока больше заданной величины. Остальные

пикселы сделать пустыми».

1. Для реализации этого запроса используйте инструмент Spatial Analyst >

Conditional > Set Null со следующими параметрами:

Параметр Значение

Input Conditional Raster acc

Expression Value VALUE < 2000

Input false raster or constant value 1
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15.5. Выделение и классификация … Глава 15. Анализ цифровой модели …

Параметр Значение

Output raster …\Ex15\Ex15.gdb\str

По результатам выполнения данного инструмента будут выделены все во-

дотоки, в которых значение аккумуляции тока более 2000.

2. Измените цвет полученных пикселов на белый, чтобы они были хорошо

видны. Изображение примет следующий вид:

Снимок экрана №4. Водотоки, полученные по растру аккумуляции тока

Полученные водотоки можно ранжировать по порядкам.

При упорядочении водотоков методом Стралера номер поряд-

ка увеличивается только в том случае, когда встречаются водо-

токи одного порядка. Водотоки, которые не имеют притоков,

имеют порядок равный 1.

3. Запустите инструмент Spatial Analyst Tools > Hydrology > Stream Order

и заполните его параметры следующим образом:

Параметр Значение

Input Stream Raster str
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Глава 15. Анализ цифровой модели … 15.6. Векторизация водотоков

Параметр Значение

Input Flow Direction Raster dir

Output raster …\Ex15\Ex15.gdb\strorder

Method of Stream Ordering STRAHLER

Нажмите ОК, чтобы запустить инструмент. Растр классифицированных

водотоков будет добавлен на экран. Если все выполнено верно, расцвет-

ка водотоков должна соответствовать их порядкам от 1 до 4.

Снимок экрана №5. Водотоки, классифицированные методом Стралера

15.6 Векторизация водотоков

В начало упражнения �

1. Для получения векторных линий водотоков воспользуйтесь инструмен-

том Spatial Analyst Tools > Hydrology > Stream to Feature и заполните

его параметры согласно следующей таблице:
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15.6. Векторизация водотоков Глава 15. Анализ цифровой модели …

Параметр Значение

Input Stream Raster strorder

Input Flow Direction Raster dir

Output Polyline Features …\Ex15\Ex15.gdb\streams

Simplify Polylines Да

После запуска инструмента в таблицу содержания будут добавлены век-

торные линии водотоков.

2. Переименуйте полученный слой в Водотоки.

3. Визуализируйте водотоки в соответствии с их порядками от 1 до 4. Для

этого настройте отображение слоя следующим образом:

Параметр Значение

Способ отображения Категории (Categories—Unique Values)

Поле отображения (Value Field) grid_code (в нем хранится порядок водотока после векторизации)

Цвет линий Steel Blue

Толщина линий 1, 1.5, 2 и 3 пункта

Диалог настройки отображения слоя должен выглядеть примерно следую-

щим образом:
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Глава 15. Анализ цифровой модели … 15.6. Векторизация водотоков

4. Нажмите ОК, чтобы применить настройки символики.

5. Измените название поля классификации в легенде с grid_code на «Порядок».

6. Отключите все слои, кроме слоевВодотоки, ГоризонталииПослойная окрас-

ка.

У вас должно получиться следующее картографическое изображение:
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15.7. Выделение и разделение … Глава 15. Анализ цифровой модели …

Снимок экрана №6. Классифицированные векторные линии водотоков

Сохраните документ карты.

15.7 Выделение и разделение устьевых точек

В начало упражнения �

Водосборный бассейн в рабочем процессе гидрологического анализа ЦМР

строится для одной точки. Если в качестве точки выбрать устье реки, то полу-

ченный бассейн будет соответствовать бассейну всей реки. Однако если устье

является точкой слияния двух водотоков, будет построен бассейн, общий для обо-

их водотоков. Проблему можно решить, немного сдвинув конечные точки водо-

токов выше по течению. Для этого можно использовать следующую последова-

тельность действий:

• Получить конечные точки водотоков (устья)

• Построить вокруг точек небольшие буферные зоны радиусом в 2R, где R —
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размер ячейки растра ЦМР (разрешение ЦМР)

• Полученными зонами обрезать исходные линии водотоков, таким обра-

зом их несколько укоротив

• Получить обновленные конечные точки водотоков, которые не совпадают

для каждой пары сливающихся притоков.

Приведенная последовательность действий является классическим приме-

ром интерпретации задачи в терминах инструментов ГИС-анализа.

1. Запустите инструмент Data Management Tools > Features > Feature

Vertices to Points со следующими параметрами:

Параметр Значение

Input Features Водотоки

Output Feature Class …\Ex15\Ex15.gdb\streams_ends

Point Type END (конечные точки)

2. Приблизьтесь к одной из точек слияния водотоков, пока не станут видны

отдельные пикселы, чтобы внимательно наблюдать за тем, что будет про-

исходить дальше.

3. Запустите инструмент Analysis Tools > Proximity > Buffer, который отве-

чает за построение буферных зон. Заполните его параметры следующим
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образом:

Параметр Значение

Input Features streams_ends

Output Feature Class …\Ex15\Ex15.gdb\streams_ends_Buffer

Distance (Linear Unit) 200

В таблицу содержания будут добавлены буферные зона вокруг устьев во-

дотоков:

4. Обрежьте водотоки с помощью инструмента Analysis Tools > Overlay

> Erase. Разберитесь самостоятельно, какие слои следует подставить в

параметры Input Features и Erase Features. Назовите выходной слой

streams_Erase.

Отключите временно слои Водотоки и streams_ends_Buffer, результат будет

выглядеть следующим образом:
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5. Воспользовавшись снова инструментом Data Management Tools >

Features > Feature Vertices to Points, постройте конечные точки для

обрезанных водотоков. Будьте внимательны при выборе типа точек

(параметр Point type). Назовите выходной класс streams_Erase_ends.

Результат должен выглядеть примерно следующим образом:

Снимок экрана №7. Точки слияния, смещенные выше по течению

6. Сохраните документ карты.

365



15.8. Построение водосборных … Глава 15. Анализ цифровой модели …

15.8 Построение водосборных бассейнов

В начало упражнения �

Построение водосборных бассейнов состоит из трех операций: * привязка

точек устья к растру аккумуляции тока, * проведение границ водосборов в раст-

ровом режиме, * векторизация бассейнов.

1. Запустите инструмент Spatial Analyst Tools > Hydrology > Snap Pour

Point и заполните его параметры следующим образом:

Параметр Значение

Input raster streams_Erase_ends

Input accumulation raster acc

Output raster …\Ex15\Ex15.gdb\pour

Snap Distance 100

Остальные параметры оставьте по умолчанию. Параметр Snap distance

указывает радиус поиска, в пределах которого вокруг каждой заданной

точки устья будет искаться ячейка с максимальной аккумуляцией тока. В

данном случае он равен 100 метрам — разрешению ЦМР.

После выполнения инструмента в окрестности каждой точки появится

привязанный пиксел:
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2. Для построения границ водосборных бассейнов запустите инструмент

Spatial Analyst Tools >Hydrology >Watershedи заполните его параметры

следующим образом:

Параметр Значение

Input flow direction raster dir

Input raster or feature pour point data pour

Pour point field Value

Output raster …\Ex15\Ex15.gdb\wsh

Полученный растр будет добавлен на экран, вы можете его расцветить в

уникальных цветах, чтобы границы бассейнов хорошо читались:
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Снимок экрана №8. Растровый слой водосборных бассейнов

3. Конвертируйте полученные бассейны в векторные полигоны. Для этого за-

пустите инструмент Conversion Tools > From Raster > Raster to Polygon

со следующими параметрами:

Параметр Значение

Input raster wsh

Field Value

Output polygon features …\Ex15\Ex15.gdb\watersheds

Simplify polygons Да

4. Переименуйте полученный слой в «Водосборные бассейны» и измените

его символ на тонкую красную линию без заливки.

5. Оставьте включенными следующие слои:

• Водотоки

• Водосборные бассейны

• Горизонтали

• Послойная окраска

6. Установите масштаб равным 1:400 000. Картографическое изображение

примет следующий вид:
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Снимок экрана №9. Векторный слой водосборных бассейнов

15.9 Расчет, привязка и визуализация статистики

по водосборным бассейнам

В начало упражнения �

В пределах границ водосборных бассейнов возможно рассчитать различную

статистику по данным ЦМР. Вам предлагается рассчитать статистику по высотам.

Далее эту статистику необходимо присоединить к исходному слою бассейнов.

1. Запустите инструмент Spatial Analyst Tools > Zonal > Zonal Statistics as

Table со следующими параметрами:

Параметр Значение

Input raster or feature zone data Водосборные бассейны

Zone Field Id
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Параметр Значение

Input Value Raster Послойная окраска

Output Table …\Ex15\Ex15.gdb\stats

Statistics Type ALL

2. Откройте полученную таблицу, чтобы ознакомиться с ее содержимым:

Снимок экрана №10. Таблица статистики высот по водосборным бассей-

нам

1. Присоедините статистические данные к исходному слою с помощью ин-

струмента Data Management Tools > Joins > Join Field со следующими

параметрами:

Параметр Значение

Input table Водосборные бассейны

Input join field Id

Join table stats

Output join field ID

Join fields Выделите все поля (кнопка Select All)
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Диалог инструмента примет следующий вид:

Нажмите ОК, чтобы запустить соединение таблиц. После выполнения ин-

струмента, откройте атрибутивную таблицу слоя Водосборные бассейны,

чтобы убедиться, что расчетные столбцы были добавлены:

2. Включите подписи слоя Водосборные бассейны по полю MEAN (средняя вы-

сота в пределах бассейна)

3. Чтобы избавиться от лишних значащих цифр, откройте таблицу слоя Во-

досборные бассейны и выберите в контекстном меню заголовка столбца

MEAN команду Properties (свойства поля):
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4. В открывшемся диалоге нажмите кнопку Numeric… и установите в окне

Number Format округление до 1 знака после запятой:
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Если все выполнено верно, на карте должны быть подписаны средние вы-

соты по каждому бассейну:
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Снимок экрана №11. Средние высоты водосборных бассейнов

5. Сохраните документ карты.

15.10 Оформление итоговой карты

В начало упражнения �

1. Установите масштаб карты равным 1:500 000

2. Переключитесь в режим компоновки

3. Измените ориентировку листа на альбомную

4. Добавьте на карту численный масштаб и заголовок «Водотоки разных поря-

доков и их водосборные бассейны».

5. Добавьте легенду со следующими слоями: Водотоки, Водосборные бассейны

и Послойная окраска.

6. Добавьте пометку «Для каждого бассейна указана средняя высота в метрах

над уровнем моря»

7. Приведите внешний вид карты в соответствии с рисунком:
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8. Полученную карту вставьте в отчет.

9. Сохраните документ карты.

15.11 Контрольные вопросы

В начало упражнения �

1. Что представляет растр направления тока?

2. Что представляет собой растр аккумуляции тока?

3. Как можно выделить водотоки по растру аккумуляции тока?

4. Как получаются порядки рек методом Стралера?

5. После того как выделены водотоки, какую последовательность действий

нужно выполнить, чтобы построить для них границы бассейнов?

6. Как можно рассчитать статистику по бассейнам? Опишите последователь-

ность действий.
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Пространственное моделирование
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Глава 16

Оценка плотности распределения

Скачать данные и файл отчета

16.1 Введение

Цель задания — научиться определять плотность распределения (густоту) ли-

нейных объектов с помощью метода плавающего окна.

Параметр Значение

Теоретическая подготовка Растровая модель пространственных данных, фильтрация растра, ядерное сглаживание, оценка плотности распределения.

Практическая подготовка Знание основных компонент интерфейса ArcGIS Desktop (каталог, таблица содержания, карта). Настройка символики и подписей объектов. Инструменты геообработки

Исходные данные База данных цифровой топографической карты 1:1 000 000 на территорию России

Результат Растры густоты дорожной сети, полученные методом простого подсчета длины линий и путем ядерного сглаживания с разным радиусом влияния. Карта густоты дорожной сети с компоновкой.

Ключевые слова Пространственный анализ, плотность распределения, фильтрация растра, ядерное сглаживание.

16.1.1 Контрольный лист

• Построить растры плотности и плотности ядер для линий

• Исследовать влияние радиуса вычислений на гладкость поверхности.

• Вырезать фрагмент результирующего растра на территорию России. Умно-
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жить значение плотности на 10, чтобы компенсировать эффект масштаба

• Подготовить проект карты густоты дорожной сети

16.1.2 Аннотация

Задание посвящено знакомству с анализом плотности размещения объектов на

примере густоты дорожной сети. Анализ густоты является одним из фундамен-

тальных методов исследования географических закономерностей размещения

объектов, который позволяет выявить неравномерности и связать их с геогра-

фическими условиями и соседством.

Для анализа густоты дорожной сети вами будет использована фильтрация

данных. Подсчет густоты основан на принципе скользящего окна: поверх исход-

ного слоя строится растровая поверхность и в заданном радиусе относительно

каждой ячейки растра подсчитывается суммарная длина линий. При использо-

вании ядерного сглаживания (кернфункции) полученное значение густоты сгла-

живается.

16.2 Оценка плотности дорожной сети

В начало упражнения �

1. Создайте в директории Ex16 новую файловую базу геоданных и назовите

ее Analysis

2. Назначьте созданную базу данных базой данных по умолчанию:
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3. Добавьте на карту слой Roads из базы данных MapData.gdb в папке Ex16.

Это дороги на территорию России, оцифрованные по картам масштаба

1:1 000 000.

4. Используя команду меню Cutomize > Extensions, включите модуль

Spatial Analyst

5. Откройте ArcToolbox

6. Запустите инструмент Spatial Analyst Tools > Density > Line Density и

заполните его параметры следующим образом:

Параметр Значение

Input polyline features Roads

Output cell size 10000

Output raster <путь к базе данных>/line_dens_100

Search radius 100000

Area units SQUARE_KILOMETERS

Диалог примет следующий вид:
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7. Нажмите ОК, чтобы запустить инструмент. Когда вычисления закончатся,

созданная поверхность будет добавлена на карту.

8. Отключите слой roadsи установитепередискретизацию слоя line_dens_100

в режим Cubic Convolution.

9. Примените к растру цветовую шкалу от синего к красному.

Результат:

10. Запустите инструмент Spatial Analyst Tools > Density > Kernel Density
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и заполните его параметры аналогично предыдущему инструменту. Назо-

вите выходную поверхность kernel_dens_100:

11. Примените к получившемуся слою такую же цветовую шкалу, как и преды-

дущему

12. Установите режиме передискретизации результирующего слоя Cubic

Convolution

13. Сделайте слой дорог черного цвета и установите ему прозрачность 70%.

14. Сравните растры, полученные методами LineDensity (простой подсчет дли-

ны линий в пределах плавающего окна) и Kernel Density (подсчет с исполь-

зованием кернфункции). Какой тип оператора дает более ровную поверх-

ность?
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16.3 Оценка влияния радиуса поиска

В начало упражнения �

1. Создайте методом Kernel Density еще два растра густоты дорожной сети с

радиусом поиска (Search radius) 200 000 и 400 000 м соответственно и раз-

решением (Output cell size) равным 20000 м. Назовите их kernel_dens_200 и

kernel_dens_400 соответственно.

2. Примените к полученным растрам настройки отображения по аналогии с

предыдущими результатами.

3. Оцените влияние радиуса поиска на сглаженность поверхности:
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4. Сохраните карту в каталог Ex16 под названием Roads.mxd

16.4 Масштабирование значение показателя

В начало упражнения �

Полученные растры отражают искаженное значение плотности, поскольку

исходный слой дорог содержит не все дороги. Их количество преуменьшено при-

мерно в 10 раз (карта масштаба 1:1 000 000. Чтобы привести значение густоты к

должно величине, необходимо умножить растр на 10.

1. Запустите инструмент Spatial Analyst > Math > Times

2. Заполните его параметры в соответствии со следующим диалогом и запу-
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стите:

16.5 Оформление слоя густоты дорожной сети

В начало упражнения �

1. Оставьте включенным только слой kernel_dens_100_x10

2. Добавьте на карту слой countries из базы данных MapData.gdb

3. Уберите у него заливку, а обводку установите черной, толщиной 1,5 пик-

села.

4. Выделите на карте полигон России.

5. Запустите инструмент Spatial Analyst > Extraction > Extract by Mask, что-

бы обрезать растр по границе России. Заполните его параметры в соответ-

ствии со следующим диалогом:
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6. Примените к полученному растру следующие настройки отображения:

Параметр Значение

Метод отображения Classified

Метод классификации Natural Breaks (Jenks)

Число классов 9

Шкала От синего к красному

Округлите значения полученных границ классов в столбце Label до одного-

двух знаков после запятой и отсортируйте классы по убыванию значе-

ний.

Результат:
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7. Переименуйте слой в «Густота дорожной сети», а заголовок показателя в

«км/кв.км»

Результат:
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16.6 Оформление итоговой карты

В начало упражнения �

1. Выделите полигоны России, Аральского и Каспийского морей в слое

Countries

2. Инвертируйте выборку.

3. Создайте новый слой на основе выборки и назовите его «Страны».

Присвойте ему символ с белой заливкой и черной обводкой толщиной 1,5

пункта.

4. Переименуйте исходный слой Countries в “Границы”

5. Установите заливку фрейма данных голубого цвета

Результат:

6. Добавьте на карту слой Cities, примените к нему символ черного кружка

диаметром 3 пункта и включите подписи по полюName_normalшрифтом

Tahoma 8 кегля.

7. Оформите компоновку карты в соответствии со следующим образцом:
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8. Сохраните документ карты.

16.7 Контрольные вопросы

В начало упражнения �

1. Для чего нужна оценка плотности пространственного распределения?

2. Как работает линейная оценка плостности распределения методом плава-

ющего окна?

3. Как работает ядерная оценка плотности распределения (оценка по методу

Парзена-Розенблатта)?

4. Как влияет на результат оценки величина радиуса поиска?
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Глава 17

Пространственная интерполяция

Скачать данные и файл отчета

17.1 Введение

Цель — научиться на основе точечных данных восстанавливать поля распреде-

ления непрерывных показателей различными способами. Осуществлять визуа-

лизацию методом изолиний с послойной окраской, строить профили по полу-

ченным поверхностям.

Параметр Значение

Теоретическая подготовка Построение растровых поверхностей. Интерполяция по данным в нерегулярно расположенных точках. Методы интерполяции: обратно взвешенных расстояний, естественного соседа, тренда, сплайнов, кригинга.

Практическая подготовка Знание основных компонент интерфейса ArcGIS Desktop (каталог, таблица содержания, карта). Настройка символики и подписей объектов. Пространственные и атрибутивные запросы, оверлей. Создание базы геоданных и классов пространственных объектов. Редактирование классов пространственных объектов. Инструменты геообработки ArcToolbox. Создание компоновки карты: название легенда, масштаб, градусная сетка.

Исходные данные Данные дрейфующих буев ARGO на акваторию Северной Атлантики, границы стран мелкомасштабной картографической основы.

Результат Поверхности температуры за 30.01.2011, построенные различными методами; поверхность кригинга, полученная после обработки фильтром 3х3; изолинии по данной поверхности с шагом 2,5 градуса; профиль температуры по меридиану 38° з.д.; карта с названием, легендой, масштабом и профилем

Ключевые слова Интерполяция, аппроксимация, гидрометеорологические поля, картографирование, профили.
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17.1. Введение Глава 17. Пространственная …

17.1.1 Контрольный лист

• Добавить на карту границы стран и точки наблюдений, оформить в соот-

ветствии с указаниями

• Оценить максимально возможное разрешение растра

• Построить поверхность методом обратно взвешенных расстояний

• Построить поверхность методом естественного соседа

• Построить поверхность методом сплайнов с натяжением

• Построить поверхности методом полиномиального тренда со степенями

1,2,3,4,5

• Построить поверхность методом кригинга

• Сгладить данную поверхность фильтром с плавающим окном размера 3х3

• Построить изолинии по данной поверхности

• Построить профиль по меридиану 38° з.д.

• Оформить карту с легендой и масштабом

17.1.2 Аннотация

Моделирование физических полей — основа гидрометеорологического карто-

графирования. Типичный рабочий процесс при создании карт температуры, дав-

ления, скорости ветра и прочих непрерывных в пространстве явлений заключа-

ется в восстановлении поверхности на основе точечных измерений (или модель-

ных значений). Полученные поверхности можно визуализировать, выполнять

их анализ, строить профили и разрезы.

В задании предлагается восстановить поле температуры в Северной Атлан-

тике по данным дрейфующих буев ARGO; проанализировать отличия поверхно-

стей, полученных разными методами. В заключении работы необходимо постро-

ить профиль и оформить карту в режиме компоновки.
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Глава 17. Пространственная … 17.2. Оформление базовых слоев

17.2 Оформление базовых слоев

В начало упражнения �

1. Скопируйте каталог Ex17 в свой рабочий каталог.

2. Подключитесь в окне каталога к вашей папке Ex17. Убедитесь, что в ней

находится база геоданных Argo.gdb.

3. Используя контекстное меню базы данных, назначьте ее базой данных по

умолчанию.

4. Добавьте на карту слои ArgoBuoys и Countries и оформите их следующим

образом:

• ArgoBuoys — черные кружки диаметром 3 пункта

• Countries — заливка серым цветом 30%, обводка серым цветом 60%

5. Включите подписи слояArgoBuoysпо полю Temp, установите размер шриф-

та равным 7 пунктам.

Картографическое изображение примет следующий вид:

Снимок экрана №1. Исходные данные

6. Сохраните документ карты в свою папку под названиемEx17_Interpolation.mxd
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17.3. Оценка необходимого … Глава 17. Пространственная …

17.3 Оценка необходимого разрешения растра

В начало упражнения �

Для оценки минимально необходимого разрешения растра следует вычис-

лить для массива исходных точек среднее расстояние до ближайшего соседа

(Nearest Neighbor Distance, NND), которое дает оценку пространственной частоты.

Согласно теореме Котельникова, потерь данных можно избежать, если частота

дискретизации будет вдвое больше максимальной пространственной частоты.

Данная частота дискретизации именуется частотой Найквиста. Интерпретируя

это утверждение в терминах растрового анализа, можно сказать, что разрешение

растра R должно быть по крайней мере в 2 раза мельче, чем среднее расстояние до

ближайшего соседа.

1. Запустите инструмент геообработки Analysis Tools > Proximity > Near и

задайте его параметры следующим образом:

Параметр Значение

Input Features ArgoBuoys

Near Features ArgoBuoys

Нажмите ОК:

396

https://ru.wikipedia.org/wiki/Теорема_Котельникова


Глава 17. Пространственная … 17.4. Интерполяция поверхностей

2. После завершения работы инструмента откройте атрибутивную таблицу

слоя ArgoBuoys и в контекстном меню заголовка поля Near_DIST выберите

команду Statistics, чтобы открыть диалог со статистикой поля.

3. Найдите в диалоговом окне строку Mean (среднее значение), разделите

его пополам и округлите полученное значение в меньшую сторону до бли-

жайшего числа, кратного 0,5. Если все сделано правильно, то в результате

должно получиться разрешение 2,5 градуса.

Более подробно с решением проблемы выбора оптимального разре-

шения растра вы можете ознакомиться в статье Hengl T. Finding the

right pixel size // Comput. Geosci. 2006. Vol. 32, № 9. P. 1283–1298.

17.4 Интерполяция поверхностей

В начало упражнения �

Используя инструменты геообработки, находящиеся в ArcToolbox в группе

Spatial Analyst Tools > Interpolation, постройте растровые поверхности ниже-

указанными методами:
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17.4. Интерполяция поверхностей Глава 17. Пространственная …

Метод Инструмент геообработки Выходной растр

Обратно

взвешен-

ных

расстоя-

ний

IDW .Ex17/Argo.gdb/Temp_IDW

Естественного

соседа

Natural Neighbor …/Ex17/Argo.gdb/Natural

Сплайнов Spline …/Ex17/Argo.gdb/Spline

Кригинга Kriging …/Ex17/Argo.gdb/Temp_Kriging

Тренда

1,2,3,4,5

степени

Trend (для указания степени полинома

используйте параметр Polynomial

Order)

…/Ex17/Argo.gdb/Trend1,…/Ex17/Argo.gdb/Trend2,…/Ex17/Argo.gdb/Trend3,…/Ex17/Argo.gdb/Trend4,…/Ex17/Argo.gdb/Trend5

Используя гиперссылки в таблице, вы можете перейти на страницу

справки и изучить принципы работы каждого из методов интерпо-

ляции.

Для всех инструментов будут общими следующие параметры:

Параметр Значение

Input Point Features ArgoBuoys

Z value field Temp

Output Cell Size 2,5

Если все выполнено верно, то в вашей базе геоданных и таблице содержа-

ния должно появиться 9 новых растров, отражающих поверхность распределе-

ния температуры:
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Глава 17. Пространственная … 17.5. Настройка отображения …

Снимок экрана №2. Построенные поверхности

17.5 Настройка отображения поверхностей

В начало упражнения �

Для того чтобы поверхности можно было сравнивать, необходимо визуали-

зировать их в единой цветовой шкале и с одинаковым шагом температуры. Рас-

смотрим последовательность действий на примере растра, полученного мето-

дом кригинга:

1. Убедитесь, что в свойствах слоя Temp_Kriging на вкладке Symbology вклю-

чен режим отображения Classified. Нажмите на этой же вкладке кнопку

Classify…

2. В появившемся диалоге выберите метод классификации Defined (за-

данный интервал), установите интервал равным 2,5 метра и нажмите

ОК:
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17.5. Настройка отображения … Глава 17. Пространственная …

3. Выберите сине-бело-красную шкалу для отображения температуры. Диа-

лог свойств слоя примет следующий вид:
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Глава 17. Пространственная … 17.5. Настройка отображения …

4. Нажмите ОК. Картографическое изображение примет следующий вид:

Снимок экрана №3. Поле температуры методом кригинга

5. Повторите эту операцию для оставшихся растров.
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17.6. Сглаживание поверхности, … Глава 17. Пространственная …

6. Поочередно включая только нужный растр (так чтобы на карте был виден

именно он) сделайте снимки экрана:

Снимок экрана №4. Поле температуры методом обратно взвешенных рас-

стояний

Снимок экрана №5. Поле температуры методом естественного соседа

Снимок экрана №6. Поле температуры методом сплайнов

Снимок экрана №7. Поле температуры методом тренда 1 степени

Снимок экрана №8. Поле температуры методом тренда 2 степени

Снимок экрана №9. Поле температуры методом тренда 3 степени

Снимок экрана №10. Поле температуры методом тренда 4 степени

Снимок экрана №11. Поле температуры методом тренда 5 степени

17.6 Сглаживание поверхности, полученной мето-

дом кригинга

В начало упражнения �

Мелкие неровности поверхности, обусловленные методом интерполяции,

можно устранить с помощью сглаживания. Для этого часто используется

фильтрация с помощью плавающего окна.

1. Отключите все растры кроме построенного методом кригинга.

2. Запустите инструмент Spatial Analyst Tools > Neighborhood > Focal

Statistics и настройте его параметры следующим образом:

Параметр Значение

Input Raster Temp_Kriging

Output Raster Ex17\Argo.gdb\Temp_Kriging_3x3

Остальные параметры (включая размер окна 3×3) оставьте по умолчанию.

Нажмите ОК. После выполнения сглаженный растр будет добавлен в таб-

лицу содержания:
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Глава 17. Пространственная … 17.6. Сглаживание поверхности, …

Обратите внимание на размер ячейки.

3. Визуализируйте сглаженный растр аналогично созданным ранее растрам.

Для этого вам потребуется сменить способ его отображения на Classified.

4. Нажмите ОК. Изображение примет цветной, но по прежнему пикселизо-

ванный вид:
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17.6. Сглаживание поверхности, … Глава 17. Пространственная …

5. Дважды щелкните на слое Temp_Kriging_3x3, перейдите на вкладку Display

и установите режим передискретизации слоя Сubic Convolution (кубиче-

ская свертка):
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Глава 17. Пространственная … 17.6. Сглаживание поверхности, …

6. Нажмите ОК. Изображение примет более привычный гладкий вид непре-

рывной поверхности:
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17.7. Построение линии профиля Глава 17. Пространственная …

Снимок экрана №12. Сглаженная поверхность поля температуры

17.7 Построение линии профиля

В начало упражнения �

Распространенная задача при анализе полей температуры, солености, дав-

ление — построение профилей или разрезов. Вам предлагается построить про-

филь температуры по меридиану 38° з.д.

1. Создайте в базе геоданных Argo линейный класс пространственных объек-

тов c названиемProfileи системой координатWGS84из группыGeographic

Coordinate Systems > World.

2. Добавьте этот слой на карту и смените его символ на линию черного цвета.

3. Включите режим редактирования.

4. Выберите в окнеCreate Features слойProfilesи щелкните правой кнопкой

мыши на карте. В появившемся диалоге выберите команду Absolute X,Y

чтобы задать координаты первой точки профиля:

5. В появившемся мини-диалоге введите значения для долготы и широты со-
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Глава 17. Пространственная … 17.7. Построение линии профиля

ответственно -38 и 0 и нажмите на клавиатуре Enter.

6. Повторите эту операцию для ввода конечной точки профиля (координаты

-38 и 63 соответственно)

7. Нажмите на клавиатуре F2, чтобы завершить создание линии:

8. Завершите сеанс редактирования, выбрав на панелиEditorкомандуEditor

> Stop Editing.
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17.8. Определение температур по … Глава 17. Пространственная …

17.8 Определение температур по линии профиля

В начало упражнения �

Для построения профиля вдоль созданной линии необходимо перенести ве-

личины температур с поверхности на узлы линии профиля. Для этого можно вос-

пользоваться функцией интерполяции объектов.

Интерполяция объектов позволяет перенести информацию с по-

верхности на перекрывающиеся с ней объекты. В частности, при

интерполяции линии каждый ее узел получит значение, интерпо-

лированное в той же точке с поверхности растра.

1. Запустите инструмент3DAnalyst Tools > Functional Surface > Interpolate

Shape и заполните его параметры следующим образом:

Параметр Значение

Input Surface Temp_Kriging_3x3

Input Feature Class Profile

Output Feature Class .Ex17\Argo.gdb\Profile_Temp

Остальные параметры оставьте по умолчанию и нажмите ОК.

2. Для корректного отображения широты конвертируйте линию в точки. Для

этого запустите инструментData Management Tools > Features > Feature

Vertices to Points. Назовите выходной класс Profile_Temp_Pts.

3. Добавьте в точки значения широты, долготы и температуры. Для этого вос-

пользуйтесь инструментом Data Management Tools > Features > Add XY

Coordinates.

4. Откройте атрибутивную таблицу получившегося слоя. Она должна иметь

следующий вид:
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5. Выберите команду меню View > Graphs > Create Graph:

6. Настройте параметры графика следующим образом:

Параметр Значение

Graph Type Vertical Line

Layer/Table Profile_Temp_Pts
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17.8. Определение температур по … Глава 17. Пространственная …

Параметр Значение

Y Field POINT_Z

X Field POINT_Y

Add to Legend Отключено

Диалог примет следующий вид:

7. Нажмите Next и настройте отображение графика следующим образом:

Параметр Значение

Title Профиль температуры по меридиану 38° з.д.

Axis Properties > Left Температура, °С

Axis Properties > Bottom Широта, °

Диалог примет следующий вид:
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8. Нажмите Finish. Построенный профиль будет добавлен в окно приложе-

ния:

Снимок экрана №13. Профиль температуры
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17.9 Оформление карты

В начало упражнения �

1. Переключитесь в режим компоновки.

2. Установите масштаб равным 1:70 000 000.

3. Щелкните на профиле правой кнопкой мыши и выберите команду Add To

Layout, чтобы добавить его на страницу компоновки.

4. Оформите карту в соответствии с нижеприведенным изображением. До-

бавьте на нее название, легенду и численный масштаб:
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Для установки нулевого расстояния между плашками цветовой шкалы два-

жды щелкните на легенде, перейдите на вкладку Layout и установите па-

раметр Vertical Patch Gap равным 0 pt:
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5. Экспортируйте изображение в файл формата PNG и вставьте его в отчет.

6. Сохраните документ карты.

17.10 Контрольные вопросы

В начало упражнения �

1. Каким образом выбирается разрешение растра?

2. Как работает метод обратно взвешенных расстояний?

3. Как работает метод естественного соседа?

4. Как работает метод тренда?

5. Как работает метод кригинга?

6. Опишите отличия в созданных растрах

7. Что позволяет сделать фильтрация растра?
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8. Что такое передискретизация растра и для чего она нужна?

9. Обратите внимание, что поверхность кригинга не всегда соответствует ис-

ходным значениям в точках. Чем это может быть обусловлено?
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Глава 18

Трехмерное моделирование

Скачать данные и файл отчета

18.1 Введение

Цель задания — знакомство с трехмерными моделями данных, трехмерной ви-

зуализацией и анализом в ГИС

Параметр Значение

Теоретическая подготовка Трехмерные модели данных, виртуальное моделирование, анализ цифровых моделей рельефа, построение зон видимости.

Практическая подготовка Знание основных компонент интерфейса ArcGIS Desktop (каталог, таблица содержания, карта). Настройка символики и подписей объектов. Создание базы геоданных и классов пространственных объектов. Инструменты геообработки ArcToolbox. Создание компоновки карты: название легенда, масштаб, градусная сетка.

Исходные данные База данных ГИС “Сатино”, аэрофотоснимок сверхвысокого разрешения.

Результат Трехмерная модель Сатинского учебного полигона, зоны видимости и линии небосвода для двух обзорных точек

Ключевые слова Трехмерный анализ и моделирование, цифровые модели рельефа (ЦМР), драпировка снимка

18.1.1 Контрольный лист

• Добавить на карту ЦМР и отобразить ее методом горизонталей с послой-

ной окраской.

• Подготовить вспомогательные объекты для учета препятствий.

417

http://autolab.geogr.msu.ru/gis/data/Ex18.zip


18.1. Введение Глава 18. Трехмерное моделирование

• Преобразовать растровые данные в триангуляционные.

• Визуализировать данные в трехмерной среде (приложение ArcScene).

• Выполнить анализ зоны видимости наблюдательного пункта при разных

положениях его высоты.

18.1.2 Аннотация

Трехмерные модели играют важную роль в географических исследованиях. Изу-

чение рельефа и его морфометрических характеристик; моделирование полей

распределения физических и химических показателей в океане, атмосфере и

почвах; моделирование городской среды и транспортных коммуникаций; мо-

делирование поверхностей небесных тел; имитация чрезвычайных ситуаций и

военных действий — это лишь краткий список тех задач, которые решаются с

помощью анализа и визуализации 3D-моделей.

Задание посвящено знакомству с трехмерным ГИС-моделированием. Гео-

графическая задача, которую вам предстоит решить — это определение зоны

видимости в точке с учетом рельефа и физических препятствий, таких как

дома и лесные массивы. Анализ зон видимости позволяет определить охват

территории доступный для визуального наблюдения.

Зона видимости ограничивается трехмерной линией небосвода (skyline).

Чем круче угол направления между точкой наблюдателя и линией небосвода,

тем меньше будет открытость небосвода по данному направлению. Общая

открытость небосвода характеризует долю видимой части небесной полусферы.

Это важный топоклиматический параметр, накладывающий ограничение на

объем поступающей прямой солнечной радиации. Как следствие, открытость

небосвода учитывается при расчетах таяния снега, моделировании городского

климата, оценке пригодности земель для сельского хозяйства.

В процессе занятия вы научитесь работать с растровыми и триангуляци-

онными моделями рельефа, управлять отображением слоев в виртуальной

3D-среде и использовать снимки в качестве текстуры трехмерных моделей,

определять зону видимости и визуализировать ее.
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18.2 Организация рабочего пространства

В начало упражнения �

1. Скопируйте данные упражнения в свой рабочий каталог Ex18 с помощью

Проводника.

2. Откройте ArcMap и в нем — окно Catalog (Каталог).

3. Сохраните документ карты в свой каталог Ex18 под именем Ex18_ЦМР.mxd.

4. Создайте в домашнем каталоге новую базу геоданных Ex18.

5. Щелкните по Ex18.gdb правой кнопкой мыши и выберите пункт Make

Default Geodatabase чтобы назначить ее базой геоданных по умолчанию.

18.3 Визуализация цифровой модели рельефа

В начало упражнения �

Для того чтобы полноценно моделировать видимость в трехмерном про-

странстве, необходимо иметь в наличии цифровую модель рельефа, а также и

объекты, расположенные на поверхности.

1. Раскройте в домашнем каталоге базу геоданных Satino.gdbи перенесите на

карту следующие слои из группы General:

• WaterPolygon (площадная гидрография);

• WaterLine (линейная гидрография);

• Contours (горизонтали);

• DEM (цифровая модель рельефа);

2. Разместите слои именно в том порядке, в котором они указаны выше.

3. Дважды щелкните на слое Горизонтали. Перейдите на вкладку Display и

установите значение прозрачности равным 80% (Рис. 1).

4. Перейдите на вкладку Symbology и поменяйте цвет горизонталей на чер-

ный. Нажмите ОК.

5. Смените символ слоя Гидрография (линии) на ярко-голубую линию толщи-

ной 1.5 пиксела.

6. Смените цвет объектов слоя Гидрография (полигоны) на ярко-голубой.
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Рис. 18.1: Рис. 1. Установка прозрачности слоя

7. Переименуйте слой DEM в таблице содержания в ЦМР.

8. Дважды щелкните на слоеЦМР, перейдите на вкладку Symbology и нажми-

те Classify…, чтобы сменить метод классификации.

9. В появившемся диалоге выберите режим Defined Interval (заданный вруч-

ную интервал) и установите величину интервала равной 4 метрам. Окно

классификации примет вид, аналогичный Рис. 2.

10. Нажмите ОК чтобы закрыть диалог классификации высот.

11. Выберите цветовую шкалу, близкую по гамме к гипсометрической. Окно

карты примет вид, аналогичный представленному на Рис. 3.

Снимок экрана №1. Цифровая модель рельефа долины реки Протвы

18.4 Подготовка вспомогательных цифровых мо-

делей для учета препятствий

В начало упражнения �

При расчете зоны видимости важно учитывать, что на поверхности располо-

жены разные объекты, в том числе здания и растительность. Чтобы учесть объ-

ект в качестве препятствия, есть два пути: представить его в виде трехмерного

тела, либо внедрить в качестве неровности в цифровую модель рельефа. Для рас-

тительности вам предлагается воспользоваться вторым вариантом. Алгоритм

состоит из двух шагов:

•  преобразовать слой растительности в растр, каждый пиксел которого хра-

нит значение высоты растительности;

• прибавить полученный растр к растру ЦМР; там, где леса нет, высота ЦМР
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Глава 18. Трехмерное моделирование 18.4. Подготовка вспомогательных …

Рис. 18.2: Рис. 2. Классификация высот для послойной окраски методом заданного
интервала
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18.4. Подготовка вспомогательных … Глава 18. Трехмерное моделирование

Рис. 18.3: Рис. 3. Цифровая модель рельефа долины реки Протвы

сохранится; на залесенных участках к ней прибавится высота раститель-

ного покрова.

1. Найдите слой VegTypes в базе данных Satino.gdb и добавьте его на карту.

2. Дважды щелкните на слое Растительность и перейдите на вкладку

Symbology.

3. Выберите тип отображение Quantities > Graduated Colors. В качестве по-

ля отображения укажите поле Высота. Выберите шкалу от светло-зеленого

к темно-зеленому. Диалог примет вид, аналогичный представленному на

Рис. 4:

4. Нажмите ОК. Окно карты примет следующий вид (Рис. 5):

5. Откройте ArcToolbox и запустите инструмент Conversion Tools > To

Raster > Polygon to Raster.

6. Выберите в качестве входных данных Input Features слой Раститель-

ность.
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Глава 18. Трехмерное моделирование 18.4. Подготовка вспомогательных …

Рис. 18.4: Рис. 4. Визуализация слоя по численному показателю методом количе-
ственного фона

Рис. 18.5: Рис. 5. Количественный фон по высоте растительности
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Рис. 18.6: Рис. 6. Преобразование полигона лесного массива в растровое представле-
ние с помощью инструмента Polygon to Raster

7. В списке Field выберите поле Height — значение, хранящееся в нем, будет

присвоено каждой ячейке растра.

8. Установите параметр Cell size равным 2,5 метра. Остальные параметры

оставьте по умолчанию. Диалог инструмента примет вид, аналогичный

представленному на Рис. 6:

9. Нажмите ОК, чтобы запустить выполнение инструмента.

10. Полученный слой переименуйте в Высота растительности.

11. Запустите инструмент Spatial Analyst Tools > Math > Plus, осуществляю-

щий сложение растров.

12. Выберите в качестве первого растра ЦМР, в качестве второго — Высота

растительности.

13. Назовите выходной класс DEM_Veg. Диалог примет следующий вид (Рис.

7).

14. Нажмите ОК.

15. После того, как полученный слой добавится на карту, назовите его ЦМР+.

16. Перенесите слой ЦМР+ под гидрографию. Обратите внимание на резкие

перепады яркости изображения, обусловленные внедрением объектов

растительности.

424



Глава 18. Трехмерное моделирование 18.4. Подготовка вспомогательных …

Рис. 18.7: Рис. 7. Инструмент Plus, осуществляющий сложение растров

Рис. 18.8: Рис. 8. Поле высот с внедренными объектами растительности
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18.5 Преобразование растровых моделей в триан-

гуляционные

В начало упражнения �

До этого момента вы использовали растровые модели, которые удобны для

вычислений. Их также можно использовать и в трехмерной среде. Однако, чтобы

обеспечить максимальную производительность и качество визуализации, раст-

ровые модели желательно преобразовать в триангуляционные, поскольку имен-

но на них основаны методы трехмерной визуализации.

1. Запустите инструмент геообработки 3D Analyst Tools > Conversion >

From Raster > Raster to TIN.

2. В качестве Input Raster выберите ЦМР.

3. В поле Output TIN назовите выходной слой tin.

4. Параметр допуска по высоте Z Tolerance установите равным 0,25 метров.

Параметр Z Tolerance управляет чувствительностью триангу-

ляционной модели к неровностям поверхности. Если величина

неровности больше, чем указанный порог, она будет выражена

в виде набора треугольников. В нашем случае сечение исход-

ных горизонталей было 2 метра, а вспомогательных горизон-

талей — 1 м. Точность положения горизонталей — ¼ сечения.

Следовательно, значение порога, равное 0,25 метра позволит

сохранить все нюансы поверхности.

5. Максимальное количество точек Maximum Number Of Points увеличьте

до 3 000 000 (три миллиона). Это значение подобрано для вас эмпирически.

6. Множитель по высоте Z factor оставьте равным 1. Окно инструмента при-

мет вид, аналогичный представленному на Рис. 9.

7. Нажмите ОК, чтобы запустить преобразование.

8. Повторите процедуру преобразования для слоя ЦМР+. В диалоге инстру-

мента назовите выходной слой tin+.

9. Полученный слой tin+ поместите в таблице содержания так, чтобы он был
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Рис. 18.9: Рис. 9. Инструмент Raster to TIN для преобразования растровых моделей
в триангуляционные

под слоями гидрографии. Все слои, кроме tin+ и гидрографии отключите.

10. Дважды щелкните на слое tin+ и перейдите на вкладку Symbology.

11. Выберите в списке слева метод отображения Edge Types — он отвечает за

показ ребер триангуляции.

12. Щелкните внизу на кнопкуAddAll Values, чтобы добавить к отображению

все типы ребер.

13. Исправьте цвет стандартного ребра Regular Edge на черный и нажмите ОК.

14. Приблизьтесь к лесному массиву в центральной части карты к северу от

Протвы. Окно карты примет вид, аналогичный представленному на (Рис.

10).

Проанализируйте свойства триангуляционной модели. Является ли

плотность треугольников и их размеры постоянными? Обратите

внимание, как сгущается сетка на участках с большой кривизной

поверхности.

Сохраните документ карты и сверните окно.

Снимок экрана №2. Триангуляционная модель рельефа долины реки

Протвы с лесным массивом
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Рис. 18.10: Рис. 10. Триангуляционная модель рельефа с лесным массивом
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Рис. 18.11: Рис. 11. Панель инструментов Tools в ArcScene

18.6 Визуализация данных в трехмерной среде и

знакомство с приложением ArcScene

В начало упражнения �

Несмотря на то, что анализ зон видимости можно проводить и в традицион-

ной двумерной среде, более наглядно результат выглядит в трехмерной сцене,

особенно когда есть несколько местоположений наблюдателя с разными высо-

тами.

Для работы в трехмерной среде в ArcGIS используется приложение

ArcScene. Это инструмент визуализации, анализа и редактирования трехмер-

ных данных.

1. Откройте приложение Пуск—Программы > ArcGIS > ArcScene.

2. Сохраните сразу же документ сцены в свой каталог Ex18 под названием

Ex18_3D.sxd.

3. Раскройте домашнюю директорию в окне Каталога, щелкните правой

кнопкой мыши на базе геоданных Ex18.gdb и выберите пункт Make

Default Geodatabase, чтобы назначить ее базой геоданных по умолчанию,

если это еще не сделано.

4. Откройте панель инструментов Tools и обратите внимание на то, что она

несколько отличается от привычной вам панели инструментов вАркмапе.

Самый первый инструмент используется для вращения сцены.

5. Добавьте на карту слой PhotoPlan из базы геоданных Satino.

Обратите внимание на то, что снимок отображается плоским.

Системе известна лишь информация о цвете каждого пиксела,
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но не о его высоте.

6. Откройте свойства слоя и перейдите на вкладку Base Heights (базовые вы-

соты).

7. Установите параметр Elevation from surfaces в положение Floating on a

custom surface.

8. Нажмите кнопку обзора каталогов и укажите модель tin+ в качестве ис-

точника высот.

9. На вкладке Symbology в группе Stretch установите параметрType равным

None. Этот параметр отвечает за растяжку гистограммы, которая в случае

фотоснимка не нужна.

10. Перейдите на вкладку Display и установите параметр Resample during

display using равным Cubic Convolution (кубическая свертка). В этом режи-

ме изображение будет всегда сглаживаться независимо от масштаба сце-

ны.

11. Перейдите на вкладку Rendering поставьте галочку Shade areal features

relative to the scene’s light position. В этом режиме снимок на снимок бу-

дет накладываться тень в соответствии с параметрами освещения сцены.

12. На той же вкладке в группе настроек Optimize переместите ползунок

Quality enhancement for raster images в крайнее правое положение

для того чтобы снимок отображался в максимальном качестве. Диалог

настройки слоя примет вид, аналогичный представленному на Рис. 12.

13. НажмитеОК в настройках слоя. Вам придется подождать некоторое время,

пока снимок драпируется на поверхность модели.

14. Добавьте на карту слои WaterLine и WaterPolygon из базы геоданных Satino

и переместите их наверх таблицы содержания.

15. Откройте свойства слоя Гидрография (полигоны) двойным щелчком.

16. Перейдите на вкладку Symbology и смените цвет заливки на ярко-голубой,

и уберите обводку (поставьте No Color).

17. Перейдите на вкладкуDisplayи установите прозрачность слоя (Transparency)

равной 30%.
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Глава 18. Трехмерное моделирование 18.6. Визуализация данных в …

Рис. 18.12: Рис. 12. Настройка параметров рендеринга для аэрофотоснимка
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18.6. Визуализация данных в … Глава 18. Трехмерное моделирование

Рис. 18.13: Рис. 13. Снимок, драпированный поверх ЦМР с высотами растительно-
сти

18. Перейдите на вкладку Base Heights и установите параметр Elevation from

surfaces в положение Floating on a custom surface. Нажмите кнопку обзора

каталогов и укажите в качестве источника модель tin.

19. Нажмите ОК в свойствах слоя.

20. Настройте аналогичным образом слой Гидрография (линии), сменив цвет

линии на голубой и включив опцию Floating on a custom surface.

Полученная сцена имеет один недостаток: необходимо увеличить мас-

штаб по высоте, чтобы изображение стало более наглядным.

21. Дважды щелкните в таблице содержания на заголовке Scene Layers и уста-

новите параметр Vertical Exxageration равным 3. Нажмите ОК.

22. Окно приложения примет вид, аналогичный представленному на Рис. 13.

Что изменилось в сцене после установки параметра Vertical

Exxageration? Как он влияет на отображение слоев?
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Глава 18. Трехмерное моделирование 18.7. Визуализация трехмерных …

18.7 Визуализация трехмерных объектов: геоде-

зические пункты и здания

В начало упражнения �

В сцену необходимо добавить здания, которые играют роль дополнитель-

ных препятствий и геодезические пункты, с которых производятся наблюдения.

До этого момента вы пользовались функцией драпировки объектов на поверх-

ность. Здания и геодезические пункты, напротив, хранятся в базе данных как

трехмерные объекты.

1. Добавьте на карту слой Geopoints_3D из базы данных Satino.

2. Дважды щелкните на слое Геодезические пункты 3D в таблице содержания

и на вкладке Symbology щелкните на кнопку с изображением символа.

3. В открывшемся диалоге нажмите кнопку Style References, чтобы подгру-

зить дополнительные символы.

4. Отметьте в списке набор символов 3D Industrial (Рис. 14) и нажмите ОК.

5. Найдите в таблице символWatchTower 1, выберите его и установите размер

40 пикселов. Диалог настройки символа примет вид, аналогичный пред-

ставленному на Рис. 15.

6. Нажмите ОК, чтобы завершить настройку символа для геодезического

пункта.

7. Добавьте на карту слойBuildings_3Dиз базы данных Satino. Это трехмерные

объекты типа Multipatch, у которых была заранее определена высота.

8. Приблизьтесь к участку поймы между деревнями Дедюевка и Рыжково. Ок-

но приложения примет вид, аналогичный представленному на Рис. 16.

Снимок экрана№3. Визуализация исходных данных для анализа зон ви-

димости: рельеф, снимок, геодезические пункты и трехмерные здания
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18.7. Визуализация трехмерных … Глава 18. Трехмерное моделирование

Рис. 18.14: Рис. 14. Подключение набора символов через Symbol Selector
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Глава 18. Трехмерное моделирование 18.7. Визуализация трехмерных …

Рис. 18.15: Рис. 15. Выбор символа для геодезического пункта (Watch Tower 1)
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18.7. Визуализация трехмерных … Глава 18. Трехмерное моделирование

Рис. 18.16: Рис. 16. Трехмерные данные для анализа зон видимости и открытости
небосвода
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Глава 18. Трехмерное моделирование 18.8. Анализ зоны видимости …

18.8 Анализ зоны видимости наблюдательного

пункта

В начало упражнения �

Зона видимости строится для определенной точки в трехмерном простран-

стве. В качестве наблюдательных точек удобно использовать геодезические

пункты. Сначала вы определите зону видимости с точки, расположенной на зем-

ле, а затем приподнимете ее на несколько метров, чтобы понять, как изменится

зона видимости.

1. Откройте атрибутивную таблицу слоя Геодезические пункты 3D и выде-

лите строку с геодезическим пунктом Старое русло. Строка должна выде-

литься ярко-голубым цветом.

2. Запустите инструмент геообработки 3D Analyst Tools > Visibility >

Skyline, который строит линию небосвода.

3. В качестве слоя точек наблюдений Input Observer Point Features выбери-

те Геодезические пункты 3D. Поскольку вы выделили объект в таблице это-

го слоя, линия небосвода будет рассчитана только для него, а не для всех

объектов.

4. В поле Input Surface выберите поверхность tin+ с помощью обзора катало-

гов.

5. Из списка препятствий Input Features выберите слой Здания 3D. Диалог

инструмента и окно приложения примут вид, аналогичный представлен-

ному на Рис. 17.

6. Нажмите ОК, чтобы запустить расчеты.

7. После того, как результат будет добавлен в таблицу содержания, смените

его название на Линия небосвода (Старое русло) и смените символ на ярко-

желтую линию.

8. Запустите инструмент 3D Analyst Tools > Visibility > Skyline Barrier, ко-

торый строит трехмерную зону видимости на основе линии небосвода.

9. Выберите в качестве Input Observer Point Features слой Геодезические
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18.8. Анализ зоны видимости … Глава 18. Трехмерное моделирование

Рис. 18.17: Рис. 17. Инструмент Skyline для построения линии небосвода
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Глава 18. Трехмерное моделирование 18.8. Анализ зоны видимости …

Рис. 18.18: Рис. 18. Результат расчета зоны видимости для пункта Старое русло

пункты 3D.

10. В качестве Input Features выберите слой Линия небосвода (Старое русло).

11. Установите галочку Closed, чтобы сформировать боковые стенки зоны ви-

димости.

12. Остальные параметры оставьте по умолчанию.

13. Нажмите ОК, чтобы запустить расчеты.

14. После того, как результат добавится в таблицу содержания, переименуйте

его в Зона видимости (Старое русло).

15. Смените цвет слоя зоны видимости на ярко-желтый и установите прозрач-

ность слоя равной 50%. Окно приложения примет вид, аналогичный пред-

ставленному на Рис. 18:
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18.9. Изменение высоты наблюдения Глава 18. Трехмерное моделирование

Снимок экрана №4. Результат расчета зоны видимости пункта Старое

русло

Проанализируйте результат. Приблизьтесь поближе, чтобы рас-

смотреть полученные границы. Как ведет себя линия небосвода

при встрече с препятствиями?

18.9 Изменение высоты наблюдения

В начало упражнения �

Рассмотрим теперь, как изменится зона видимости, если переместиться в

пункт, расположенный более высоко.

1. Выберите в таблице атрибутов слоя Геодезические пункты 3D строку Дедю-

евка. Строка должна выделиться ярко-голубым цветом.

2. Запустите инструмент Skyline еще раз для построения линии небосвода.

3. В параметр Input Observer Point Features подставьте слой Геодезические

пункты 3D.

4. В поле Input Surface выберите поверхность tin+ с помощью обзора катало-

гов.

5. Из списка препятствий Input Features выберите слой Здания 3D. Осталь-

ные параметры оставьте по умолчанию и запустите инструмент.

6. Получившийся слой переименуйте в Линия небосвода (Дедюевка) и смените

его символ на ярко-красную линию.

7. Запустите снова инструмент Skyline Barrier для построения зоны видимо-

сти.

8. Выберите в качестве Input Observer Point Features слой Геодезические

пункты 3D.

9. В качестве Input Features выберите слой Линия небосвода (Дедюевка).

10. Установите галочку Closed, чтобы сформировать боковые стенки зоны ви-

димости.

11. Остальные параметры оставьте по умолчанию и запустите инструмент, на-
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Глава 18. Трехмерное моделирование 18.9. Изменение высоты наблюдения

Рис. 18.19: Рис. 19. Зона видимости, построенная для пункта Дедюевка

жав ОК.

12. Переименуйте получившийся слой в Зона видимости (Дедюевка), смените

его цвет на розовый и установите прозрачность равной 50%.

13. Отключите слои Линия небосвода (Старое русло) и Зона видимости (Старое

русло).

14. Нажмите глобус, чтобы вся сцена поместилась на в окне просмотра (Рис.

19).

Снимок экрана№5. Результат расчета зоны видимости пункта Дедюевка

Проанализируйте, как изменилась зона видимости после выбо-

ра более высокой точки.

Сохраните документ сцены еще раз. Положите ваш отчетный файл в сетевую
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18.10. Контрольные вопросы Глава 18. Трехмерное моделирование

папку преподавателя.

18.10 Контрольные вопросы

В начало упражнения �

1. Опишите сути и отличия растровой и триангуляционной моделей рельефа

2. На что влияет параметр допуска по высоте (z tolerance) при преобразова-

нии растровой модели в триангуляционную?

3. Каким эффектом обладает параметр преувеличения по высоте (vertical

exxageration) применительно к цифровой модели рельефа? Меняет ли

этот параметр сами цифровые данные о высотах?

4. Какие действия необходимо выполнить для того чтобы положить снимок

на трехмерную цифровую модель рельефа?

5. Что такое линия зона видимости и линия небосвода? Как они соотносятся?

6. Как влияет высота точки наблюдения на конфигурацию зоны видимости?
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Приложение A

Работа с окном каталога

A.1 Открытие каталога

Окно каталога используется для работы с файлами и базами пространственных

данных. Оно обычно расположено в правой части приложения и вызывается пу-

тем нажатия кнопки на панели инструментов:
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A.2. Подключение к каталогу Приложение A. Работа с окном каталога

A.2 Подключение к каталогу

Для подключения к папке используйте кнопку на панели инструментов:
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Приложение B

Геообработка

B.1 Открытие ArcToolbox

На стандартной панели инструментов нажмите кнопку с красным сундучком:

B.2 Запуск инструмента

Найдите нужный инструмент в иерархическом дереве и дважды щелкните на

нем:
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B.2. Запуск инструмента Приложение B. Геообработка
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Приложение C

База геоданных

C.1 Создание базы геоданных

В контекстном меню папки в окне каталога выберите команду New > File

Geodatabase:
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C.2. Создание классов … Приложение C. База геоданных

C.2 Создание классов пространственных объектов

1. В контекстном меню базы геоданных выберите команду New > Feature

Class:

2. В появившемся диалоге введите название класса и выберите тип модели

пространственных объектов и нажмите Далее:
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Приложение C. База геоданных C.2. Создание классов …

3. Выберите систему координат или импортируйте ее у существующего слоя

карты или базы данных:
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C.2. Создание классов … Приложение C. База геоданных

4. В следующих двух диалогахXYToleranceиConfigurationKeywordничего

не меняйте и нажмите Далее.

5. В завершающем диалоге вы можете создать новые поля в атрибутивной

таблице слоя:
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Приложение C. База геоданных C.3. Установка базы геоданных по …

6. Нажмите Finish, чтобы завершить создание класса пространственных объ-

ектов.

C.3 Установка базы геоданных по умолчанию

В контекстном меню базы геоданных выберите пункт меню New > File

Geodatabase:
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C.3. Установка базы геоданных по … Приложение C. База геоданных
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Приложение D

Работа с таблицей слоев

D.1 Добавление слоя

Чтобы добавить слой на карту, вы можете его просто перетащить из базы данных

в таблицу содержания. Альтернативный путь — через кнопку Add Data на панели

инструментов:
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D.2. Удаление слоя Приложение D. Работа с таблицей слоев

D.2 Удаление слоя

Чтобы удалить слой, выберите в его контекстном меню команду Remove:

D.3 Переименование слоя

Выделите слой и нажмите F2 на клавиатуре:

D.4 Переименование показателя

Щелкните на названии показателя в таблице содержания, затем щелкните еще

раз:
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Приложение D. Работа с таблицей слоев D.5. Смена порядка слоев

D.5 Смена порядка слоев

Щелкните на слое левой кнопкой мыши и, не отпуская ее, переместите слой

вверх или вниз по таблице содержания. Отпустите левую кнопку мыши в

нужном месте:

D.6 Свойства слоя

Чтобы открыть свойства слоя, дважды щелкните на нем, либо выберите в кон-

текстном меню пункт Properties (Свойства).
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D.7. Копирование слоя Приложение D. Работа с таблицей слоев

D.7 Копирование слоя

В контекстном меню слоя выберите команду Copy:

D.8 Вставка слоя

В контекстном меню Фрейма данных Layers выберите команду Paste layer(s):
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Приложение D. Работа с таблицей слоев D.9. Создание нового слоя на основе …

D.9 Создание нового слоя на основе выбранных

объектов

В контекстном меню слоя выберите команду Selection — Create Layer From

Selected Features:

D.10 Отключение слоя

Снимите флажок слоя, он перестанет отображаться.

D.11 Копирование и вставка слоя

1. В контекстном меню слоя нажмите Copу

2. В контекстном меню фрейма данных Layers нажмите Paste:
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D.11. Копирование и вставка слоя Приложение D. Работа с таблицей слоев
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Приложение E

Панели инструментов

E.1 Как открыть или найти панель инструментов

Для открытия любой панели инструментов щелкните правой кнопкой мыши на

сером поле. Далее нужно найти панель во всплывающем списке:
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E.1. Как открыть или найти панель … Приложение E. Панели инструментов
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Приложение F

Навигация по карте

F.1 Инструменты навигации (панель Tools)

Для навигации по карте используйте инструменты, расположенные на панели

Tools:

F.2 Установка масштаба

Масштаб устанавливается в соответствующем поле на панели инструментов. Вы

можете выбрать масштаб из списка или ввести его вручную. При вводе использу-

ется только знаменатель масштаба: «3000000», пробелы и числитель «1:» вводить

не нужно:
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F.2. Установка масштаба Приложение F. Навигация по карте

462



Приложение G

Оформление векторного слоя

G.1 Единый символ для всего слоя

В свойствах слоя перейдите на вкладку Symbology и выберите режим Features—

Single Symbol. Далее щелкните на кнопку Настройки символа:
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G.2. Категории (Categories) Приложение G. Оформление …

В появившемся диалоге вы можете выбрать готовый символ, настроить его,

либо перейти к созданию нового символа.

G.2 Категории (Categories)

В свойствах слоя перейдите на вкладку Symbology и выберите режим Features—

Single Symbol. После этого выберите поле категорий в списке Value Field и нажми-

те Add All Values, чтобы подставить имеющиеся в поле категории в список. Чтобы

отредактировать символ конкретной категории, дважды щелкните на нем.
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Приложение G. Оформление … G.2. Категории (Categories)

G.2.1 Сортировка классов

Для сортировки категорий по значению категории или подписи щелкните по за-

головку и выберите команду Reverse Sorting:

G.2.2 Сортировка цветовой шкалы

Для сортировки категорий по значению категории или подписи щелкните по за-

головку и выберите команду Flip Symbols:
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G.3. Градуированные символы … Приложение G. Оформление …

G.2.3 Подстановка стиля (Match Symbols In a Style)

На вкладке Symbology свойств слоя выберите режим Categories — Match Symbols

In a Style:

G.3 Градуированные символы (картодиаграммы)

В свойствах слоя на вкладке Symbology выберите режим Graduated Symbols:
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Приложение G. Оформление … G.4. Градуированные цвета …

G.4 Градуированные цвета (картограммы)

В свойствах слоя на вкладке Symbology выберите режим Graduated Colors:
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G.5. Секторная картодиаграмма (pie … Приложение G. Оформление …

G.5 Секторная картодиаграмма (pie chart)

В свойствах слоя на вкладке Symbology выберите режим Charts—Pie Charts:
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Приложение G. Оформление … G.5. Секторная картодиаграмма (pie …

Чтобы размер диаграммы варьировался, нажмите кнопку Size. Появится диа-

лог,в котором вы можете выбрать, как он будет меняться:
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G.6. Выбор метода классификации Приложение G. Оформление …

G.6 Выбор метода классификации

Метод классификации выбирается после нажатия на кнопку Classify…
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Приложение G. Оформление … G.7. Настройка символа для …

G.7 Настройка символа для точечного объекта

При редактировании точечного объекта вы можете настраивать его размер и ос-

новной цвет. Нажав кнопку редактирования символа, вы можете сделать более

тонкую настройку:
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G.7. Настройка символа для … Приложение G. Оформление …

G.7.1 Символьный маркер

Чтобы использовать шрифтовые символы для визуализации точечных слоев, в

диалоге Symbol Selector (см. выше) нажмите Edit Symbol. В появившемся диалоге

выберите тип символа Character Marker Symbol:
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Приложение G. Оформление … G.7. Настройка символа для …

G.7.2 Вращение символа

Вращение символа обычно используется для показа векторных величин в точ-

ках. Направление задается значением в заданном атрибутивном поле таблицы

слоя. Чтобы включить функцию поворота, войдите в свойства слоя и на вкладке

Symbology нажмите кнопку Advanced — Rotation…:
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G.7. Настройка символа для … Приложение G. Оформление …

Далее, в появившемся диалоге выберите поле, в соответствии с которым бу-

дет осуществляться поворот символа, а также направление поворота:
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Приложение G. Оформление … G.7. Настройка символа для …

G.7.3 Размер символа

Вы можете менять размера символа в соответствии со значением в атрибутив-

ном поле. Для включения этого режима войдите в свойства слоя и на вкладке

Symbology нажмите кнопку Advanced — Size…:

В появившемся диалоге выберите, в соответствии с каким полем следует ме-

нять размер символа:
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G.8. Настройка символа для … Приложение G. Оформление …

G.8 Настройка символа для линейного объекта

При настройке символа для линейных объектов вы можете выбрать подходя-

щий образец в списке слева, а затем настроить его цвет и толщину. Кнопка Edit

Symbol позволяет осуществить более тонкую настройку символа, например, сде-

лать линию с обводкой:
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Приложение G. Оформление … G.9. Настройка символа для …

G.9 Настройка символа для полигонального объ-

екта

При редактировании символа полигонального объекта вы можете задавать цвет

заливки и обводки, а также толщину обводки. Кнопка Edit Symbol позволяет сде-

лать более тонкую настройку, например, добавить штриховку полигона:

G.10 Создание площадного объекта без заливки

Выберите в свойствах символа цвет заливки No Color:
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G.11. Регулировка прозрачности … Приложение G. Оформление …

G.11 Регулировка прозрачности векторного слоя

Перейдите на вкладку Display в свойствах слоя и введите значение прозрачности

в поле Transparent:
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Приложение G. Оформление … G.12. Поиск символа по названию

G.12 Поиск символа по названию

Для поиска символа по названию, используйте соответствующее поле в диалоге

настройки символа:
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G.13. Подключение библиотек … Приложение G. Оформление …

G.13 Подключение библиотек символов

Вы можете подключить дополнительные библиотеки символов. Для этого в на-

стройках символов нажмите кнопку Style References:

480



Приложение H

Оформление растрового слоя

H.1 Градиентная окраска

Для отображения растрового слоя в режиме градиентной окраски, перейдите в

свойствах слоя на вкладку Symbology и выберите режим Stretched. Здесь вы мо-

жете выбрать шкалу и настроить режим растяжки гистограммы.
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H.2. Классификация (послойная … Приложение H. Оформление …

Растяжка гистограммы используется для сопоставления разброса значений

растра и цветовой шкалы. В режиме Minimum-Maximum начало цветовой шкалы

соответствует минимальному значению растра, конец шкалы — максимальному

значению.

H.2 Классификация (послойная окраска)

Классифицированное отображение растра позволяет объединять пикселы по

диапазонам значений и присвоить им общий цвет. Например, этот способ часто

используется при отображении рельефа методом послойной окраски.

H.3 Передискретизация и прозрачность слоя

Поскольку пиксел экрана не совпадает по размерам с ячейкой растра (вы можете

увеличивать и уменьшать изображение) необходим алгоритм расчета значения

пикселов изображения на основе ячеек растра. Для этого используется передис-

кретизация. В ArcGIS имеются следующие ее режимы:

• Nearest Neighbor (ближайшего соседа) — для классифицированных раст-

ров

• Bilinear (Билинейный) — кусочно-гладкий метод, не годится для классифи-

цированных растров

• Cubic Convolution (Кубическая свертка) — наиболее гладкий метод, не

годится для классифицированных данных

• Majority (большинство) — для классифицированных растров

Для выбора метода передискретизации передите на вкладку Display и выбе-

рите нужный режим в списке Resample during display using.

На этой же вкладке регулируется прозрачность слоя.
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Приложение H. Оформление … H.3. Передискретизация и …
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H.3. Передискретизация и … Приложение H. Оформление …
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Приложение I

Подписи объектов

I.1 Включение механизма Maplex

Maplex— это дополнительный модуль для ArcGIS, предоставляющий расширен-

ные настройки размещения подписей.

Чтобы включитьMaplex, откройте панель инструментов Labeling и выбери-

те опцию в меню Labeling. Там же устанавливается режим работы:
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I.2. Включение и настройка подписей Приложение I. Подписи объектов

I.2 Включение и настройка подписей

Чтобы создать простые подписи для слоя, перейдите на вкладку Label в его свой-

ствах и включите режим Label Features in this layer. Далее настройте поле, по

которому будут подписываться объекты, а также настройте внешний вид подпи-

си:

I.3 Классифицированные подписи

Чтобы внешний вид подписи (размер, цвет и т.д.) соответствовал типу объекта,

необходимо использовать классифицированные подписи. Для этого:

1. Установите на вкладке Labels метод отображения Define classes of features
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Приложение I. Подписи объектов I.4. Гало подписей

and label each class separately.

2. Импортируйте классы символов, нажав кнопку Get Symbol Classes.

3. Настройте внешний вид каждого класс подписи, выбирая их из списка

Class

I.4 Гало подписей

Чтобы подписи хорошо читались на пестром фоне, им добавляют обводку — га-

ло.

1. В диалоге настройке подписи щелкните на кнопке Symbol.

2. В появившемся диалоге выполните следующие действия:
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I.5. Настройки размещения подписей Приложение I. Подписи объектов

I.5 Настройки размещения подписей

Диалог настройки размещения подписей вызывается нажатием кнопки

Placement properties на вкладке Labels в свойствах слоя:
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Приложение I. Подписи объектов I.6. Тип и стиль размещения

В данном диалоговом окне находятся 4 вкладки:

• Label Position (Позиция подписи),

• Fitting strategy (Вписывание подписи),

• Label Density (Плотность размещения),

• Conflict Resolution (Разрешение конфликтов).

I.6 Тип и стиль размещения

Чтобы настроить конкретный стиль размещения, нажмите кнопку Position… и

выберите нужный стиль:
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I.6. Тип и стиль размещения Приложение I. Подписи объектов
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Приложение I. Подписи объектов I.7. Разрядка букв

I.7 Разрядка букв

Разрядка букв по длине объекта включается нажатием галочки Spread

Characters на вкладке Label Position:
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I.7. Разрядка букв Приложение I. Подписи объектов
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Приложение I. Подписи объектов I.8. Разрядка слов

I.8 Разрядка слов

Разрядка букв по длине объекта включается нажатием галочки Spread Words на

вкладке Label Position:
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I.8. Разрядка слов Приложение I. Подписи объектов
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Приложение I. Подписи объектов I.9. Подписывать наибольшую часть

I.9 Подписывать наибольшую часть

Если объект состоит из нескольких частей (например, страна включает в себя

острова), Maplex по умолчанию подписывает каждую из них. Для того чтобы

подписывалась только самая крупная часть, перейдите на вкладку Label Density

и отметьте флажком опцию Label Largest Feature Part:

I.10 Разрешение конфликтов

За опции разрешения конфликтов при расстановке подписей отвечает вкладка

Conflict Resolution в диалоговом окне Placement Properties. В частности, мож-

но запретить удалять подпись, даже если она перекрывается другой подписью.

Для этого установите флажок Never remove (place overlapping):
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I.10. Разрешение конфликтов Приложение I. Подписи объектов
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Приложение I. Подписи объектов I.11. Приоритеты подписей

I.11 Приоритеты подписей

На панели Labeling нажмите кнопку Label Weight Ranking:
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I.11. Приоритеты подписей Приложение I. Подписи объектов
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Приложение J

Атрибутивная таблица

J.1 Открытие атрибутивной таблицы

В контекстном меню слоя выберите команду Open Attribute Table:

Во всплывающей подсказке содержится информация о том, как можно сде-

лать это быстрее.
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J.2. Псевдонимы полей Приложение J. Атрибутивная таблица

J.2 Псевдонимы полей

Дважды щелкните на названии слоя, перейдите на вкладку Fields, выделите поле

слева и введите текст псевдонима справа:

J.3 Формат отображения поля

1. В контекстном меню заголовка поля выберите команду Properties…

2. В появившемся диалоге выполните следующие действия:
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Приложение J. Атрибутивная таблица J.4. Выделение строки в …

J.4 Выделение строки в атрибутивной таблице

Найдите нужную строку и щелкните по ее заголовку слева:
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J.5. Сортировка таблицы Приложение J. Атрибутивная таблица

J.5 Сортировка таблицы

Дважды щелкните по заголовку столбца, чтобы отсортировать его. Щелкните

дважды еще раз, чтобы отсортировать в обратном порядке.

J.6 Соединение таблиц

1. Дважды щелкните на слое, к которому нужно присоединить таблицу, и пе-

рейдите на вкладку Joins & Relates.

2. Нажмите кнопку Add….

3. Во всплывающем окне выберите ключевое поле слоя для соединения,

внешнюю таблицу и ключевое поле внешней таблицы, по которому они

будут соединяться:
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Приложение J. Атрибутивная таблица J.6. Соединение таблиц
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J.6. Соединение таблиц Приложение J. Атрибутивная таблица
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Приложение K

Выборка объектов

K.1 Выборка вручную

Для выделения объектов используйте кнопку Select Features на панели Tools.

Чтобы выделить несколько объектов, зажмите клавишу Shift:
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K.2. Инвертирование выборки Приложение K. Выборка объектов

K.2 Инвертирование выборки

В контекстном меню слоя выберите команду Selection > Switch Selection:

K.3 Атрибутивный запрос

1. Выберите команду меню Selection > Select by Attributes

2. В появившемся диалоге введите текста запроса для выборки объектов по

атрибутам. Обратите внимание на то, что при выполнении выборки по ат-

рибуту название поля не заключается в дополнительные символы (кавыч-

ки и т.п.):
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Приложение K. Выборка объектов K.4. Пространственный запрос

Если вы выберете название поля в списке слева и нажмете

кнопку Get Unique Values, то вы сможете увидеть полный

список уникальных значений, хранящихся в данном поле, что

поможет правильно сконструировать запрос.

3. Нажмите Apply (Применить) либо OK (в этом случае диалог закроется).

K.4 Пространственный запрос

1. Выберите команду меню Selection > Select by Location

2. В появившемся диалоге укажите слой искомых объектов, слой-источник и

тип пространственного запроса:
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K.5. Определяющий запрос Приложение K. Выборка объектов

K.5 Определяющий запрос

1. Дважды щелкните на слое и перейдите на вкладку Definition query

2. Нажмите кнопку Query Builder

3. В появившемся диалоге дважды щелкните на названии поля, которое ис-

пользуется для запроса. Оно автоматически подставится в строку запроса

4. Допишите запрос вручную (например, = 3).

Пример запроса для выбора единиц по значению поля:
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Приложение K. Выборка объектов K.5. Определяющий запрос
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K.5. Определяющий запрос Приложение K. Выборка объектов
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Приложение L

Проекции и координатная сетка

L.1 Изменениепроекции (системыкоординат кар-

ты)

1. Дважды щелкните на заголовке фрейма данных в таблице содержания (ес-

ли вы его не переименовывали, то он называется Layers).

2. Перейдите на вкладку Coordinate System и выберите необходимую проек-

цию в списке:
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L.1. Изменение проекции (системы … Приложение L. Проекции и …

Системы координат возможны двух типов:

• Географические (Geographic) — координаты объектов хранятся в широтах

и долготах, проекция не используются

• Проецированные (Projected) — координаты объектов хранятся в метриче-

ских единицах, используются та или иная проекция.
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Приложение L. Проекции и … L.2. Вставка координатной сетки

L.2 Вставка координатной сетки

3. В контекстном меню фрейма карты выберите команду Properties

4. Перейдите на вкладку Grids и нажмите кнопку NewGrid…

5. Выберите нужный тип сетки и нажмите Далее:

a. Graticule (градусная)

b. Measured (прямоугольные координаты)

c. Reference (сетка-указательница)

6. Задайте шаг сетки и нажмите далее. В остальных диалоговых окнах вы мо-

жете оставить параметры по умолчанию и настроить их позже.

L.3 Отображение нулевых минут и секунд

Если шаг сетки кратен целым градусам, нет необходимости отображать нулевые

минуты и секунды. Чтобы отключить их, выполните следующие действия:

1. На вкладке Grids в свойствах фрейма данных выделите нужную сетку и на-

жмите кнопку Properties

513



L.4. Шаг линий сетки Приложение L. Проекции и …

2. Перейдите на вкладку Labels и нажмите кнопку Additional Properties

3. Снимите флажки с опций Show Zero Minutes и Show Zero Seconds.

L.4 Шаг линий сетки

Откройте настройки координатной сетки, нажав кнопку Properties на вкладке

Grids свойств фрейма данных, затем в появившемся диалоге на вкладке Intervals

установите требуемое значение в разделе Interval:
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Приложение L. Проекции и … L.5. Начало расстановки линий сетки

L.5 Начало расстановки линий сетки

При создании сетки вы устанавливали шаг размещения линий. Однако каково

начальное значение широты и долготы, от которого с заданным шагом будут

размещаться линии сетки? Чтобы установить это значение явным образом, от-
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L.5. Начало расстановки линий сетки Приложение L. Проекции и …

кройте настройки координатной сетки, нажав кнопку Properties на вкладке Grids

свойств фрейма данных, затем в появившемся диалоге на вкладке Intervals уста-

новите требуемое значение в разделе Origin. В частности, если вы хотите чтобы

линии широт отсчитывались от экватора, в поле Y Origin следует установить 0:
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Приложение M

Привязка растровых данных

M.1 Панель Georeferencing

Привязка растровых данных путем трансформирования осуществляется с помо-

щью панели Georeferencing:

M.2 Перемещение растра в область, отображае-

мую на экране

Выберите команду Fit to Display в меню Georeferencing:
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M.3. Расстановка контрольных точек Приложение M. Привязка растровых …

M.3 Расстановка контрольных точек

1. Найдите соответствующие точки на растре и на картооснове.

2. На панели Georeferencing щелкните кнопку Add Control Points:

3. Щелкните сначала на точке растра, затем на точке референцного слоя:
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Приложение M. Привязка растровых … M.4. Просмотр и редактирование …

M.4 Просмотр и редактирование контрольных то-

чек

1. На панели Georeferencing щелкните кнопку View Link Table:

2. Отредактируйте контрольные точки на появившейся панели:

M.5 Выбор метода трансформирования

На панелиGeoreferencing откройте пункт менюGeoreferencing—Transformation:
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M.6. Трансформирование Приложение M. Привязка растровых …

M.6 Трансформирование

Чтобы создать файл пространственной привязки, используйте команду меню

Georeferencing > Update Georeferencing
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Приложение N

Редактирование

N.1 Включение сеанса редактирования

В контекстном меню слоя выберите команду Editing > Start Editing:
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N.1. Включение сеанса редактирования Приложение N. Редактирование

Альтернативный вариант: на панели Editor выберите пункт меню Editor >

Start Editing:
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Приложение N. Редактирование N.2. Сохранение изменений

N.2 Сохранение изменений

На панели Editor выберите пункт меню Editor > Save Edits:

N.3 Завершение сеанса редактирования

На панели Editor выберите пункт меню Editor > Stop Editing:
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N.4. Создание (цифрование) объектов Приложение N. Редактирование

N.4 Создание (цифрование) объектов

1. Щелкните на шаблоне объекта в окне Create Features и выберите режим

цифрования в нижней части окна:

2. Для создания точки достаточно щелкнуть в нужно месте на карте.

3. При цифровании линии последовательно нажимайте в узлах линии в по-

рядке их очередности. В последней точке сделайте двойной щелчок или

нажмите F2:
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Приложение N. Редактирование N.5. Цифрование полигонов в режиме …

N.5 Цифрование полигонов в режиме автозавер-

шения (auto-complete)

1. Выберите в окне Create Features режим Auto-Complete polygon

2. Оцифруйте границу, используя следующие правила:
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N.6. Копирование объектов Приложение N. Редактирование

N.6 Копирование объектов

Используйте команду главного меню Edit > Copy.

N.7 Вставка объектов

1. Используйте команду главного меню Edit > Paste.

2. В появившемся диалоге выберите слой, в который необходимо вставить

объекты:
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Приложение O

Компоновка карт

O.1 Включение режима компоновки

Выберите пункт меню View > Layout View:

O.2 Макет страницы

Щелкните правой кнопкой мыши на поле и выберите режим Page and Print

Setup:
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O.2. Макет страницы Приложение O. Компоновка карт

В появившемся диалоге вы можете настроить такие стандартные параметры

как размер листа и ориентировку:
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Приложение O. Компоновка карт O.3. Изменение фрейма карты

O.3 Изменение фрейма карты

Фрейм карты— это прямоугольник, внутри которого отображается карта в режи-

ме компоновки. Выберите на панели Tools инструмент Select elements и щелк-

ните им по изображению карты. Появятся управляющие точки по периметру кар-

ты:
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O.4. Заливка и обводка фрейма карты Приложение O. Компоновка карт

Далее вы можете изменять размер фрейма, перетаскивая его управляющие

точки или перетаскивать его целиком, щелкнув внутри фрейма.

O.4 Заливка и обводка фрейма карты

Щелкните правой кнопкой на фрейме данных, выберите Properties и перейдите

на вкладку Frame:
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Приложение O. Компоновка карт O.4. Заливка и обводка фрейма карты
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O.5. Вставка текста Приложение O. Компоновка карт

O.5 Вставка текста

Чтобы вставить текст (например, название), используйте инструмент вставки

текста на панели Draw. Щелкните в нужном месте и введите текст. Для настрой-

ки шрифта созданной подписи выделите ее и используйте инструменты на па-

нели Draw.

O.6 Вставка линейного масштаба

Используйте команду меню Insert > Scale bar. Выберите нужный стиль в диало-

ге.

O.7 Вставка численного масштаба

Используйте команду меню Insert > Scale text. Выберите нужный стиль в диало-

ге.

O.8 Изменение единиц измерения

Дважды щелкните на масштабной линейке и в появившемся диалоге замените

параметры Division Units и Label:
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Приложение O. Компоновка карт O.8. Изменение единиц измерения
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O.8. Изменение единиц измерения Приложение O. Компоновка карт
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Приложение P

Легенда карты

P.1 Вставка легенды

Используйте команду Insert—Legend. В появившемся диалоге оставьте в правой

части только те слои, для которых вы хотите условные обозначения. Ненужные

слои можно выделить и исключить из легенды. Параметры в остальных диалогах

можно оставить по умолчанию — их можно настроить позже.
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P.2. Название слоя в легенде Приложение P. Легенда карты

P.2 Название слоя в легенде

Чтобы поменять название слоя в легенде, переименуйте его в таблице содержа-

ния

P.3 Название показателя в легенде

Чтобы переименовать название показателя, перейдите в настройки слоя и заме-

ните его на вкладке Symbology в столбце Label:
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Приложение P. Легенда карты P.4. Стиль отображения подписей в …

P.4 Стиль отображения подписей в легенде

Вы можете отрегулировать стиль отображения, а также включить/отключить

подписи для:

• Названия слоя

• Названия показателя

• Названия элемента легенды

• Описания элемента легенды (если есть)

Для этого:

1. Дважды щелкните на легенде

2. Перейдите на вкладку Items, выберите один или несколько слоев и нажми-

те кнопку Style
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P.5. Название легенды Приложение P. Легенда карты

3. В появившемся диалоге нажмите кнопку Properties…

4. В следующем диалоге перейдите на вкладку General, в которой вы можете

выполнить необходимые настройки.

Если вы выделили несколько слоев, то настройки будут применены ко всем.

Вышеописанный процесс иллюстрирует следующий рисунок:

P.5 Название легенды

Чтобы изменить название легенды или стиль его отображения, дважды щелкни-

те на легенде и перейдите на вкладку General:
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Приложение P. Легенда карты P.6. Интервал между элементами …

P.6 Интервал между элементами легенды

Интервал между элементами легенды регулируется в свойствах легенды на

вкладке Layout (компоновка) и обозначен там как Item Gap:
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P.7. Изменение подписей классов Приложение P. Легенда карты

P.7 Изменение подписей классов

Щелкните дважды на слое и перейдите на кладку Symbology. Отредактируйте

вручную содержимое столбца Label.

Было:
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Приложение P. Легенда карты P.7. Изменение подписей классов

Стало:
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P.7. Изменение подписей классов Приложение P. Легенда карты

542



Приложение Q

Экспорт изображения

Используйте команду меню File > Export.
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